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About This Book

This book describes the OS/2 PCM Compatibility Testkit, a software package provided with the OS/2 PCM
Compatibility Test Program that lets personal computer hardware manufacturers (PCMs) perform self-testing
to be listed in IBM's list of compatible systems.

Who Should Read This Book

This book is for testers who want to ensure that their products are compatible with IBM's OS/2 Warp
products.

Skills Required

To use the information in this book, you need the following skills:
e Familiarity with the OS/2 Warp Desktop

e Access to and ability to use an ASCII editor

» Familiarity with commands such as cd, fdisk, and xcopy

» A basic understanding of networks

e Some basic network hardware skills such as cabling computers in a network and installing and
configuring network cards

Documentation Conventions

This book uses the following conventions:

« All system names, addresses, user names, and passwords are case-sensitive and must be typed exactly
as shown.

» Variable names, such as names of adapters, are shown in italics. For example, adapter_name.
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Chapter 1. Introduction to the OS/2 PCM Compatibility Test
Program

This chapter provides installation instructions, an overview of the OS/2 PCM Compatibility Test Program, lists
new features available with this release, and describes how you get information and support for your
participation in the program and use of the OS/2 PCM Compatibility Testkit.

What's New in This Release

The LAN Distance testcase is removed.
The Print Service Facilities testcase is removed.

Multimedia testcases updated to use WAV files instead of MIDI.

USB ports support added to Printer Device Driver Test (PRINTDD).

1.

2

3

4. Parallel port, serial port and legacy floppy drive detection utility was added.
5

6. Now PCM Compatibility Testkit support for only the Convenience Packages.

In addition, there is enhanced information and support for the OS/2 PCM Compatibility Testkit on the World
Wide Web. "Web Sites" lists related Web sites you may want to visit.

Web Sites

These Web pages provide information about the OS/2 PCM Compatibility Test Program and OS/2 PCM
Compatibility Testkit:

http://www.software.ibm.com/os/warp/hw-cert

This Web page helps you find devices compatible with OS/2 Warp, and information on the OS/2
compatibility programs by providing links to:

» PC systems and devices that are compatible with OS/2 Warp

e 0S/2 device drivers you can download

* Information about OS/2 PCM Compatibility Test Programs

* Alink to the OS/2 compatibility programs

* An explanation of the benefits of the compatibility programs

» Information to help you decide which compatibility program is right for you

» Links to Web pages for those programs
http://www.software.ibm.com/os/warp/hw-cert/pcm/pcm_tkit.htm

The OS/2 PCM Compatibility Testkit Program home page contains:

* Aform for enrolling in the OS/2 PCM Compatibility Test Program and ordering the testkit

» Hints and tips for using the testkit

* Access to Frequently Asked Questions (FAQs) about the testkit

» A customer satisfaction survey

» Program Office contact information

e A form for reporting problems with the testkit
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Submitting PCM Test results to the OS/2 PCM Compatibility Test Program Office.

Enrolling in the OS/2 PCM Compatibility Test Program

To enrol in the OS/2 PCM Compatibility Test Program and obtain the OS/2 PCM Compatibility Testkit, fill out
the testkit order form on the OS/2 PCM Compatibility Testkit Web page. The OS/2 PCM Compatibility Testkit

and its documentation will be sent to you.

Program Office

The OS/2 PCM Compatibility Test Program Office can help you:
» Answer questions about OS/2 PCM Compatibility Test Program
* Resolve problems you encounter while running the OS/2 PCM Compatibility Testkit

When you have completed your testing, the OS/2 PCM Compatibility Test Program Office reviews your test
results, sends a confirmation e-mail testing report, and adds your system to the listings published on the
WEB.

The OS/2 PCM Compatibility Test Program Web site has more details about the services provided by the
Program Office, and tells you how to contact the Program Office that serves your country.

Chapter 1. Introduction to the OS/2 PCM Compatibility Test Program
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Chapter 2. Overview of the OS/2 PCM Compatibility Testkit

The OS/2 PCM Compatibility Testkit is a set of automated test cases that verify that your hardware is
compatible with OS/2 Warp. The OS/2 PCM Compatibility Testkit Version 4.91 tests the networking
capabilities of the system. Personal computer manufacturers must establish network compatibility before a
system can be added to the list of compatible systems.

This chapter describes:

» The high-level flow of the test process

» The skills required to use the OS/2 PCM Compatibility Testkit

*  What you get with the OS/2 PCM Compatibility Testkit

e The test environment, including the hardware and software required to create the environment

»  Which tests you need to run for your specific hardware and software configuration

Using the Testkit

A good way to create your test environment is to start with systems that you know are compatible with OS/2
Warp and run all the tests in that environment. If a test case fails in an environment that is known to be
compatible with OS/2 Warp, troubleshooting is not complicated by having a new system that may or may not
be compatible with OS/2 Warp.

The steps involved in using the OS/2 PCM Compatibility Testkit are:
7. Obtaining the necessary hardware and operating system software

8. Connecting and configuring the machines to create a stable test environment (see Chapter 3, "Building
the Test Environment")

9. Testing your machine in the stable environment by doing the following:
» If you want your system listed as a compatible server:
1. Test your machine in the role of an additional server and gather results.
2. Test your machine in the role of a domain controller and gather results.
» If you want your system listed as a compatible client:
1. Test your machine in the role of client 1 and gather results.
2. Test your machine in the role of client 2 and gather results.

(See Chapter 6, "Using Your System in the Stable Test Environment" for detailed information.)

Note: If your system supports different LAN adapters, you can have your system listed with up to two
different LAN adapters by testing with different LAN adapters when moving a system from one
role to another. If you change LAN adapters, be sure to list both in the system hardware
configuration PCM_HDW on panel 3.

10. Submitting the results to the OS/2 PCM Compatibility Test Program Office

11. Receiving email or fax confirmation from the OS/2 PCM Compatibility Test Program Office that your
hardware has passed the test and will be added to the lists of compatible systems

This document provides detailed instructions to guide you through these procedures.
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0OS/2 PCM Compatibility Testkit Materials

The OS/2 PCM Compatibility Testkit Version 4.91 consists of:

A PCM Version 4.91 Testkit CD containing the software, documentation, and file templates needed to
perform the compatibility tests

» Viewable and printable documentation about the OS/2 PCM Compatibility Testkit
e Alicense agreement for OS/2 PCM Compatibility Testkit

A Welcome Letter, which includes instructions for printing this document

Which Tests are Required

To be placed in the list of compatible systems your hardware must pass:

» The base test suite, which tests whether your machine is compatible with the OS/2 operating system in a
non-networked environment

» The network test suite, which tests the networking features of OS/2

See Chapter 8, "PCM Base Test Case Details" and Chapter 9, "LAN Test Case Details" for a complete listing
of the test cases.

Base Tests

You must perform the OS/2 base compatibility tests on all systems, whether they are designated as client or
server systems. The OS/2 base compatibility tests consist of:

* Required tests, which must be run on all systems. These tests include installation and initialization of
08S/2, batch testing, stress testing, hardware interface tests, and special function tests, such as
multimedia.

« Additional tests, which test specific hardware interfaces. You need to run these tests only if your
system's shipped configuration supports these features:

* Advanced Power Management

e Symmetric MultiProcessing (SMP)

« PCMCIA

e Speech Recognition

» Capability to boot from partition the begins or extends beyond 8.3GB (cylinder 1024).
* Journaled File System (JFS) - required for OS/2 Warp Server for e-business.

These tests will be required for compatibility only if the system that is being tested will support the
specific function.

Running the entire set of base tests takes approximately one and one half days. This includes time for setup
and results processing.

Network Tests

In addition to the base tests, your hardware must pass the network tests, which verify networking functions. A
system may be tested as a client system, as a server system, or both.

Testing as a Server

If you want your system included in the list of compatible server systems, you must test it in both the
additional server and domain controller roles as shown in Figure 1. You must submit a test results diskette
showing that your system has passed the base tests and the network tests. Base system testing must be
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done only once using the additional server role. Network testing must be done for both the additional server
and domain controller roles.

Testing as a Client

If you want your system included in the list of compatible client systems, you must test it in both client 1 and
client 2 roles as shown in Figure 1. You must submit a test results diskette showing that it has passed the
base tests and the network tests. Base system testing must be done only once using the client 1 role.
Network testing must be done for both the client 1 and client 2 roles.

Testing as Both Client and Server

If you want your system included in both lists, compatible client systems and compatible server systems, you
must perform all the tests and submit two test results diskettes, one from server testing and another from
client testing.

Base testing is required in both client and server roles because the OS/2 base differs between the client and
server products.

Duration of the Tests

The network tests take approximately two days to complete, including setting up the test environment,
running the test cases, and collecting the results.

You should allow at least four days for the network tests to allow time to resolve problems and to rerun test
cases after you fix problems discovered during the tests. This document describes an environment that can
eliminate or minimize setup problems. If you choose to use a different configuration, troubleshooting might be
more difficult.

The Test Environment

The test environment consists of a network of systems configured as shown in the following figure:

Domain Controller Adddlitional Server

Figure 1. The OS/2 PCM Compatibility Testkit Test Environment
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The systems in this environment are:

The domain controller

This server system controls access by users, manages the resources of your network, and controls the
sharing of resources.

An additional server

This system handles other server functions, such as file access, remote connections, and network
printing.

The test cases require both domain and server tests to verify that your system correctly handles the
handshaking between the domain and server systems.

Client 1 and client 2

These systems act as requesters of services provided by the domain controller and the additional server.

To set up this environment, you need:

Two server systems (see "Server Hardware Requirements")

Two client systems (see "Client Hardware Requirements")

Note: PCM compatibility testing requires only two client systems in the test environment. However,
to meet certain requests from your customers, you may need to test server systems with more
than two clients. See Appendix F, "Testing with Additional LAN Clients" for more information.

Four LAN adapter cards with the appropriate driver and NIF files (see "Selecting LAN Adapter Cards")

Ethernet hub or token ring MAU and category 5 cabling
Three to four blank 3.5" high-density diskettes

Server Software Requirements

Installation materials (CD and diskettes) for the server operating system. This must be the Convenience
package for OS/2 Warp Server for e-business.

Also USB Device Driver required if USB Keyboard, USB Floppy Drive, USB CD/DVD Drive or USB printer is
used.

Server Hardware Requirements

The minimum hardware for each server is:

System unit uses at least an Intel® 486 processor
System unit has at least 32 MB RAM

Hard drive with at least 1 GB capacity (at least 3 drives for RAID setup, and 1 additional drive for
Convenience package for OS/2 Warp Server for e-business JFS volume spanning testcase).

CD-ROM drive
Floppy Disk Drive

0S/2 boot partition with a minimum of 500 MB free space, which includes a minimum of 50 MB for
swapper.dat. This also includes space for the network test cases, but not for the base test cases.

For additional server, a PCMTEST partition with at least 230 MB free space for base test cases. This may
be the boot partition or another local (non-network) drive.

For domain controller, a SADUMP partition of at least 20 MB larger than installed memory. This can be
the same space allocated for the PCMTEST partition.
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* A Journaled File System (JFS) partition. To test volume spanning, two physical disks are required.
e The printer device driver for the printer in your test environment.
e If your machine supports multimedia, you need the appropriate multimedia hardware:

 Sound card

e Speakers

e CD-ROM drive

e An audio (music) CD

Client Software Requirements

You may install the latest Convenience Package for OS/2 Warp Version 4 on a client system.
USB Device Driver required if USB Keyboard, USB Floppy Drive or USB CD/DVD Drive is used.

Also the latest DVD/UDF Support package and latest Enhanced IDE Support package must be installed for
CD-like devices tests and 137Gb Limit Tests.

Client Hardware Requirements

The minimum hardware for each client is:

« System unit uses at least an Intel 486sx processor. If you plan to run the speech recognition tests, the
system unit must have at least an Intel Pentium® processor, 90 MHz or faster.

» System unit has at least 16 MB RAM
» Hard drive with at least 1 GB capacity

e 0S/2 boot partition with a minimum of 400 MB free space, which includes a minimum of 50 MB for
swapper.dat. The networking test cases are installed on the boot drive.

» Atleast 230 MB free space for installing the base test cases. This may be the boot partition or another
local (non-network) drive.

* CD-ROM drive

e An audio (music) CD

» Data CD media with CDFS file system

» If there are CD-RW drive present in system
* CD-RW media

» If there are DVD-ROM drive present in system
+ Data DVD-ROM media

» If there are DVD-RW device present in system

» Data DVD-ROM media

 DVD-RW media (formatted with OS/2 utilities)
» If there are DVD+RW device present in system

» Data DVD-ROM media

 DVD+RW media (formatted with OS/2 utilities)
e If there are DVD-RAM device present in system

» Data DVD-ROM media

* DVD-RAM media (formatted with OS/2 utilities)
* Floppy Disk Drive
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Printer support should be installed even if no printer is attached.
If your system supports multimedia, you need the appropriate multimedia hardware:

e Sound card
» Speakers
» CD-ROM drive

If your system supports speech recognition, you need:
* A microphone compatible with OS/2 Warp Version 4

e Sound card
» Speakers

Selecting LAN Adapter Cards

The LAN adapter cards should be either all token ring or all Ethernet. It is helpful if all four adapters are
the same kind or at least use the same driver. Using the same driver will save some setup time later on.
However, it is possible to mix adapter cards, as long as they are all of the same type, either all Ethernet
or all token ring.

Use one of the adapters supported by OS/2, information on supported adapters can be found in the
online guides:

* For OS/2 Warp Server products, see the MPTS Configuration Guide.
* For OS/2 Warp 4, see the Network Adapters and Protocol Services Guide.

Note: Additional information on LAN Adapters supported can be found on the WEB at:
http://service.software.ibm.com/os2ddpak/html/index.htm.

The choice of LAN adapter for the additional server is of particular importance because that adapter is
used by the Remote Connection Server. Select an adapter from the list of Tested and Approved adapters
that passed the Remote Connections testing. If you are using a Token Ring as the LAN type and the
adapter being used uses the IBMTOK driver, then you have an adapter that should work.

For LAN adapter cards not listed, check with the adapter manufacturer for driver availability, and any
setup or configuration requirements that may be needed for OS/2.
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Chapter 3. Building the Test Environment

These procedures assume that you already have the four systems required to create the initial stable test
environment, that they are connected together with either Ethernet or token ring cabling, and that each has
an operational monitor, keyboard, and mouse.

This test environment should be isolated from other LAN segments. Although an isolated environment is not
required, it is easier to troubleshoot problems in an isolated environment. In addition, network traffic from
other systems on the network can sometimes interfere with your tests.

Installation of Server systems

In setting up your PCM test environment, you need to install two server systems, one as the Domain
Controller, the second as the Additional Server. For instructions on how to install and configure the domain
and server systems in the PCM testing environment, refer to the following Appendix's:

» For Convenience Package for OS/2 Warp Server for e-business, refer to: Appendix A, "Install and
Configure Convenience Package for OS/2 Warp Server for e-business".

Installation of Client systems

In setting up your PCM test environment for Convenience Package for OS/2 Warp Version 4, you need to
install two client systems as LAN Requester #1 and LAN Requester #2. For instructions on how to install and
configure the client systems in the PCM testing environment, refer to the following Appendix's:

» For Convenience Package for OS/2 Warp Version 4, refer to: Appendix B, "Install and Configure
Convenience Package for OS/2 Warp Version 4".
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Chapter 4. Running and Verifying the Base Test Cases

This chapter explains how to run the base test cases. Use this information in the following sequence:
1. Record your configuration from the PCM HDW icon.

2. Select and run the base tests from the PCM TEST icon.

3. Runindividual base tests, as required.

4. Create the results diskette.
5

Rerun any failed or missing tests as individual tests. See Chapter 8, "PCM Base Test Case Details" for
information about the individual tests. Also, additional information is available from the PCM WEB site
TIPS page.

6. Update the results diskette.

Continue to LAN testing. See Chapter 5, "Running and Verifying the Network Test Cases".

See Chapter 7, "Collecting and Submitting Test Results" for information about submitting test results.

Recording and Verifying Your Configuration

You must supply information about the system configuration being tested for either server or client
compatibility. You can fill in this information after you run all the test cases. To record the information, do the
following steps:

1. Double-click on the PCM KIT folder on the Desktop and then double-click on PCM HDW.
2. Click on Update System Information and complete each of the hardware information panels.
3. Click on Continue to display subsequent panels.

4. When complete, click on Save and Exit.

The hardware information is saved in c:\\pcmlogs\machine.txt. If you need to change the information, rerun
PCM HDW.

Note: The c: specifies the boot drive (where the OS/2 is installed).

Selecting Base Test Cases

You run the base test cases at the additional server or at client 1. The base test GUI lets you select the tests
you need to run. Several tests, however, might require initiation from the command line due to hardware
configuration limitations. The instructions below take you through the steps for running the tests in the most
automated sequence.

If your system fails any test, you can run each test individually by following the directions in Chapter 8, "PCM
Base Test Case Details".

In the PCM KIT folder, double-click on the PCM TEST icon. The Test Selection & Control window is
displayed.
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Figure 2. The Base Test GUI

Always run the selectable tests from this GUI, unless you are rerunning an individual test after a failure.

Click on Help if you need more information about the selection choices.
Click on Run to start running the selected the tests.
Click on Exit to leave the program without running any test cases.

The GUI lets you select the tests to run, and whether to run tests requiring user input first or last. Select First
or Last to indicate when, within the testing, you want to run the test cases requiring user input. These tests
run quickly, you should run them first.

A suggested sequence is:

1. Select and run the acceptance test cases, FVT test cases, the multimedia cases, and, if applicable to
your system, PCMCIA and SMP. The acceptance and FVT tests require user input and run quickly. The
multimedia test takes longer and requires user input at the completion of PCM_REXX.

2. When these tests are complete, use the GUI again to start the stress test, which takes a long time and
requires no user input.

3. If your shipped system supports speech, run the speech test. The speech test must be run individually.
See "Speech Recognition (SPEECH)" for instructions.

4. If your shipped system supports Advanced Power Management, run the APM test. The APM test must be
run individually. See "Advanced Power Management Test (APM)" or "Advanced Power Management Test
(APM) for Desktop Systems" for instructions.

Attention: Do not use the keyboard or the mouse while the tests are running. Wait until control is returned to

you before opening or closing windows. After the tests requiring user input have completed, ignore other

windows that seem to request input.
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The system reboots between several of the tests. This is normal behaviour.

Running the Base Tests

This section tells what you need to run the tests, what you see on the screen, and how to respond when
prompted for input. The section assumes you selected FIRST for the test cases requiring user input.

The tests are grouped by category. Each category may consist of several tests, started automatically when

you select that category.

Note: The d: specifies the drive on which the Testkit (or Testcase Partition) is located.

Acceptance Tests

Requirement

User Input

Duration
Log file

Detailed
description

Stress Tests

Requirement
Supplies required
User Input

Duration

Log file

Detailed
description

Required on all systems

Watch screen and respond at end of this sequence:

1. The initial test runs in the Logical Screen Group-1 window, and then the screen
starts flashing multiple colors and characters.

2. Wait five minutes while the screen flashes, and then press Q to end the flashing.

3. No other user input is required.

About 30 minutes for both the user input and automated tests.
Enter type d:\batch\pcmaccpt.sum to check the log file.

See Chapter 8, "PCM Base Test Case Details" for details.

Required on all systems
One blank diskette
If prompted, insert the diskette in drive a: and press Enter.

About 6 hours. You can run this test last and leave the system unattended until it
completes.

Enter type d:\logm1\pcmmed0l.sum to check the log file.

See "Stress Test (PCMMEDO1)" for details.

Chapter 4. Running and Verifying the Base Test Cases
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FVT Tests

Requirement

Information
required

Supplies required

User Input

Duration

Log file

Detailed
description

Multimedia Tests

Required on all systems

« Diskette size used by drive a:, 3.5" or 5.25"
*  Physical drive number of any local drive

e Logical drive letter of any local drive

¢ One blank diskette
¢ (CD-like media for CD-TESTS testcases

Insert diskette and CD-like media when requested, check printer output.

1. Enlarge the window to see the questions on the screen.

2. Do not respond until prompted.

3. When prompted, follow the instructions on the screen to enter the keystrokes as
requested.

About 2 hours

Enter type d:\logf\fvtsect2.sum to check the common log file.
Enter type d:\cd-tests\log\cd-tests.log to check the log file for CD-TESTS.
Enter type d:\ide48bit\log\ide48bit.log to check the log file for 137GB_TESTS.

See "FORMAT Utility Test (FORMAT)" for details.
See "CD-like Devices tests (CD-TESTS)" for details.
See "137Gb Limit Tests (137GB_TESTS)" for details.

The multimedia tests are divided into individual tests for the various types of multimedia available.

Requirement  Required on all systems shipped with either a sound card or a CD-ROM drive.

If you added a CD-ROM drive to the system, or used a CD-ROM drive connected to the
parallel port to install OS/2, you must still install multimedia and run the multimedia
PCM_CD test case, even if the CD-ROM drive is not part of the shipped configuration.

Note: The CDROM support cannot be removed from the Multimedia Configuration if OS/2

was installed from a CDROM drive. Once support is installed it cannot be removed
by updates to config.sys or through selective un-install.

Test selection Use the following table to select the specific tests required:

Table 1. Selecting Multimedia Tests

Your system supports Test to select Required

VVGA video, resolution less than 1024 x 768 x 256 PCM_VGA Select this or
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PCM_SVGA

SVGA video, resolution at least 1024 x 768 x 256 PCM_SVGA Select this or
PCM_VGA

Always PCM_FLC Yes

Always PCM_REXX Yes

Regular CD-ROM drive PCM_CD Yes

User input None required

Supplies Music CD (not a software CD)

required

User Input Yes, the PCM_REXX test requires user input to close windows when it completes.
Duration About 2 hours for all tests

Log files Each multimedia test has its own log file in the d:\results\mmepcm\svtraw directory.
Detailed See "OS/2 Multimedia Tests" for details.

description

PCMCIA Tests

Requirement

Information
required

User Input

Duration
Log file

Detailed
description

Required on all systems shipped with PCMCIA support

For each slot, the drive letter, and the type of PCMCIA card used in that slot.

None

Note: Some systems do not reboot with PCMCIA cards installed, or might leave the cards
unusable they are installed while the system is rebooted. If this occurs with the
system being tested, run PCMCIA tests from an OS/2 command line. See the

directions in "PCMCIA".

About 15 to 30 minutes depending on the storage capacity of the cards used.

The log files are in the d:\pcmcia directory.

See "PCMCIA" for details.
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SMP Tests

Select this test only if the shipped system supports multiple processors, and Convenience Package for OS/2
Warp Server for e-business

Requirement

User input
Duration
Log file

Detailed
description

JFS Tests

Required for systems with Convenience Package for OS/2 Warp Server for e-business
software

None
About five minutes
The log files are in the d:\smp directory.

See "SMP Verification Test" for details.

Select this test only for Convenience package for OS/2 Warp Server for e-business

Requirement

User input
Duration
Log file

Detailed
description

Required for systems with Convenience package for OS/2 Warp Server for e-business
software

None
About 30 minutes
The logdfile is in d:\jfstest\jfstest.log.

See "0OS/2 Journaled File System Test (PCMJFS)" for details.
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Chapter 5. Running and Verifying the Network Test Cases

This chapter explains how to run the network test cases. Use this information in the following sequence:

1.
2.
3.

Select and run the network tests by double-clicking on the LAN TEST icon.
Run individual network tests, as required.

Update the results diskette. Be sure to use the same results diskette used earlier when running the base
tests.

Rerun any failed or missing tests as individual tests, with the following exceptions:

e ITLLS56 and ITLLS57 (these tests cannot be run individually and must be run on three test machines
to exercise either the domain controller or the additional server)

e ITLPEER (this test cannot be run individually and must be run on the additional server and client 2
systems to exercise client 1)

Update the results diskette.
Check to make sure all tests were run and passed.

See Chapter 7, "Collecting and Submitting Test Results" for information about submitting test results.

Running the Network Test Cases

To run the network tests, do the following on each of the four test machines simultaneously or sequentially
within a short period of time (not exceeding two minutes).

1.
2.

Open the PCM Compatibility Testkit Version 4.91 folder.

Double-click on LAN TEST. The LAN Testcase Selection & Execution window is displayed as shown in
Figure 3.

The Workstation currently configured as: field indicates which machine the tests are being started
from. For example, in Figure 3, the test cases are being started from client 2.
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LAH Testcase Selection 3 Execution

Workstation currently configured as: ITO1R0Z
Client #Z - LAN/Remote Requester

select below which system you want to test.

For Domain/Server Compatibilty Testing - you must test both:

) Run tests to exercise the Additional Server

) Run tests to exercise the Domain Controller

For Client/Peer Compatibility Testing - you must test both:
) Run tests to exercise Client #1 - LAN / Peer Requester

() Run tests to exercise Client #2 - LAN / Remote Requeste

Run Exit Help

Figure 3. LAN Testcase Selection and Execution

3. Select one of the following testing options:
* Run tests to exercise the Additional Server
* Run tests to exercise the Domain Controller
* Run tests to exercise Client #1 - LAN/Peer Requester
* Run tests to exercise Client #2 - LAN/Remote Requester

4. Click on Run.

The test cases will begin running. Information is displayed in an OS/2 window on each of the
machines as the test cases are processed.

Attention: Do not use the keyboard or mouse while the tests are running.

When each of the test cases completes, the results are copied to a log file on the machine where the
test was started in addition to a log file on the appropriate target machine, depending on which
testing option you selected. The log files are located on the boot drive in the following directories:

\dOllogs On the domain controller
\sOllogs On the additional server
\r01llogs On client 1

\r02logs On client 2
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The log files are named testcase.xxx, where testcase represents the name of the individual test case
(for example, itlls57, itlftp01, and so on) and xxx represents the machine where the test case was run

from as follows:

File Extension Test Case Run From

DO1

S01

RO1

R0O2

Domain controller

Additional server

Client 1

Client 2

If your system fails any test, you can rerun the test individually following the steps in Chapter 9, "LAN Test

Case Details".

Running the Manual Intervention Network Test Cases

The following test cases must be run individually on the domain controller.
"OS/2 Dump Test Case (ITLDUMP)"

"Personal Safe and Sound (ITLPSNS)"

"SystemView Raid Information (ITLRAID)"

The following test cases must be run individually on the additional server.
"Group Management (ITLSV00)"

"Monitor Remote System's Resources (ITLSV06)"

"Hardware Inventory (ITLSV07)"

"Software Inventory (ITLSV08)"

"System Information Tool (ITLSV11)"

For detailed information describing these test cases, see the sections listed above.

For an overview of which test cases need to be run to test the different systems and which systems those test
cases are run from, see Appendix D, "LAN Test Case Groupings, Execution, and Output".
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Chapter 6. Using Your System in the Stable Test Environment

This section explains how to substitute your test system into the stable four-machine test environment
created in Chapter 3, "Building the Test Environment", to test it in each role as domain controller, additional
server, client 1, and client 2.

For a review of the role each system plays in the test environment, refer to Chapter 3, "Building the Test
Environment".

Server Testing

Do the server testing the in the following order:

1.
2.

Test your system as additional server.

Test your system as domain controller.

Testing Your System as the Additional Server

This is the state of the machines in your test environment:

Original domain controller is powered on.
Original additional server is powered on and cabled into the network.
Original client 1 and client 2 are powered on.

Test system is powered off, not yet configured, but cabled into the network.

To exercise your test system as an additional server:

1.
2.

Power off or remove the original additional server from the network.

If the original server is not powered off or disconnected from the network, "duplicate netbios name" errors
create problems during the installation.

Power on your test system and follow the appropriate instructions to prepare your test system for the role
of additional server.

» For Convenience Package for OS/2 Warp Server for e-business, see: Appendix A, "Install and
Configure Convenience Package for OS/2 Warp Server for e-business".

* Be sure to select the option that formats the hard drive during installation.

*  On each of the four systems that are powered on, use the PCM TEST and LAN TEST GUIs to run
the tests for the additional server as described in:

e Chapter 4, "Running and Verifying the Base Test Cases".

e Chapter 5, "Running and Verifying the Network Test Cases".

After all the tests are complete, collect the results as described in Chapter 7, "Collecting and Submitting
Test Results". Review and analyze any problems seen in the test report.

Shut down and power off the test system currently playing the role of additional server.
Power on the original additional server.

Issue the resync command on the original additional server.
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Testing Your System as the Domain Controller

This is the state of the machines in your test environment:

» Original domain controller is powered on and cabled into the network.

« Original additional server is powered on and cabled into the network.

e Original client 1 and client 2 are powered on and cabled into the network.

» Test system is powered off, cabled into the network, and currently configured for role of domain
controller.

To exercise your test system as a domain controller:

1. Shut down and power off all four systems in the original test environment.
If the original domain controller is not powered off or disconnected from the network, "duplicate netbios
name" errors create problems during the installation.
You may leave the original domain controller attached to the network if it remains powered off while you
test the new system.

2. Power on your test system and follow the appropriate instructions to prepare your test system for the role
of domain controller.
» For Convenience Package for OS/2 Warp Server for e-business, see: Appendix A, "Install and
Configure Convenience Package for OS/2 Warp Server for e-business"

e Be sure to select the option that formats the hard drive during installation.

After the new domain controller is ready, power on the original additional server.

4. From an OS/2 command prompt on the additional server, issue the resync command from the \itlutil
directory on the server.

5. On the additional server, run the lansetup command file in the \os2 directory. This command redefines
the shared resources on the server to the domain that were lost when the original domain controller was
replaced with the system being tested.

6. The system under test is now operating as the environment's domain controller.
Power on both client systems.

8. On each of the four systems that are powered on, use the LAN TEST GUI to run the test cases for the
domain controller as described in:

* Chapter 5, "Running and Verifying the Network Test Cases".

9. After all the tests are complete, collect the results as described in Chapter 7, "Collecting and Submitting
Test Results". Review and analyze any problems seen in the test report.

10. Do problem resolution and rerun tests as required.

11. After all the appropriate tests have passed, shut down and power off all four systems.

Client Testing

Do the client testing the in the following order:
1. Test your system as client 1.

2. Test your system as client 2.
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Testing Your System as Client 1

This is the state of the machines in your test environment:

» Original domain controller is powered on and cabled into the network.

» Original additional server is powered on and cabled into the network.

e Original client 1 and client 2 systems are powered on and cabled into the network.
» Test system is powered off, not yet configured, but cabled to the network.

To exercise your test system as client 1:

1. Shut down client 1 and power it off.
If the original client 1 is not powered off or disconnected from the network, "duplicate netbios name"
errors create problems during the installation.

2. Power on your test system and follow the appropriate instructions to prepare your test system for the role
of client 1.

« For Convenience Package for OS/2 Warp Version 4, see: Appendix B, "Install and Configure
Convenience Package for OS/2 Warp Version 4".

» Be sure to select the option that formats the hard drive during installation.

3. On each of the four systems that are powered on, use the PCM TEST and LAN TEST GUIs to run the
tests for client 1 as described in:

* Chapter 4, "Running and Verifying the Base Test Cases".
» Chapter 5, "Running and Verifying the Network Test Cases".

4. After all the tests have completed, collect the test results. Review and analyze any problems seen in the
test report.

5. When all appropriate tests have passed, shut down and power off client 1 (your test system).

Power on the original client 1.

Testing Your System as Client 2

This is the state of the machines in your test environment:

» Original domain controller is powered on and cabled into the network.

» Original additional server is powered on and cabled into the network.

e Original client 1 and client 2 systems are powered on and cabled into the network.

» Test system is powered off, cabled into the network, and currently configured for role of client 1.
To exercise your test system as client 2:

1. Shut down client 2 and power it off.
If the original client 2 is not powered off or disconnected from the network, "duplicate netbios name"
errors create problems during the installation.

2. Power on your test system and follow the appropriate instructions to prepare your test system for the role
of client 2.

» For Convenience Package for OS/2 Warp Version 4, see: Appendix B, "Install and Configure
Convenience Package for OS/2 Warp Version 4".

* Be sure to select the option that formats the hard drive during installation.

3. On each of the four systems that are powered on, use the LAN TEST GUI to run the tests for client 2 as
described in:
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 Chapter 5, "Running and Verifying the Network Test Cases".

After all the tests have completed, collect the test results. Review and analyze any problems seen in the
test report.

When all appropriate tests have passed, shut down and power off client 2 (your test system).

Power on the original client 2.
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Chapter 7. Collecting and Submitting Test Results

This chapter explains how to collect the results of the tests and prepare them for submission to the Program
Office.

When you have completed the tests, you are ready to collect the results. You can collect results after all the
tests or after rerunning an individual test. The results program collects the results of the tests, analyzes the
results, and stores the results on diskettes; one for server tests, and one for client tests.

System Hardware Information

You must complete entering your system's hardware configuration information before you collect the test

results. If the information is not complete, the System Hardware Configuration (SNF001) test shows an error
in the results.

You can enter the system hardware information either before or after you do the testing. To start or update
the hardware information, double-click on the PCM KIT folder on your Desktop and then double-click on PCM
HDW. The System Hardware Information screen is displayed as shown in Figure 4.

FCH - System Handware Informafion

The information entered on the following pages will be made available with the FCH
Compatibility Listings at this Web site:

httpaffwwrwlibmocomisoltwared os warpf hw-certd

This site is Intended to provide information about the system as tested, as well as any
comments on how the system was configured.

IT you did not configure the hardware, install 052, or configure the nelwork, consult the
FIE‘FEIIII'I(S:J wiho clid to ensure that the information is accurate amd complate.

If using this program for the first time on a system tested
previously in a different location (581 or D81 for server and
RE1 or ROZ Tor client), click here to use the data from the
Hesults disk previously created,

Update From Results Disk

Click here to enter or update system hardware Create/Update
information. -

If you are using PCMHDW for the first time, read Hel
the information provided in the help =P

Cancel

Figure 4. System Hardware Information

Click on Update System Information to enter new information or to update existing information. Appendix C,
"Hardware Information Components" shows each of the five hardware information panels. You can use this
information as a reference to collect the details that you will need before completing your system's hardware
configuration information.
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Collecting Test Results

On the Desktop, double-click on the PCM KIT folder, and then double-click on PCM RSLT, which opens the

diskette request dialog as shown in Figure 5.

PCH Compatibility Testkit - Results Processing

Please insert BLAHK

OR previously created Results Diskette in Drive A:
and press ENTER to continue,

OR press CANCEL to exit.

Cancel

Figure 5. Startup dialog.

If blank or Results diskette already inserted, this dialog is not showed.

After the diskette inserted the PCM Compatibility Testkit - Results Processing window appears as shown in 6.

PCM Compatibility Testkit - Results Processing

Enter/Update Testing/System Information:

The file PCHM_INFO will be loaded from the previously created RESULTS
Diskette into the menu fields for update as needed.

Enter HEW or Update
Testing/System Information

Process Results Diskette

Enter or Update Testing/System
Information then click on Process
Results Diskette.

Cancel

Figure 6. Results Processing Window
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Creating a New Results Diskette

To create a new results diskette:

1. Label a blank, formatted diskette. The diskette label should contain the following information. Print or type
the label clearly.
» Manufacturer of the system tested
*  Model name or number of the system tested
o Server test results or client test results
e Tester's name (can be different from the contact person)
» Tester's Phone and Fax numbers
» Date

2. Insert the blank diskette.
You must provide identification on the diskette about your product and identify the person who should be
contacted by the Program Office.

3. Press the Enter/Update Testing/System Information button and fill in the information in the Results
Processing window, which is shown in Figure 7.

PCH Compatibility Testkit - Results Processing - Testing/System Information

System Manufacturer: ||

System Model Hame: |

Hote: This is the name that will appear in the 05/2 Hardware Compatibility Listing.
Please be sure this name is the same as entered in PCHM HDW panel previously.

Hote: This person will get the test results information.

Contact Name:

Contact Fax Number:

Contact Phone Number: |
Contact EMAIL Address: |

Tester Hame: |

Tester Phone Number: |

Tester EMAIL Address: |

‘Cancel “Help

Figure 7. Results Processing

Attention: Follow these instructions exactly to make sure your product is listed correctly. The information
you submit is used exactly as you entered it.
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» The system manufacturer and model name used for the Test Report are published in the Web
compatibility list. These names appear exactly the way you entered them. Please check the names
for accuracy because the names cannot be altered after they are published.

« Do not use internal product code names as part of the system model name. Use the model name that
the system is marketed as.

» The contact person receives the reports provided by the program. If you are tester, but want the
report to go to another person at your installation, provide that person's name as the contact name.

Running the Create Results Program
Click on Continue to have the program analyze the files created by the tests and build the results files on the
diskette.

Select the appropriate operating system and whether you are preparing results for a server or client system in
the panel shown in Figure 8.

POM Compatibility Testkit - Results Processing - TestingdSystem infarmatiom

FCH Compatibility Testkit Version: V4.9

#! Prepare results for Compatibility of SERVER System Unit

@ Prepare results for Compatibility of CLIENT System Unit

Select Operation System from list;

onvenlence Package 2 for 05/2 Warp Server for e-business |

Convenlence Package 1 for 05/2 Warp Server for e-business

=

Enter 0542 fixpack levels If any fixpacks were applied for testing.

Continue Cancel

Figure 8. Results Processing

Click on Continue and wait while the program writes pcmscore.txt on the results diskette.
The program creates the following files:

» testbad on diskette, if any tests fail or are missing

» pmscore.txt on the results diskette

» c:\pcmlogs\pcmscore.txt on your hard disk

Note: The c: specifies the boot drive (where the OS/2 is installed).

Updating a Results Diskette

To update a results diskette:
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1. On the Desktop, double-click on the PCM KIT folder, and then double-click on PCM RSLT, which opens
the PCM Compeatibility Testkit - Results Processing window as shown in Figure 3.
2. Insert the diskette you want to update.

The existing information from the pcm_info.txt file on the diskette is displayed. You can update the
Testing/System Information if necessary or process directly to update the results by pressing Process Results
Diskette button.

Checking Your Results

Check your results as follows:
1. Review pcmscore.txt for any tests that are marked "fail" or "missing".

2. If atestis marked "fail", examine the testbad file on the results diskette. The testbad file gives more detail
about which test to rerun.

3. Rerun the failed test:

* Rerun base system tests either from the PCM TEST icon, or as described in Chapter 4, "Running
and Verifying the Base Test Cases".

* Rerun network tests either from the LAN TEST icon, or as described in Chapter 5, "Running and
Verifying the Network Test Cases".

4. Update the results diskette; click on PCM RESULTS.

Recheck the results in pcmscore.txt

6. When all the required tests are marked "PASS", make a copy of the diskettes for your records.

Submitting Test Results Diskettes

Do not submit your test results until all the tests required for your hardware configuration are marked "PASS"
in pcmscore.txt, unless instructed to do so by the Program Office.

If you tried several times to complete a test successfully, refer to Appendix E, "Troubleshooting" for help.
Also, you can download tips files from the PCM Compatibility Program WEB site for additional information. If
this help is not sufficient, use the Problem Report Form on the Web to request help from the Program Office.

Refer to the PCM Web pages to get utilities and detailed instructions for submitting test results via EMAIL. If
you are sending the diskette through the mail, enclose a business card or other identification.
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Chapter 8. PCM Base Test Case Details

Use the instructions in this chapter to run those tests that must be run individually or to rerun individual tests.

The following information is included, where appropriate, for each test:

e The name of the test, or part of the test

e A description of the test
» The steps to run the test
* The test results

e The test duration

Base Test Summary

The following table lists the tests in the base testkit, where to get the details about each test case, and the

approximate run time.

Note: The d: specifies the drive on which the Testkit (or Testcase Partition) is located.

Table 2. Summary of Base Tests

Test Description Approximate Run Time

SNF001 0S/2 System Installation and 60 Minutes
Initialization on page 38

SNF002 File 1/0 Using Semaphores Test on |10 Minutes
page 39

SNF006 Code Page Switching 5 Minutes
(VIDEO/PRINTER) Test on page
39

SNF007 Shared Segments Test on page 40 |5 Minutes

SNFBPB High Performance File System Test |5 Minutes
on page 41

SNFREXX Batch Processing and REXX Calls |3 Minutes
on page 41

SNFMVDM Automated Tests to Stress the 15 Minutes
Base System on page 42

SNFWIN Your DOS/Windows Applications 30 Minutes
Test on page 43

PCMMEDO1 Stress Test on page 43 6 Hours

KBD Keyboard Device Driver Test on 5 Minutes

page 45
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CD-TESTS CD-like Devices Test on page 46  |15-30 Minutes
137GB_TESTS 137Gb Limit Tests on page 46 15 Minutes
FVTDISK Disk Multitasking Test on page 47 |20 Minutes
FORMAT Format Utility Test on page 48 15 Minutes
TIMERDD Timer Device Driver Test on page |10 Minutes
48
PRINTDD Printer Device Driver Test on page |20 Minutes
49
PCM_VGA OS/2 Multimedia Test on page 50 |10-20 Minutes Each
PCM_SVGA
PCM_HPFS
PCM_CD
PCM_FLC
PCM_REXX
SNFAPM APM Test on page 53 60 Minutes
SNFPCM PCMCIA TEST on page 55 30 Minutes
SNFSMP 0S/2 for SMP Test on page 56 2 Minutes
SPEECH Voice Navigation on page 57 30 Minutes
JFSTEST Test JFS File System on page 52 |30 Minutes

System Hardware Configuration (SNF001)

You must include a definition of your hardware in the material submitted to the Program Office on the results
diskette. The RESULTS process checks for this information. An error will be posted for Test # 1.

Creating the Hardware Information

Double-click on the PCM KIT icon, and then double-click on the PCM HDW icon.

The System Hardware Information window is displayed. Click on Update System Information and complete
each of the hardware information component. (See Appendix C, "Hardware Information Components" for a
representation of each panel.)

When complete, click on Save and Exit. After you complete a page and continue to the next page or have
saved and exited, you can modify the entries by restarting PCM HDW. You can then update the displayed
information.

Results

The machine.ixt file is created and saved in the \snf001 subdirectory for all the system configuration data.

38 Chapter 8. PCM Base Test Case Details




You can enter this information before or after running any tests. However, it must be created before you
collect your results as described in Chapter 7, "Collecting and Submitting Test Results".

File I/0O Using Semaphores (SNF002)

This is a test of semaphores, video I/O, file I/0, and interprocess communications. It also tests for
semaphores output from the kernel test.

SNFO002 Test Steps

1. Atan OS/2 command line, change to the d: drive.
2. Type cd batch and press Enter.

3. Type SNF002 and press Enter.

4. The test displays:

Scanning output log \ACCEPT\CORE\SNF002.LOG for "PASS"

There should be 59 entries
D:\ACCEPT\CORE\SNF002.LOG: 59

5. You are returned to the test drive prompt.

Results of SNF002

Check the d:\accept\core\snf002.log file. If there are not 59 entries, check the log to see which files did not
pass.

If any file shows "FAIL", shut down and reboot the system; then, rerun the entire test.

Run Time

The test takes approximately five minutes.

Code Page Switching (Video/Printer) (SNF006)

This is a comprehensive test of objects within folders, and the display of ASCII codes with a range of different
background colors.

Check the Desktop for the printer icon. A printer needs to be installed for this test even if no printer is
attached to the system.

If you did not install the printer during OS/2 installation, then follow these steps to install the printer and
drivers:

1. Double-click on the OS/2 System icon on the Desktop. The OS/2 System - Icon View is displayed.
2. Double-click on Templates. The Templates - Icon View is displayed.

3. Drag the Printer icon to the Desktop. The Create a Printer panel is displayed.

4

Type ENVPRT in the Name: field and then click on Install New Printer Driver. The Install new printer
driver panel is displayed listing all of the print drivers defined for this release of OS/2.

5. Select the printer that is attached to this workstation and click on Install. A panel is displayed requesting
the path to the OS/2 drivers. Because you loaded this system from the CD and the CD is still in the CD-
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ROM drive, it is likely the default path provided by OS/2 is correct. As long as the OS/2 Warp CD is still in
the CD-ROM drive, click on OK. A pop-up panel will indicate a successful installation.

6. Click on OK. The Create a Printer panel is displayed with the driver that was just loaded highlighted.

7. Be sure the LPT1 port is selected along with the driver you just loaded and click on Create. You should
see the printer that you just defined on the Desktop.

8. Close the Templates icon view, and the OS/2 System icon view.

SNFO006 Test Steps

Open an OS/2 Full Screen session and change to the d: drive.
Type cd batch and press Enter.
Type snf006 and press Enter.

The test displays all the ASCII characters and begins to change colors.

o > b=

The test returns to the d:\batch directory at completion.

Results of SNF006

The test results are stored in the following files in the d:\nlscpa directory:

+ fontd

e printd

» cpalog

» switch_6

Each file ends with PASS, SUCCESSFUL, or FAI L.

Note: If this test is run in SVGA mode, the cpalog file will show up to 39 lines of: Font _Denon f ound
wrong code page, and will end with CPALOG FAILED. This is a successful run for SVGA.

Run Time

Approximately five minutes.

Shared Segments Test (SNF0Q07)

This is a test of multiple memory allocation calls

SNFOO7 Test Steps

1. Atan OS/2 command line, change to the d: drive.
2. Type cd batch and press Enter.

3. Type snf007 and press Enter.
4

The test runs and returns to the test drive prompt.
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Results of SNFO07

Check the d:\loga\switch_7 file for PASS or FAI L information for:

M32SHR
NAMESHR
GIVESHR
GETSHR

Run Time

Approximately 10 minutes.

High Performance File System Test (SNFBPB)

This is a test of the HPFS file system.

SNFBPB Test Steps

1.

At an OS/2 command prompt, type chkdsk c: /f: 3. Verify that there are no disk errors for each HPFS
partition before starting the test. The test might fail otherwise.

Change to the d: drive.
Type cd batch and press Enter.
Type SNFBPB and press Enter.

Note: The snfbpb.cmd command looks at c:, d:, e: and f: for the first HPFS partition it finds. If all
these partitions are FAT, the test ends and OS/2 returns to the d:\batch subdirectory.

If an HPFS partition is found, the test verifies that the directory displays long file names, because HPFS
allows file names up to 256 characters.

The test ends and returns to an OS/2 command line.

Results of SNFBPB

The batch\snfbpb_1 log file indicates PASS, FAI L, or NO HPFS.

Run Time

Approximately five minutes.

Batch Processing and REXX Calls (SNFREXX)

This test verifies the REXX language with OS/2.

SNFREXX Test Steps

1.
2.

At the OS/2 command line, change to the d: drive.
Type cd batch and press Enter.
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Type snfrexx and press Enter.

Two system errors (sys 1041) are displayed during the test. They are designed to fail, and do not indicate
test failure.

5. You are returned to the OS/2 command line.

Results of SNFREXX

1. Attest end, a message is displayed: scanni ng out put |1 og REXX_LOG for " K"

2. d:\rexx\rexx_ | og: 71 isdisplayed.

The rexx_log file is in the \rexx directory. If there are not 71 entries, type type rexx_log |more and inspect
each command line for BAD.

Run Time

Approximately three minutes.

Automated VDM Test (SNFMVDM)

This is a collection of small tests. You must have a mouse attached to the system.

SNFMVDM Test Process

1. Atan OS/2 command line, change to the d: drive.
2. Type cd batch and press Enter.

3. Type snfmvdm and press Enter.
4

Do not touch the keyboard or mouse until Logical Screen Group 1 is visible on the Desktop with flashing
colors and characters.

Note: The box with the flashing colors appears once on the Desktop, goes away momentarily, and then
appears again. This might happen rather quickly, depending upon the speed of the machine.
5. After the second window of flashing colors appears for a full five minutes, press Q to end the video part of
the test.

6. The test ends, the window closes, and you are returned to the OS/2 command line.

Results of SNFMVDM

At the end of the test, the message is displayed:
Checki ng out put |ogs under \vdm for "PASS"
There should be 6 files with PASS

The results files in the \vdm directory are:

¢ SWITCH_V
 VDM1 (partial is OK)
e VVTATXM4

« FLTO18

¢ MATO015
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+ CTTCLOCK

Run Time

Approximately 15 minutes.

Your DOS/Windows Applications Test (SNFWIN)

This is a test of your Windows 3.1 and 3.11 compatible applications.
To be able to run this test, you must first load your Windows applications in the d:\window directory.

Windows applications are not provided with this test package. You must provide your own DOS/Windows
applications.

SNFWIN Test Steps

There are two ways to get a Windows environment. Do one of the following:

»  Select WIN-OS/2 Full Screen in the Command Prompts folder, which is located in the OS/2 System
folder.

» Type winos2 from an OS/2 full screen session.

Either method results in a Windows Program Manager screen.

Do the following steps:

1. Select File from the Program Manager action bar.

2. Select Run from the pull-down menu. (Select Exit Win-OS/2 to return to an OS/2 session.)
3. Type the name of the Windows program you want to run and press Enter.
4

(If you press Ctrl+Esc, the Task List window is displayed where you can select Desktop to return to an
0OS/2 session.)

Results of SNFWIN

Your Windows application should run without errors.

Because this test is visually verified by the tester, no specific output files are generated.

After completing this test you will need to modify the log file, c:\pcmlog\snfwin.txt with the results.
You also need to add the applications and the version that was used in the testing to this log. \

Note: The c: specifies the boot drive (where the OS/2 is installed).

Run Time

The run time depends upon your applications.

Stress Test (PCMMEDO1)

This set of tests collectively tests the major functions of the OS/2 operating system in an environment that
introduces an element of demand by dynamically starting and ending tests while other tests are permitted to
execute over a period of time.
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This test runs for approximately six hours. After you start this test, the test systems should be left alone until
the test completes. These tests might fail if there is other activity on the system while these tests are running
or if the system has not been shut down and restarted prior to this test.

PCMMEDO1 Stress Test Steps

1. Shut down and reboot the system.
After restarting, the PCM TEST screen is displayed.

Press Alt+Esc to go back to the Desktop to let the system open completely before going to the PCM
TEST session to start test cases. This should be done every time the system is restarted.

At an OS/2 command prompt, type d:\log and press Enter.
Type run and press Enter. (The PCMMEDO1 test script is run.)

After a few moments, the screen clears and then displays three bars.

N o o &

Insert a blank diskette and press any key to continue.

Note: Press Ctrl+C to terminate the test here if you do not want to continue.

When the stress test is running, numerous parallel processes will be executing at the same time.

At test completion you are returned to an OS/2 full screen session or to the Desktop.

Results of PCMMEDO1
Errors encountered that prevent test completion as well as errors reported in the summary file could indicate

test failure.

At completion time, go to an OS/2 command prompt and change to the d:\log directory. Type type
pcmmed01.sum and press Enter.

After successful execution of this stress test, the last line of the summary file, pcmmed01.sum, should reflect
the following:

PCMMEDO1 PASS 68 FAIL O PARTIALO MISSING 0

In some cases the dswitchm or cube files will report a <PARTIAL>. This is acceptable; your passing count will
be one or two less. The <PARTIAL> is caused if the switcher script stops the test before completion.

Note: If partials are detected other than in dswitchm or cube, rerun the individual testcase.exe with the same
parameters as used in PCMMEDO1. Then run strlog.cmd to update the summary file.

Rerunning the Stress Test

If you do not achieve the desired test results described above, do one of the following:

» Make certain the test system does not have other activity while running the stress test.
* Rerun the stress test.

* Reload the stress tests and rerun the stress test.

» Refer to the STRESS HELP file on the Web Tips page for help solving individual file failures, or refer to
the data in the document on the bulletin board information.
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Run Time

The stress test takes approximately six hours.

Keyboard Device Driver Tests (KBD)

These tests exercise the USB keyboard and non-USB keyboard device driver.

KBD Test Steps

1. Open an OS/2 window session.

Note: The testcase should not be run in full screen mode.

Enlarge the OS/2 window so that you can see the questions on the screen as they are presented.
Do not enter any keystrokes until prompted.

At an OS/2 command prompt, change to the \kbd directory on the d: drive.

o M w0 DN

At the command prompt, type:
vio.cmd

6. Follow the instructions on the display to select the keyboard type and enter the keystrokes when
prompted.

7. When the test is complete, you are returned to d:\kbd directory.

Results of KBD

The test writes its results in the following log files:

» d:\kbd\kbd.log for standard keyboard

» d:\kbd\kbd1.log and d:\kbd\kbd2.log for USB keyboard

To determine if the tests were successful, search the file for the status indicators.
To verify that the vio.cmd test for standard keyboard was successful, type:
grep "STATUS KBD' kbd. | og

The output should be similar to the following:

STATUS .... RUN 35....PASS 35...FAIL 0...AUTOFAIL O

To verify that the vio.cmd test for USB keyboard was successful, type:
grep "STATUS KBD' kbd1l. 1 og

grep "STATUS KBD' kbd2.1 og

The output should be similar to the following:

STATUS .... RUN 35....PASS 35...FAIL O0...AUTOFAIL O

Run Time

The total run time for the KBD test is approximately 5 minutes.
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CD-like Devices tests (CD-TESTYS)

CD Tests are designed to test devices, for read/write capability on various media. It also verifies some device
error handling and test data integrity to insure device under test can be successfully used with OS/2.

Hardware and Software Requirements

* Atleast one CD-like device (CD-ROM, CD-R, CD-RW, DVD-ROM, DVD-R, DVD-RW, DVD+RW, DVD-
RAM);

» the latest DVD/UDF Support package and latest Enhanced IDE Support package must be installed;

» If USB CD/DVD device testing is planned, the USB Basic Device Support package should also be
installed;

CD-TESTS Test Steps

Open an OS/2 window session.
Enlarge the OS/2 window so that you can see the questions on the screen as they are presented.
Do not enter any keystrokes until prompted.

At an OS/2 command prompt, change to the \cd-tests directory on the d: drive.

o » b=

At the command prompt, type:
test_cd.exe

6. Follow the instructions on the display to select the drive, tests and media type and enter the keystrokes
when prompted.

7. When the test is complete, you are returned to d:\cd-tests directory.

Results of CD-TESTS

The test writes its results in the following log files:
e d:\cd-tests\log\cd-tests.log for standard tests;

» d:\cd-tests\log\cd-ddtt.log for advanced tests (optional tests with CD-DOM Diagnostic disk, P/N
81F8902).

To determine if the tests were successful, search the file for the DEVICE string. The DEVICE1 indicate the
status for first CD-like device in system, DEVICE2 for second and DEVICES for third.

Run Time

The total run time for the CD-TESTS test is depended on device type and approximately 15 minutes for each
device.

137Gb Limit Tests (137GB_TESTS)

Purpose of 137 GB Limit tests is to check if IDE disk drives larger than 137 Gb can be handled without errors.

Hardware and Software Requirements

To successfully execute this test, the latest Enhanced IDE Support package must be installed.
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Tests will not be executed on system with a level of IBM1S506.ADD driver lower than 4.88.

Download the latest device driver software packages for OS/2 from the OS/2 Device Driver Pak Online
(http://www7 .software.ibm.com/2bcprod.nsf) or IBM Software Choice (http://www-
3.ibm.com/software/os/warp/swchoice/).

137Gb Limit Tests Steps

Normally tests will be started from GUI when FVT tests are selected. It is not necessary to execute 137 Gb
limit tests separately from other FVT tests. However if 137 Gb limit tests fails or need to be rerun for some
other reason, they be executed from command line:

1. Open an OS/2 window session.

2. Enlarge the OS/2 window so that you can see the questions on the screen as they are presented.
3. Do not enter any keystrokes until prompted.

4. Atan 0OS/2 command prompt, change to the \ide48bit directory on the d: drive.

5

At the command prompt, type:
run.cmd

6. Tests will perform three reboots between tests, and will continue 137 Gb limit test execution after each
reboot.

7. When the test is complete, you are returned to d:\ide48bit directory.

Results of 137Gb Limit Tests

The test writes its results in the following log file:
« d:\ide48bit\log\ide48bit.log for standard tests;

To determine if the tests were successful, search the file for the DEVICE string. The DEVICE1 indicate the
status for first Hard Disk device in system, DEVICE2 for second and DEVICES for third.

Run Time

The total run time for the 137Gb Limit Tests is approximately 15 minutes.

Disk Multitasking Test (FVTDISK)

This test exercises the file system's use of drive d:.

FVTDISK Steps

From an OS/2 command prompt, change to the \cmd directory, type fvtdisk and press Enter.

Note: «  All the parameters for FVTDISK are in fvtdisk.cmd

*  The defaults for FVTDISK are logical drive c: when running FVT from the PCM TEST icon. These
are changed automatically to the values entered on the menu.

Results of FVTDISK

FVTDISK creates log files named d:\logf\dasdstd1.log and d:\logf\dasdstd2.log.
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Run Time

Approximately 15 minutes.

FORMAT Utility Test (FORMAT)

This test verifies the FORMAT function for various diskette types.
The FORMAT utility tests run both the OS/2 .cmd test cases and the DOS .bat test cases.

Note: This test program can test both 5.25-inch and 3.5-inch diskettes.

FORMAT Test Steps

1. Shut down and reboot the system.

2. The tests assume that the 1.44 MB or the 1.2 MB drive is the a: drive. If your configuration is different,
edit the .inp file and change the drive letter on both the command line and FTEST line of the input files.

Open an OS/2 full screen session (change to the PCM TEST window if active).
4. Place a blank diskette in the a: drive.

If drive a: is 1.44 MB diskette drive then:
» Type cd format and press Enter.
» Type tstl 44.cmd and press Enter.

6. If drive a: is 1.2 MB diskette drive then:
» Type cd format and press Enter.
» Typetstl 2.cmd and press Enter.

Results of Format

The output .log files are scanned using grep.exe to look for the STATUS lines to provide summary
PASS/FAIL status. At the end of each .log file, a summary status is presented showing the number of
variations run, variations pass, and variations fail.

Change to the d:\logf directory.
» Type type flop144.log or type flop525.log.
*  Type type dsktrslt.log.

Run Time

Approximately 20 minutes for each drive media.

Timer Device Driver Test (TIMERDD)

The timer device driver consists of one testcase:

e DH calls functions provided in the timex1.sys to test DevHIp_SetTimer, DevHIp_ResetTimer, and
DevHIp_TickCount at task and interrupt time. This test contains 18 variations.

Attention: If your test system is connected to a network, some tests might not be successful. For example,
you might notice some timer handlers between 18 through 25 are not set. This is acceptable. There can be
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up to 10 timer handlers that may not be set and not affect 0OS/2 compatibility. However, if you have more than
10 timer handlers not set, it might be necessary to shut down the other processes and rerun the test.

TIMERDD Test Steps

1. Atan OS/2 command line, type cd timerdd and press Enter.
2. Type timer and press Enter.

3. Control is returned to the d:\timerdd directory.

Results of TIMERDD

DH test results are stored in the timerdd\dh\dh directory.
Type type dh.log |more and press Enter.

Look at each file for each of the 18 variations to determine success or failure. They will not run consecutively.

Run Time

Approximately five minutes for the dh.exe test.

Printer Device Driver Test (PRINTDD)

This is a test for printer device drivers to the parallel ports LPT1, LPT2, LPT3 and USB ports. You can test
these ports individually or collectively.

PRINTDD Test Steps

Connect a printer to the LPT and/or USB ports you want to test.
OS/2 Full Screen Printer Testing

1. Open an OS/2 full screen session.

2. Change to the \printdd directory on the d: drive

» Totest LPT1 only, type printl.cmd and press Enter. This test is required if LPT port is present in
system.

 Totest LPT2 only, type print2.cmd and press Enter. This test is optional.

e Totest LPT3 only, type print3.cmd and press Enter. This test is optional.

e Totest LPT1 and LPT2, type printl_2.cmd and press Enter. This test is optional.

e Totest LPT1 and LPT3, type printl_3.cmd and press Enter. This test is optional.

e Totest LPT2 and LPT3, type print2_3.cmd and press Enter. This test is optional.

» Totest LPT1, LPT2, and LPT3, type printall.cmd and press Enter. This test is optional.

» Totest LPT1, LPT2, and LPT3, type printall.cmd and press Enter. This test is optional.

» Totest USB port type printdd.cmd and press Enter. Choice testing mode (choice #2) and press
Enter. This test is required if LPT port is not present in system.

* Totest USB and LPT ports type printdd.cmd and press Enter. Choice testing mode (choice #3) and
press Enter.

3. Attest end, control is returned to the OS/2 full screen session.
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DOS Printer Testing

1. Open a DOS full screen session.

2. Change to the \printdd directory on the d: drive.

* Totest LPT1 only, type printl.bat and press Enter. This test is required.

» Totest LPT2 only, type print2.bat and press Enter. This test is optional.

 Totest LPT3 only, type print3.bat and press Enter. This test is optional.

e Totest LPT1 and LPT2, type printl_2.bat and press Enter. This test is optional.

e Totest LPT1 and LPT3, type printl_3.bat and press Enter. This test is optional.

e Totest LPT2 and LPT3, type print2_3.bat and press Enter. This test is optional.

» TotestLPT1, LPT2 and LPTS3, type printall.bat and press Enter. This test is optional.

At test end, press Ctrl+Esc to open the Task List window and click on waiting DOS PRINT test.

4. All tests are done when the DOS test is completed.

Results of PRINTDD

To view test output, type the file you want to check. For example, type type prtlos.log to display PASSED
| F ALL CHARACTERS WERE PRI NTED.

» prtl1os.log - Logs print1.cmd results

» prt20s.log - Logs print2.cmd results

e prt3os.log - Logs print3.cmd results

* prt120s.log - Logs print1_2.cmd results
» prt13os.log - Logs print1_3.cmd results
» prt230s.log - Logs print2_3.cmd results
« prtallos.log - Logs printall.cmd results

» prt1dos.log - Logs print1.bat results

» prt2dos.log - Logs print2.bat results

e prt3dos.log - Logs print3.bat results

e prt12dos.log - Logs print1_2.bat results
» prt13dos.log - Logs print1_3.bat results
» prt23dos.log - Logs print2_3.bat results
« prtaldos.log - Logs printall.bat results

e pddrslt.log — Logs printdd.cmd results.

Run Time

Approximately 10 minutes.

OS/2 Multimedia Tests

These tests verify the functions of the various Multimedia Presentation Manager/2 (MMPM/2) components.
They are a minimal representative test for multimedia usability in which they exercise the wave audio, MIDI,
CD and digital video devices.
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Multimedia Requirements

This test is required if the test system is shipped with either sound support or a CD-ROM.

Automated Test Steps

The Multimedia tests run unattended if selected from the Selection & Execution GUI screen.
If the test system has sound support:

e If Testkit drive is HPFS, you must run PCM_HPFS.

» If your video is VGA (resolution less than 1024 x 768 x 256), you must run PCM_VGA.
» If your video is SVGA (resolution at least 1024 x 768 x 256), you must run PCM_SVGA.
*  You mustrun PCM_FLC.

*  You must run PCM_REXX.

These test selections require a music CD in the CD-ROM drive.

* If the test system has a CD-ROM, you must run PCM_CD.

 When all tests have been selected, click on RUN.

Note: If the test system has sound support and a CD-ROM that supports streaming, then you can also run

PCM_CDS. This test is optional, and should not be run until required testing has completed, and the
results diskette is ready for submission.

Individual Test Steps

Before running these tests, type buc and press Enter to change to the cd\build\src\svt\buckcmd directory.
If the test system has sound support:

e For PCM_HPEFS, type pcm_hpfs.cmd and press Enter.

e For PCM_VGA, type runmme pcm_vga and press Enter.

» For PCM_SVGA, type runmme pcm_svga and press Enter.

» For PCM_FLC, type runmme pcm_flc and press Enter.

e For PCM_REXX, type pcm_rexx.cmd and press Enter.

The next test selections require a music CD in the CD-ROM drive.

e For PCM_CD, type runmme pcm_cd and press Enter.

 For PCM_CDS, type runmme pcm_cdst and press Enter.

» As each test ends, the script file returns to an OS/2 full screen session.

Test Results

The test results are in the d:\results\mmepcm\svtraw directory. Log files are in the d:\results\mmepcm\svtlog
directory and have the same name as the output files but end with the .log extension.

 The pcm_svga.ra_ file contains the SVGA results.

» The pcm_vga.ra_ file contains the VGA results.

» The pcm_hpfs.ra_ file contains the HPFS results.

Chapter 8. PCM Base Test Case Details 51



» The pcm_cd.ra_ file contains the CD Music results.
e The pcm_cds.ra_ file contains the CDS Music results.
e The pcm_flc.ra_ file contains the FLC results.

» The rexxrsp.out file contains the PMREXX results.

Note: There will be a total of:

11 TESTS for PCM_VGA
12 TESTS for PCM_SVGA
1 TEST for PCM_HPFS
e 2TESTS FORPCM_FLC
e 7 TESTS for PCM_CD
e+ 6 TESTS for PCM_CDS

If this test is run more than once, the output files will be appended with the new test results. To prevent
this file from getting very large, run the resetlog command from the d:\util directory. This .cmd file
deletes all files generated by these tests.

Run Time

Test duration is approximately 30 minutes for each test.

0OS/2 Journaled File System Test (PCMJFS)

This test is run on the Additional Server (S01).

This is a test of the OS/2 Journaled File System (JFS) that is run only when testing Convenience package for
0OS/2 Warp Server for e-business which implements JFS support. Do not run this testcase with other OS/2
products. This is a testcase that uses a REXX command file to format the JFS partition, and run a series of
file system commands on the JFS file partition. The default drive letter is E: as specified by system installation
instructions which would have the assigned the E: drive letter to the JFS Volume/Partition under LVM.

This testcase will also cover LVM functions of having volumes span disk partitions on the same disk drive, or
on 2 different disk drives.

If you run the PCMJFS testcase from the PCM_TEST PM GUI, you can specify a different drive letter as the
JFS Volume/Partition to be tested.

Note: This will format the drive letter provided, be sure it is the drive letter for the JFS Volume/Partition that
was setup during OS/2 installation.

PCMJFS Test Steps

At an OS/2 command line, change to the d: drive.
Type cd batch and press Enter.
Type pcmijfs e and press Enter.

The test runs and returns to the test drive prompt when through.

o bk 0N =

The command Line parameters for PCMJFS.CMD have been hard coded to call the test routine
\JFSTEST\FLSPGM1.CMD as follows:
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e /H:MB (File size to be created: KB or MB or GB or #bytes)

» /per:90 (Percentage of free space to be filled: 0->100 Default 90%)
* /num:1 (number of drives: Default is 1)

* /dI:E (JFS Drive letter, Default is E)

* /FSDir:JDIR (Dir name to create: Default is DIR)

* /FName:JFILE (File name to create: Default is FILE)

e iter:1 (no of iterations: Default is 1)

Results of PCMJES

This test is successful if the system successfully formats and exercises the JFS Volume (spanning 2
partitions, which can be on different disks).

Check the d:\jfstest\jfstest.log for PASS or FAI L information for the testcase.

Run Time

Approximately 30 minutes.

Advanced Power Management Test (APM)

The APM test is intended for portable systems that utilize batteries for power.

This test tests both APM hardware and aspects of the PM user interface including:

*  Power state definitions

 APM installed correctly and power object found

» Power object shows correct status for battery or A/C power and battery life remaining

» Standby and Suspend/Resume modes work correctly

» Power object refresh functions work correctly

Note: Non-APM Supporting Hardware: If Selective Install is used to force APM installation on a system and
the Power object is opened, the following message may occur: "The system cannot load the APM

feature". This can be caused by your system not supporting this feature or because the APM device
driver was not installed.

APM Test Steps

The following set of APM test steps describes a brief test of the APM functions installed on a system with the
OS/2 operating system.

1. Make sure the battery is fully charged.

2. Set hardware timers for screen blanking to three to five minutes and suspend timer to 15 minutes or
more.

3. Verify the following are present in config.sys.
Convenience Package for OS/2 Warp Version 4
 DEVICE=C:\OS2\BOOT\APM.SYS
* DEVICE=C:\OS2\MDOS\VAPM.SYS

Verify that Power Object is in System Setup folder.

Open an OS/2 window and insert a scratch diskette in the a: drive. From the d:\cmd directory, type
drain.cmd.
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Open the OS/2 System Setup folder and double-click on the Power Object.
Verify that the system shows "AC Powered" and "Battery State High."
Unplug A/C Charger.

9. Click on system menu for Power Object and select Refresh Now.

® N o

10. Verify that system shows "Battery Powered" and "Battery State High."
11. Allow the system time to enter standby mode (screen blanks).

12. Press any key to bring system out of standby mode, and verify that drain.cmd is still running (let it run for
a couple of minutes).

13. Click on system menu for Power Object and select Suspend. Select Yes on the pop-up menu to continue
suspend operation.

14. Press any key to bring system out of suspend mode, verify that the Desktop is OK, and that drain.cmd
continues running.

15. Click on system menu for Power Object and select Refresh to bring up the submenu, and select On to
set up automatic refresh.

16. Open the Power Object Settings/Properties. Click on the View tab, set refresh on, and refresh rate to 1-2
minutes.

17. Let the system run for 30 minutes, verify that the battery life bar shows an indication of battery drain.

18. Plug in A/C charger, wait for automatic refresh to occur (1-2 minutes) and verify that Power Object now
shows "AC powered."

19. Stop drain.cmd in OS/2 window by pressing Ctrl+Break.

20. Let battery charge for 30 minutes or more.

21. Verify that Power Object battery life indicates increased charge.
22. Close Power Object.

23. Update the file \AAPM\APM.TXT on the testcase partition.

Results of APM

Because this test is verified by the tester, no specific output files were generated. To obtain OS/2
Compatibility for Advanced Power Management, complete the information in the apm.txt file. You can print
the apm.txt file to check off during the test and to update the file after completion.

Advanced Power Management Test (APM) for Desktop Systems

This test tests both APM hardware and aspects of the PM user interface including:
 APM installed correctly and power object found

» Power object shows correct status for A/C power

» Standby and Suspend/Resume modes work correctly

»  Power off mode work correctly

Note: Non-APM Supporting Hardware: If Selective Install is used to force APM installation on a system and
the Power object is opened, the following message may occur: "The system cannot load the APM
feature". This can be caused by your system not supporting this feature or because the APM device
driver was not installed.
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APM Test Steps for Desktop Systems

The following set of APM test steps describes a brief test of the APM functions installed on a Desktop system
with the OS/2 operating system.

1. Set hardware timers for screen blanking to 3-5 minutes and suspend timer to 15min or more.

2. Verify the following are present in config.sys.
Convenience Package for OS/2 Warp Version 4
 DEVICE=C:\OS2\BOOT\APM.SYS
« DEVICE=C:\OS2\MDOS\VAPM.SYS

Verify that Power Object is in System Setup folder.

Open the OS/2 System Setup folder and double click on the Power Object.
Verify that the system shows "AC Powered".

Allow the system time to enter standby mode (screen blanks).

Touch key(s) to bring system out of standby mode.

® N o 0o A~ W

Click on system menu for Power Object and select "Suspend"”, answer "Yes" on pop-up menu to
continue suspend operation.

©

Touch key(s) to bring system out of suspend mode.

10. Click on system menu for Power Object and select "Power off", answer "Yes" on pop-up menu to
continue shutdown operation.

11. Write result to apmdesk.ixt file.

Results of APM for Desktop Systems

Because this test is verified by the tester, no specific output files were generated. To obtain OS/2
Compatibility for Advanced Power Management, complete the information in the apmdesk.txt file. You can
print the apmdesk.txt file to check off during the test and to update the file after completion.

PCMCIA

This is a test of the OS/2 interface for PCMCIA slots and devices.

The test case sections assume that the C and D partitions are defined on the hard disk and the test system
has two PCMCIA slots.

Note: 1, During Phase 3 of OS/2 installation (selective install), be sure to install all PCMCIA options (DISK,
FLASH, MODEM).

2. Double-click on the Drives icon to determine the drive letters assigned.

PCMCIA Test Steps

The PCMCIA test cases exercise the three layers of OS/2 PCMCIA support. The system unit, socket
services, and card services layers are exercised with each of the PCMCIA SVT test cases.

1. Atan OS/2 command line, change to the d: drive.
2. Type cd pcmcia and press Enter.

3. Insert the PCMCIA card to be tested in the PCMCIA slot (ATA DISK, FLASH, SRAM).
Type the appropriate command for the PCMCIA card to be tested: (Parameters are drive letters)
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e ATA Drives

Run Command Examples: pcmcia_a e or pcmcia_af
» FLASH Drives

Run Command Examples: pcmcia_f g or pcmcia_f i
« SRAM

Run Command Examples: pcmcia_s g or pcmcia_s i

Results of PCMCIA

Output Logs:
\pcmcia\ata-disk.log - should find 6 pass
\pcmcia\pcmcia_a.log
\pcmcia\fscpyata.log
\pcmcia\fsdelata.log
\pcmcia\fsdirata.log
\pcmcia\flashcrd.log - should find 4 pass

\pcmcia\sramcrd.log - should find 4 pass

SMP Verification Test
This test determines the number of processors in the SMP system and verifies that the processors are
enabled. This test is required only for SMP systems.

You must install Convenience package for OS/2 Warp Server for e-business with SMP support on your
system prior to running the test.

If the Convenience Package for OS/2 Warp Server for e-business with SMP support has not been installed,
do not run this test.

Hardware and Software Requirements

* An SMP system with at least two processors installed and enabled

» Convenience Package for OS/2 Warp Server for e-business with SMP support installed
Installation

After the operating system has been installed, install the SMP test case. Run PCMSETUP to install the
testcase if not previously installed and select the SMP test cases.

SMP Test Steps

1. Atan OS/2 full screen prompt, change to the d: drive, type cd smp, and press Enter.
2. Type smptst and press Enter.

3. Control returns to an OS/2 command prompt.
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Results of SMP

Test results are written to the d:\smp directory in the smptest.log file.

The following is an example of the smptest.log output file on an SMP system that has two processors that are
both enabled.

SMPOO1 testing starting..........

system has 2 processors

*** Processor 1 Status is enabled. ***

*** Processor 2 Status is enabled. ***

testing status on processor O.

test passed, anticipated error occurred.

testing status on a processor beyond actual nunber of processors.
test passed, anticipated error occurred.

testing status on processor O.

test passed, anticipated error occurred.

testing status on a processor beyond actual nunmber of processors.
test passed, anticipated error occurred.

testing status of null.

test passed, anticipated error occurred.

testing status greater than 1

test passed, anticipated error occurred.

SWMP testing ended. .............

Examine the output smptest.log file for any messages that may indicate test failure by comparing the sample
output to your output file.

Run Time

Less than one minute.

Speech Recognition (SPEECH)

System Requirements

* Intel Pentium 90 MHz or faster

* 16 MB memory

» 300 MB OS/2 boot partition

e Sound card (refer to the OS/2 Warp 4.0 readme for a list of supported cards)
e Speakers

*  Microphone
Installation Verification

1. Double-click on the Programs icon on Desktop.
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2. Verify that the VoiceType folder is present. Open the folder.

3. Verify that the following icons are in VoiceType folder:

a.

TT@ ™m0 a0oT

Dictation Window

Dictation Macro Editor

Enroliment

VoiceType Users Guide (shadow icon)
States Game

Migrate User Information

Optional Vocabularies Install/Uninstall
Check Installation

Voice Manager

4. Check Installation:

a. Double-click on Check Installation icon.

b. Enter user name and click on Create.

c. Click on OK in pop-up window indicating that new user has been created successfully.

d. Click on Start Test. Repeat the words presented in the display area. Continue until all seven test
words have been spoken and recognized. The test will stop when all seven are completed. Click on
OK in pop-up window indicating that the test completed successfully.

e. Click on Check Speakers. Let recording play for at least five seconds and then click on OK to stop.

f. Click on Record. The pop-up will request that you read at least eight words, using consistent volume.
Then, click on OK. Speak at least eight words (a sentence) into microphone. Click on Stop, and then
click on Play to play back the recording.

g. Click on Exit to close.

h. Click on YES to save input and match level established.

Voice Test

1. Click on States Game. Wait for application and Voice Manager to open and initialize.

2. Click on Microphone in Voice Manager to activate.

Say the names of several states and verify that they are highlighted.

Note: 1. The Help button provides a list of state names and indicates which have been spoken and
recognized.

2. It might be necessary to modify the voice settings for match. To do this, click on the Voice
Manager icon to the left of the help icon. Click on the Audio tab and go to the second
page. Adjust the slide bar for sound match to the left for more approximate match. Then
retry the States Game.

4. Close the States Game.

Verify that the microphone in Voice Manager is still active.

Desktop Navigation Test:

o bk 0 bdh =

Say "Jump to Command Prompts."

Verify that the Command Prompts folder opens on the Desktop.
Say Up/Down/Left/Right as needed to highlight OS/2 window.
Say "Open," and verify that an OS/2 window opens.

Say "Close" and when pop-up panel is displayed, say "Yes" to continue closing.
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Results of SPEECH Tests

Update the file \SPEECH\SPEECH.TXT on the testcase partition.

Because this test is verified by the tester, no specific output files were generated. To obtain OS/2
Compatibility for Speech Recognition, complete the information in the speech.txt file. You can print the
speech.txt file to check off during the test and to update the file after completion.
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Chapter 9. LAN Test Case Details

The individual test cases in this chapter can be used when rerunning a single test manually. This may be
necessary after a test failure has been corrected. These tests are run by typing the appropriate command
from the command line.

Note: Copies of the log files will be located in the \xxxlogs directory on each system that the individual tests
were started on.

The following information is included, where appropriate, for each test:
e The name of the test, or part of the test

» A description of the test

» The steps to run the test

* The test results

e The test duration

LAN Test Case Summary

The following table lists the test cases in the LAN testkit, where to get the details about each test case, and
the approximate run time.

Table 3. Summary of LAN Tests

Test Description Approximate Run Time

ITLDUMP 0OS/2 Dump Utility on page 69 15 Minutes

ITLLS56.CMD LAN Server Exerciser for Domain |2 Hours
on page 61

ITLLS57.CMD LAN Server Exerciser for Server on |2 Hours
page 61

ITLFTPO1.CMD FTP Server/Ping Exerciser of S01 |2 Hours
on page 63

ITLFTP02.CMD FTP Server/Ping Exerciser of DO1 |2 Hours
on page 63

ITLTCP0O1.CMD TCP/IP Remote Execution on RO1 (15 Minutes
on page 63

ITLALERT.CMD Alert Reporting on S01 on page 62 (15 Minutes

ITLMSG.CMD LAN Messaging on page 62 1 Hour

ITLPEER.CMD PEER Services Exerciser on page |2 Hours
61

ITLPSNSOQ0 Backup/Restore on page 68 30 Minutes
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ITLRAID SystemView RAID Information on (30 Minutes
page 69

ITLSVOO Group Management on page 64 15 Minutes

ITLSVO6 Monitor Remote Workstation on 30 Minutes
page 64

ITLSVO7 Hardware Inventory (Group) on 15 Minutes
page 65

ITLSVO8 Software Inventory (Group) on 15 Minutes
page 66

ITLSV11 S01-System Information Tool on 10 Minutes
page 67

LAN Server Exerciser (ITLLS56, ITLLS57)

This test case will generate network traffic by creating a link between multiple requesters and a file server.
The itlls56.cmd test runs on S01, R01, and R02. The itlls57.cmd test runs on D01, R0O1, and R02.

ITLLS56 and ITLLS57 Test Steps

1. Open an OS/2 window.

2. Type net name and press Enter to verify the system is logged on to the domain controller. If the system
is not logged on, type the following:

logon ITO1xxxU /d:ITO1D01A /p:UPWO01xxx /v:d
4. where xxx is the system name (D01, S01, R01, R02).

To test the domain controller, type itlls56.cmd on systems S01, R01, and R02. This test must be started
on all three systems at the same time. Log files for itlls56 will be copied to the \dO1logs directory on the
domain controller.

To test the additional server, type itlls57.cmd on systems D01, R01, and R02. This test must be started
on all three systems at the same time. Log files for itlls57 will be copied to the \sO1logs directory on the
additional server.

Results of ITLLS56 and ITLLS57

This test is successful if all three of the requesters are able to connect to the domain controller or additional
server and are able to run the tests for a minimum of two hours without a failure.

Peer Services (ITLPEER)

This test case will exercise the OS/2 Peer function by sharing a local subdirectory with the network. The test
case runs on the additional server (S01) and client 2 (R02).

ITLPEER Test Steps

Start the test case from client 2 and the additional server by typing the command itlpeer.cmd.
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Note: If problems occur from the remote workstation while trying to access the shared resource, verify that
the correct access is being granted for this resource. In order to run the test case, the resource needs
to be given read/write access. To verify the access, double-click on the Sharing and Connecting icon.
Clicking on this icon will open a notebook. Select the Access controls tab, the specific resource, and
then click on the Set Access Permissions button.

This test will run for approximately two hours. The log file itlpeer.xxx will be copied to \rO1logs on client 1.

Results of ITLPEER

This test is successful if both the additional server (S01) and the client 2 (R02) systems are able to access
the Peer workstation (client 1) and run ITLPEER a minimum of two hours without a failure.

LAN Messaging (ITLMSG)

This test will generate light messaging traffic on the network. This test is run from the domain controller and
client 1 systems.

ITLMSG Test Steps

1. Enter the following command on the domain controller or client 1:

itimsg
If the target workstation is busy, this test case might stop with a message indicating the workstation is
busy or not responding. This is normal if the workstation getting the message is running multiple test
cases.

Notes:

» This executable will send a message to the target systems once every 30 seconds. 120
messages will run for little more than a hour.

« NETPOPUP Service should be running on the domain controller and can be stopped by typing
net stop netpopup. To restart, type net start netpopup.

2. To view the log on the target systems, open the IBM LAN Services folder and double-click on the
Network Messaging icon.

Results of ITLMSG

This test is successful if the test case runs to completion without a failure. This test should run for a minimum
of one hour.

LAN Alerts (ITLALERT)

The purpose of this test is to generate an FFST/2 alert on the additional server (S01). To generate this alert,
available space on the c: drive is reduced to less than 15,000,000 bytes. Run this test on the additional server
(S01).

ITLALERT Test Steps

1. Make sure that the LAN Server was started as follows (this should be in the startup.cmd file):
2. net start server /e:1 /alerts:1 /alertn:IT01S01 /di: 15000

3. net start alerter
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4. net start genalert

5. On the additional server:

a. Type itlalert at the c: drive. This command will build a temporary directory and fill it with test data
files. When the available space is less than 15 MB, the program will sleep for two minutes before the
test data files are erased and the \temp directory is removed. The amount of free disk space will
dictate how long the executable will take.

Note: A drive with 180 MB of free space will be filled up in approximately 10 minutes.

b. You should receive a pop-up message when the alert is detected. You can check the message log to
determine if the message was received. Open the IBM LAN Services folder on the Desktop, and then
select Network Messaging. From here you can review all messages.

Results of ITLALERT

TCP/IP FTP to Host and Ping (ITLFTPOL, ITLFTPO2)

This test case will ftp to a remote host and ping the host before sleeping. This test case is run on client 1 and
client 2.

ITLFTPO1 and ITLFTPO2 Test Steps

1. Open an OS/2 window.

2. To test the domain controller, type itlftpO1l.cmd on client 1.
To test the additional server, type itlftp02.cmd on client 2.

Results of ITLFTPO1 and ITLFTPO2

This test is successful if the FTP test case is able to run on both requesters for a minimum of two hours
without a failure.

TCP/IP Remote Execution (ITLTCPO1)

This test case will run commands on a remote host, sleep, and then continue looping. This test case is run on
the domain controller.

ITLTCPO1 Test Steps

1. Open an OS/2 window.
2. Type itltcp01.

Results of ITLTCPO1

This test is successful if the REXEC test case is able to run for a minimum of two hours without a failure.
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Group Management (ITLSVOO Optional)

Run this testcase if Netfinity Manager v5.xx is installed.

This test case verifies Netfinity functions in the creation of several groups of managed systems based on
communication protocol, and operating system.

This test is run on the additional server.
*  With Convenience Package for OS/2 Warp Server for e-business, Netfinity is used.
1. Open the Netfinity, folder on the desktop.
2. Open the Netfinity Service Manager icon.
Open the Remote System Manager icon.

Note: If a group ALL already exists, then continue with step 6 to add systems to the group.

4. From the Group pull down menu, select Add Group, and enter ALL for the group name. Then click on
Add to close the window.

Note: No keywords are used for this group.

5. Click on the ALL group once with the right mouse button and then select Discovery Filters. Highlight the

TCP/IP and NETBIOS protocols, and click on Save.
6. In the System Group Management window, double-click on All to open the Group window.
From the Systems pull down menu, select Discover Systems.
Note: This should fill the window with systems as they are being discovered. It should find two entries
for systems D01, S01, and R02, and one entry for RO1. When all systems are found, close the
Group window.
8. Create two additional groups following step 4 above and name them NETBIOSWS and TCPIPWS.
Note: No keywords are used for either group.
9. Click on each group once with the right mouse button and then select Discovery Filters. Select the
appropriate protocol for each group and click on Save.

10. Then use steps 6 and 7 above to discover systems for each group.

Results of ITLSVOO

Demonstrate that the correct systems are discovered in each of the defined groups.

* Inthe All group, you should see two icons for D01, S01, and R02, and one icon for RO1.

e Inthe NETBIOSWS group, you should see one icon for each of the systems.

* Inthe TCPIPWS group, you should see one icon for D01, S01, and R02, and no icon for RO1.

Monitor Remote System's Resources (ITLSV06 Optional)

Run this testcase if Netfinity Manager v5.xx is installed.
This test case verifies Netfinity functions for remote monitoring of a managed system.
This test must run after ITLSVOO because it relies on having groups of systems already defined.

This test is run on the additional server.
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With Convenience Package for OS/2 Warp Server for e-business, Netfinity is used.

ITLSVO6 Test Steps

1
2
3.
4

o

1.
12.
13.
14.

Open the Netfinity, folder on the desktop.
Open the Netfinity Service Manager icon.
Open the Remote System Manager icon.

From the System Groups window, double-click on the ALL group to open it. Active workstations will
have a green screen on their icon.

Double-click on one of the active systems to open the Remote Service window for that system.
Double-click on the System Monitor icon to bring up the window that shows CPU utilization.

From the System Monitor Service panel, use the Windows pull down menu and select Show
Monitors.

CPU Utilization should already be highlighted, highlight one or two other resources to monitor from the list
and click on Accept to begin monitoring the highlighted selections.

Let the monitor run for at least 30 minutes.

. From the System Monitor Service panel, use the Windows pull down menu and select Export to

database.

Click on OK to accept the defaults on the Database selection panel.
Click on OK to accept the defaults on the Export to File panel.

Click on OK on the Data Base Status pop-up panel.

Close the Monitor and all folders.

Results of ITLSVO06

This test is successful if the Netfinity Managing system can monitor the target system without errors.
Monitoring should take place in 30 minute intervals.

For Convenience Package for OS/2 Warp Server for e-business, the file ITO1 .DBF, will be created in the
\NETFIN directory on the OS/2 Boot Drive.

The appropriate file will be verified during results processing.

Hardware Inventory (ITLSVO7 Optional)

Run this testcase if Netfinity Manager v5.xx is installed.

This test case verifies Netfinity functions to collect hardware information from all clients and store the
information in files on the additional server.

This test must run after ITLSVOO because it relies on having groups of systems already defined.

This test is run on the additional server.

This test case is set up to run one time.

With Convenience Package for OS/2 Warp Server for e-business, Netfinity is used.

ITLSVO7 Test Steps

1.

Open the SystemView / TME10 / Netfinity, folder on the desktop.
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Open the SystemView / Netfinity Service Manager icon.
Open the Remote System Manager icon.

Open the Event Scheduler icon.

Click on New and enter the event name HW_INVENTORY.

Highlight System Information Tool and click on Groups. This will open the Schedule Groups or
Systems window.

7. Highlight TCPIPWS from the Groups listbox, this will fill in the Systems listbox with a highlighted entry for
three systems (RO1 is not discovered under TCPIP).

Click on Schedule.

Create Print Output or History File should already be selected with the history file directory. Click on
Save.

R e

10. The Schedule Time and Date panel is displayed. Click on the one time radio button and choose a time
of at least 10 minutes from the current time.

11. Click on Save.
From the Scheduler Service panel, The event HW_INVENTORY will show as scheduled.

Wait for the event time to pass, then click on View Log to verify that the events were executed and
successful.

Results of ITLSVO07

This test is successful if at least three successful events were executed and the results are in the specified
files.

For Convenience Package for OS/2 Warp Server for e-business, the files ITO1 .HST, will be created in
the \NETFIN directory on the OS/2 Boot Drive.

The appropriate file will be verified during results processing.

Software Inventory (ITLSV08 Optional)

Run this testcase if Netfinity Manager v5.xx is installed.

This test case verifies Netfinity functions to collect software inventory from all clients and store the information
in files on the additional server.

This test must run after ITLSVOO because it relies on having groups of systems already defined.
This test is run on the additional server.
This test case is set up to run one time.

»  With Convenience Package for OS/2 Warp Server for e-business, Netfinity is used.

ITLSVO8 Test Steps

Open the Netfinity, folder on the desktop.

Open the Netfinity Service Manager icon.

Open the Remote System Manager icon.

Open the Event Scheduler icon.

Click on New and enter the event name SW_INVENTORY.

o M N =

66 Chapter 9. LAN Test Case Details



6. Highlight Software Inventory and click on Groups. This will open the Schedule Groups or Systems
window.

7. Highlight NETBIOSWS from the Groups listbox, this will fill in the Systems listbox with a highlighted entry
for all four systems.

Click on Schedule.
9. Click on OK to accept the default to generate system reports.

10. The Schedule Time and Date panel is displayed. Click on the one time radio button and choose a time
of at least 10 minutes from the current time.

11. Click on Save.
From the Scheduler Service panel, The event SW_INVENTORY will show as scheduled.

Wait for the event time to pass, then click on View Log to verify that the events were executed and
successful.

Results of ITLSVO0S8

This test is successful if at least four successful events were executed and the results are in the specified
files.

For Convenience Package for OS/2 Warp Server for e-business, the files ITO1 INV, will be created in the
\NETFIN directory on the OS/2 Boot Drive.

The appropriate file will be verified during results processing.

System Information Tool (ITLSV11 Optional)

Run this testcase if Netfinity Manager v5.xx is installed.

This test case verifies SystemView / TME10 / Neffinity functions of correctly identifying a systems hardware
information.

This test must run after ITLSVOO because it relies on having groups of systems already defined.
This test is run on the additional server.

*  With Convenience Package for OS/2 Warp Server for e-business, Netfinity is used.

ITLSV11 Test Steps

Open the Netfinity, folder on the desktop.
Open the Netfinity Service Manager icon.
Open the Remote System Manager icon.
Open the System Information icon. This will bring up information about the local machine.

Verify the memory, adapter card, and CPU information is correctly identified in that view.

o ok w0 DN =

From the File pull down menu, select Save to file or Print All System Data To File, depending on the OS/2
version being tested.

N

Accept the default file name and directory.
If a completion pop-up panel is displayed, click on OK to close.

Close all folders.
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Results of ITLSV11

This test is successful if the System Information tool correctly gathers hardware information for the target
machine.

For Convenience Package for OS/2 Warp Server for e-business, the file sysinfo.rpt, will be created in the
\NETFIN directory on the OS/2 Boot Drive.

The appropriate file will be verified during results processing.

Personal Safe and Sound (ITLPSNS)

This test case will exercise some of the basic functions provided with the Personal Safe and Sound backup
and restore utility provided with OS/2 Warp Server. This test is run on the domain controller.

ITLPSNS Test Steps

1. Atan OS/2 command prompt, net use to the directory where the backup will be stored by typing the
following:

2. netuse x: sO1util

Open the OS/2 Warp Server PSNS Backup/Restore folder and click on the Backup/Restore icon, and
then click on the Move on button and the Done for now button.

4. From the Tools pull-down menu, select Storage Devices. This will list available devices that the backup
can be created upon.

5. Click on the button in the upper-left corner of the screen and select New. Select Remote Disk.

On Storage Device Remote Disk select the remote drive and directory name, which should be psns5bkp,
and click on OK. Then close the Storage Devices window.

7. From the Tools pull-down menu, select Backup Sets. Click on the button in the upper-left corner of the
screen, select Available Sets, and click on New. For Name, type: Backup of ITLUTIL on SO1. For
Storage Device, select the drive letter (x:) you created using the net use command earlier. Click on OK.

8. You will be prompted to enter another description. Enter a description and then click on OK. Close the
Backup Sets window.

9. From the Tools pull-down menu, select Backup Methods. This will list the defined (default) ways in
which the backup can be run. Click on the button in the upper-left corner of the screen and select New.
Enter the following information from the example provided:

Description: Backup of ITLUTIL directory on Additional Server
Source: Select "Only allow backup of files below"

Select the C drive and for directory, type: ITLUTIL
Compression: Select for no compression
Preview: By pass this section (click on red arrow)
Backup Set: Select the name "Backup of ITLUTIL on SO1"

10. At this point, click on Save As at the bottom of the screen and type Backup of ITLUTIL on S01. Close
the Backup Methods window.

11. Click on the clock icon on the PSNS screen.
12. From the schedule window, click on the button in the upper-left corner and select Active Events.

13. Click on New and then click on Daily Event. For Backup Method, select Backup of ITLUTIL on SO1. For
time, select a time of at least five minutes from the current time. When complete, click on OK.

14. When the backup has been accomplished, the restore functions must be exercised. From the PSNS
screen, select Restore and then select Everything.
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Note: Itis necessary to build a Restore method first by doing the following:

a. Select RESTORE from the pull-down menu.

b. Select EDIT A NEW METHOD from the selection presented.

c. Provide a description (your choice) in the description field.

d. Select the backup set name you used when defining the backup.

e. Bypass the preview selection.

f. Click on Save as and give it a name of your choice. This is the name you will select to
initiate the restore. Click on OK. This will take you back to the original PSnS menu.

g. Select RESTORE from the pull-down menu and click on the restore name you
supplied to start the restore.

15. Update the file ITLUTILMTLPSNS.TXT with results.

Results of ITLPSNS

This test is successful if the backup/restore exercises have been run and files have been restored to the
domain controller.

OS/2 Dump Test Case (ITLDUMP)

This test case will verify the ability of a hardware system to take a successful system dump. This test is run
on the domain controller (d01).

ITLDUMP Test Steps
1. Create a FAT partition that is at least 1 MB larger than the amount of system memory. Format the
partition and call it SADUMP.

2. Edit config.sys by adding TRAPDUMP=ON, x: where X is the drive letter for the FAT partition that was just
created.

Shut down and reboot the system.
Edit config.sys and remove the TRAPDUMP line.

Shut down the system a second time and when you see the Ctrl+Alt+Del window, press
Ctl+Alt+NumLock+NumLock.
This will start a dump of memory to the FAT partition. When it is complete the system should reboot.

6. Update the file ITLUTILNTLDUMP.TXT with results.

Results of ITLDUMP

This test is successful if the system successfully reboots and the SADUMP partition is loaded with dump
data.

Netfinity Raid Information (ITLRAID Optional)

Run this testcase if Netfinity Manager v5.xx is installed.

This test case will verify the ability of Netfinity to recognize that a system under test has a RAID driver, and
that an alert is generated when a device fails, is replaced and rebuilt.

Depending on the RAID adapter, it may be necessary to add the RAID Support/Configuration Utilities to the
system under test.
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Setup of RAID-1 or RAID-5 must have been completed before installation of OS/2 as defined "Setting Up the
Domain Controller".

ITLRAID Test Steps

1. With OS/2 Running, install the RAID Support/Configuration Utilities for the RAID adapter. Shutdown and
reboot only if required by the RAID Support Utility installation.

2. Create a disk failure:
e If disks are Hot-Swappable:

* Remove 1 RAID drive while system is running.
»  Wait for alert pop-up before continuing.

» If disks are NOT Hot-Swappable:
e Shutdown OS/2 - but do not reboot yet.

* Remove 1 RAID drive.
* Reboot 0S/2
»  Wait for alert pop-up before continuing.
Close the Alert pop-up by double clicking on the system icon in the left corner of the title bar.

4. Replace the failed drive:
» If disks are Hot-Swappable:

* Re-insert the RAID drive while the system is running.

» If disks are NOT Hot-Swappable:
e Shutdown OS/2 - but do not reboot yet.

* Re-insert the RAID drive.
 Reboot 0OS/2

5. Rebuild the RAID drive using the RAID Support Utilities for the Adapter. If the RAID adapter can only be
re-built during with a standalone boot utility, shutdown OS/2 and rebuild the drive.

Note: Alerts should be generated when the drive is removed and flagged as failing, when the drive has been
placed in rebuild status (if rebuild support utility runs while OS/2 is booted), and when the drive is
placed back online following successful rebuild.

To check the alerts generated, do the following:

1. Open the Netffinity folder on the desktop.

2. Open the Netfinity Service Manager.

3. Open the Alert Manager.

Results of ITLRAID

This test is successful if the alerts are generated and the system continued to operate after a drive was
removed, replaced, and rebuilt.

The alerts are written to \netfin\alerts.log and checked during results processing for alerts expected.
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Chapter 10. Uninstalling the OS/2 PCM Compatibility Testkit

To uninstall the OS/2 PCM Compatibility Testkit, type remvkit at an OS/2 command prompt. This removes
the OS/2 PCM Compatibility Testkit code and all log files.

If you need to rerun all of the base tests, for example after a processor upgrade, use the clearpcm
command, which will remove only the base test case log files. If you need to rerun all of the network tests, for
example after a system upgrade or if a different LAN card is used, use the clearlan command on all four
systems, which will remove only the network test case log files.
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Appendix A. Install and Configure Convenience Package for
OS/2 Warp Server for e-business

This appendix details the steps needed to install your domain controller and additional server with
Convenience Package for OS/2 Warp Server for e-business for testing with the OS/2 PCM Compatibility
Testkit Version 4.91.

Setting Up the Domain Controller

Setting up the domain controller consists of:
* Loading the domain controller
»  Configuring the domain controller

* Installing the network test cases

Note: All system names, addresses, user names, and passwords are case-sensitive and must be typed
exactly as shown.

Note: If the system supports RAID disks, configure the machine with a minimum of three physical disks and
set up the RAID controller for RAID-1 or RAID-5 configuration. See "Netfinity Raid Information
(ITLRAID)" for additional information.

Load the domain controller with Convenience Package for OS/2 Warp Server for e-business.

The following steps walk through the installation of the operating system on the system destined to be the
domain controller.

1. If there are any files on the hard drive of the system that you want to keep, make a copy of them now.
This procedure will delete all files on the hard drive.

2. Shut down or power off all four systems in your test environment (the domain controller you are about to
load, the additional server, and both client systems). Make sure the additional server and both clients
remain shut down or powered off while you load the domain controller.

Insert the OS/2 Installation diskette in the a: drive.

Power on or restart the system.

When prompted for the OS/2 Diskette 1, insert the diskette and the OS/2 CD, and press Enter.
When prompted for the OS/2 Diskette 2, insert the diskette and press Enter.
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At the Welcome screen, press Enter to start loading from the CD.
If the Welcome screen is not displayed, see "Resolving Problems during Installations".

8. The OS/2 Warp Server for e-business Installation is displayed, press Enter.

If there are no volumes or partitions defined:

« The Volumes Too Small screen is presented, press Enter.

e If there are partitions defined, but no volumes defined:

* The "Volume Conversion Utility" (VCU) will convert disk partitions that do not have volumes defined
to compatibility volumes. Drive letters will be assigned to any partition that would be visible under
previous versions of OS/2. Hidden partitions (2nd primary partition on a drive) will not be converted.

» The VCU conversion screen will be presented indicating the number of compatibility volumes
created, and prompt you to reboot using the installation diskettes.

If there are volumes and partitions defined:
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* The Installation Volume Selection screen will be displayed.
» Highlight 2. Specify your own installation volume, and press Enter.

9. A Modifying Volumes Warning is displayed indicating all data on the volumes will be lost. Be sure there
is nothing left on the drive(s) that might still be needed, and then press Enter to start the Logical Volume
Managment Tool (LVM).

10. If the message A volume of the following minimum size must be set installable: 120megabytes is
displayed, press Enter.
If needed, press F3 to exit the installation and back up any necessary data.

Note: If the system has both IDE and SCSI/RAID disks, and the IDE disk is in the boot sequence

before the SCSI/RAID, then install OS/2 Boot manager and create the SADUMP partition on
the IDE disk. The OS/2 boot partition, and at least one of the JFS partitions should be created
on the SCSI/RAID disks.

Note: If the system has more than 1 disk of a particular type, then define JFS logical partitions on at

least 2 disks that can be used for testing the LVM function of having JFS volumes span
physical disks. However, if the system has only 1 disk drive, then 2 partitions can be defined
on the drive for testing LVM volume spanning.

Note: If you know the system bios supports booting from a partition that begins or extends

beyond 8.3GB (cylinder 1024) on large drives, then create a partition on the disk beyond
the 8.3GB range for the OS/2 bootable volume. You can create a filler partition to take up the
free space not allocated or required for PCM testing.

Note: When using LVM to modify partitions and volumes, you must first delete the volumes and

partitions and then re-create them.

11. The Logical Volume Management Tool - Logical View screen is displayed. Setup the disk partitions
and volumes as follows:
a. Install OS/2 Boot Manager

In the Logical Volume section at the top, the entry [CDROM-1], may be the only entry, and the
Disk Partition section at the bottom will be blank.

Press Enter to bring up the Options screen.

Highlight Install boot manager and press Enter.

b. Press F5 to change to the physical view.
c. Define Physical Partition for OS/2:

Tab up to the Physical Disks section, and highlight the disk drive to be used for OS/2
installation.

Tab down to the Disk Partition section, and highlight [free space 1].

Press Enter to bring up the Options menu.

Highlight Create a new partition, and press Enter.

Highlight Primary Partition, and press Enter.

Note: If you know the system BIOS supports booting from a partition that begins or
extends beyond 8.3GB (1024 cylinders), then in the next step, select create at end of
free space, otherwise select create at beginning free space.

Highlight Create at the beginning of free space, and press Enter.

Clear the entry field, and enter Warp Server for the partition name, and press Enter.

Set the size of the boot partition to 500 MB, and press Enter.

Appendix A. Install and Configure Convenience Package for OS/2 Warp Server for e-business 73



d. Define Physical Partition for PCMTEST:

Tab up to the Physical Disks section, and highlight the disk drive to be used for the PCMTEST
partition.

Tab down to the Disk Partition section, and highlight [free space 1].

Press Enter to bring up the Options menu.

Highlight Create a new partition, and press Enter.

Highlight Logical Partition, and press Enter.

Highlight Create at beginning of free space and press Enter.

Clear the entry field presented, and enter PCMTEST for the partition name, and press Enter.

Set the size of the pcmtest partition to at least 230MB, and press Enter.

e. Define Physical Partition for SADUMP:

Tab up to the Physical Disks section, and highlight the disk drive to be used for the SADUMP
partition.

Tab down to the Disk Partition section, and highlight [free space 1].

Press Enter to bring up the Options menu.

Highlight Create a new partition, and press Enter.

Highlight Logical Partition, and press Enter.

Highlight Create at beginning of free space and press Enter.

Clear the entry field presented, and enter SADUMP for the partition name, and press Enter.

Set the size of the dump partition to at least 20MB greater than installed memory, and press
Enter.

f. Define Physical Partition for JFS:

Tab up to the Physical Disks section, and highlight the disk drive to be used for the Journaled
File System (JFS).

Tab down to Disk Partition section, and highlight [free space 1].

Press enter to bring up the Options menu.

Highlight Create a new partition, and press Enter.

Highlight Logical Partition, and press Enter.

Highlight Create at the end of free space, and press Enter.

Clear the entry field, and enter JFS Drivel for the partition name, and press Enter.
Set the size of the JFS partition to 100 MB, and press Enter.

Note: If you have more than 1 disk, and the above JFS partition was created on the first disk,
then use the steps from above to create a JFS partition on the second disk. This allows
testing of volumes that span physical disks. Enter the second partition name as JFS
Drive2, and set the size to 100MB. Otherwise, if you only have 1 disk, define the 2nd JFS
partition on the same drive, and when the JFS Volume is setup it will span partitions.

g. Press F5 to change to the Logical Volume Management Tool - Logical View.
h. Define OS/2 Boot Volume:

Press Enter for the Options menu.
Highlight Create a new volume, and press Enter.

Highlight Create a volume that can be made bootable, and press Enter.
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Highlight C: and press Enter.

Type WSVR for e-business as the volume name, and press Enter.

A pop-up panel asks you to choose the disk for creating the volume, press Enter.
Highlight the disk drive selected for OS/2 installation, and press Enter.

Highlight Use existing partition, and press Enter.

Highlight [Warp Server 500], and press Enter.

The partition name Warp Server is presented, press Enter to accept.

Add OS/2 Boot Volume to Boot Manager:

Highlight the volume WSVR for e-business.

Press Enter for the Options menu.

Highlight Set Boot Manager startup values, and press Enter.
Highlight Default boot selection field, and press Enter.
Highlight Save the changes, and press Enter.

Define PCMTEST volume:

Press Enter for the Options menu.

Highlight Create a new volume, and press enter.

Highlight Create a volume that does not need to be bootable, and press Enter.
Highlight Create a compatibility volume and press Enter.

Highlight D: and press Enter.

Type PCMTEST as the volume name, and press Enter.

A pop-up panel asks you to choose the disk for creating the volume, press Enter.
Highlight the disk drive selected for PCMTEST, and press Enter.

Highlight Use existing partition, and press Enter.

Highlight [PCMTEST nnn], and press Enter.

The partition name PCMTEST is presented, press Enter to accept.

Define SADUMP volume:

Press Enter for the Options menu.

Highlight Create a new volume, and press enter.

Highlight Create a volume that does not need to be bootable, and press Enter.
Highlight Create a compatibility volume and press Enter.

Highlight E: and press Enter.

Type SADUMP as the volume name, and press Enter.

A pop-up panel asks you to choose the disk for creating the volume, press Enter.
Highlight the disk drive selected for SADUMP, and press Enter.

Highlight Use existing partition, and press Enter.

Highlight [SADUMP nnn], and press Enter.

The partition name SADUMP is presented, press Enter to accept.

Define JFS (Journaled File System) volume:
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Press Enter for the Options menu.

Highlight Create a new volume, and press enter.

Highlight Create a volume that does not need to be bootable, and press Enter.
Highlight Create an LVM volume and press Enter.

Highlight F: and press Enter.

Type JFS Volume as the volume name, and press Enter.

A pop-up panel asks you to choose a disk for creating the volume, and then press F6 to complete
creation of the volume. Only press Enter for now.

Highlight the disk drive selected for JFS Drive1, and press Enter.
Highlight Use existing partition, and press Enter.
Highlight [JFS Drivel nnn], and press Enter.

The partition name JFS Drivel is presented, press Enter to accept.

Note: If you have more that 1 physical disk installed, and created a second logical partition JFS
Drive2, then continue to setup the JFS volume to span physical disk partitions.
Otherwise, press F6 now to finish the LVM volume definition.

Highlight the physical disk that JFS Drive2 was created on and press Enter.
Highlight Use existing partition, and press Enter.

Highlight [JFS Drive2 nnn], and press Enter.

The partition name JFS Drive2 is presented, press Enter to accept.

Press F6 to finish the LVM volume definition.

The rest of the disks can be left as free space for now.
Press F3 to exit.
Highlight Save the changes and exit, and press Enter.

12. If disk partitions were modified, follow the instructions to reboot the system using the new disk partitions.
Use the same installation diskettes as before.

At the Welcome screen, press Enter.
The OS/2 Warp Server for e-business installation screen is presented, press Enter.

The Installation Volume Selection screen is presented, and the message in the middle of the
screen should say OS/2 Warp Server for e-business will be installed on: Volume C. Highlight
option 1. Accept the volume, and press Enter.

13.

14.

15.

Note: It will be the boot drive that was set as installable with LVM.

Select 2. Format the Partition on the Formatting the Installation Partition screen.

Note: When disk partitions have been modified, the boot partition will be unformatted and this screen

will not be presented.

The Formatting the Installation Volume screen is presented. Select option 1. Perform a long format,
and press Enter.

On the Select the File System screen, highlight option 1. High Performance File System, and press Enter.

Note: There are test cases that require HPFS in order to use file names greater than eight

characters long.

Note: If the boot volume is currently formatted, a warning screen is displayed indicating that the hard
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disk might contain data. Press Enter to continue with formatting.
The system starts copying data from the CD to the system's hard disk. A progress bar displays the status of
this activity.

16. When loading is complete, an all blue screen is displayed requesting you to remove the diskette from the
a: drive, and press Enter to reboot the system.

When the system boots this time, it is booting from the hard drive. The system automatically opens the
System Configuration screen. The following steps identify how the system should be configured.

17. On the System Configuration screen, click on Next.
18. The System Configuration(cont.) screen is presented. Click on Next.

19. The Country Information screen is presented, choose the United States, and select codepage
(437,850) and click on OK

20. The Select System Default Printer screen is displayed.
21. Select Do not install default printer and click on OK.

22. If your system recognizes a sound card, it opens the Multimedia Device Settings screen. Click on
Selections to verify the adapter settings, and then click on OK.

23. In the Primary Display Driver Install screen, the video driver is already selected. Click on OK to accept
the default.

24. The OS/2 Warp Server for e-business Setup and Installation screen is presented. Accept the defaults
and click on Next.

25. The Installing IBM OS/2 Warp Server for e-business screen is displayed. Click on Next.

26. The Information screen is displayed, DO NOT ADD ANY INFORMATION ON THIS SCREEN, click on
Next.

27. On the Select the services to install screen, check the following items:
» File and Print Sharing Services
* Click on more button and turn on check box for Generic Alerter Service, and click on OK.

+ TCP/IP Services
» Click on more button and turn on check box for Network File System (NFS) Support, and click
on OK.

* Netscape Communicator
« Tivoli Management Agent
e PSnS Backup and Recovery
28. Click on Next. The Configuration screen is displayed.

The next set of steps configure the characteristics of the domain controller. The test cases depend on this
information. If you do not follow these instructions exacitly, test cases might fail. On the left side of the screen
is a list of the components to configure.

29. OS/2 Warp Server for e-business - explains the color codes of the check marks and needs no input.

30. Click on File and Print Sharing Services - do the following:
» Verify that the Domain controller radio button is selected.

Enter a Server name: [T01D01
Enter a Domain name: [IT0O1D01D

31. Click on Network Adapters for File and Print Sharing - this will have been filled out already if OS/2 was
able to detect the network adapter card installed in the system. If no information is displayed, or the
wrong adapter is listed, then the installed network adapter needs to be identified to OS/2. Follow the
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instructions in step 41 to identify the network adapter and load the driver, then return to this step and
continue.

32. Click on Autostart - in addition to the items already selected, also select the following:
e Alerter
» Generic Alerter
If this item is disabled, then the Generic Alerter service was not selected when File and Print Services
was selected for installation (see step 27).

33. Click on User ID and Password - enter USERID for the user ID and PASSWORD for the password.

34. Click on TCP/IP Services - enter the following information:

TCP/IP address 10.3.227.78
Subnet Mask 255.255.254.0
Router 10.3.226.1
Host Name it01d01

TCP/IP Domain Name test.company.com

Name Server 10.3.199.2

You must use the TCP/IP addresses shown. If other addresses are used, the test cases that rely on
the TCP/IP addresses will fail.

If the network being used is not isolated from other LAN segments the TCP/IP information here will
not be valid with the existing network. This is why it is important to isolate this test environment if at
all possible.

35. Click on Netscape Communicator, accept the defaults.
36. Click on Tivoli Management Agent, accept the defaults.
37. Click on PSnS Backup and Recovery - accept the defaults.

38. Click on Advanced Print Services - accept the defaults Note: On OS/2 Warp Server for e-business
systems only.

39. Click on Books - accept the defaults.

40. Click on Error Logging Services - enter the following information:

Route Alerts to: IBM LAN Network Manager
Workstation ID:  IT01D01

41. Click on Network Adapters and Protocol Services

» If the system displays the adapter as selected, skip to step 42.

« If OS/2 did not detect the adapter card, the Add Adapter push button is displayed. Do the following
steps to define the adapter. The following directions assume the adapter's device driver and Network
Information File (NIF) are on a diskette. For example, the IBM token ring adapter has a device driver
named ibmtok.os2 and a NIF file named ibmtok.nif.

1. Click on Other Adapter. The Network Adapter Driver Disk panel is displayed.

2. Insert the diskette with the OS/2 driver and NIF files in the a: drive and specify the directory
where the system can find those files.

3. Click on OK. The Drivers Found panel is displayed. Select the adapter that is installed and make
sure the correct LAN type is selected (Ethernet or Token-Ring).
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42. If OS/2 detected an adapter card in the system, the Configuration panel is displayed with the adapter
selected. Set the address on the network card to 4000AC010001 using the following steps: (Ref #1.)

4. Click on OK. The files are copied to the hard drive.

5. Remove the diskette and click on OK. The Configuration panel is displayed showing the adapter

that was selected.

a. Click on Settings. The Parameters for adapter_name Adapter panel is displayed.

b. Select Node Address/Network adapter address and click on CHANGE. The Change Configuration

panel is displayed.

Note: Not all adapter cards allow you to define the network address for the LAN adapter.
Having a defined network address makes the isolation of problems easier. If your

adapter does not let you change the network address, skip this step.

c. Enter the following value for the node address: 4000AC010001
d. Click on OK. The Parameters for adapter_name Adapter panel is displayed.
e. Click on OK. The Configuration panel is displayed.

All of the items should be selected with colored check marks indicating all the parameters have been
provided to finish the installation of the domain controller.

43.
44.

45.

46.

Click on Install. A Configuration pop-up panel is displayed asking if it is OK to start the installation.

Click on OK The system begins the installation. A progress bar is displayed as the installation

progresses. Load time is less than one hour. The system will reboot automatically when the installation is

complete.

If the Monitor Configuration/Selection Utility panel is displayed, accept the defaults for monitor type

and click on OK.

If the Select Display Resolution panel is displayed, click on OK to accept the default selection.

After the installation completes, the system automatically reboots and an OS/2 Warp Server for e-business
registration screen is displayed. Click on Exit to close the registration screen.

Installing Netfinity V5.2xx from CDROM (Optional)

With OS/2 Warp Server for e-business, the Netffinity product is shipped on a separate CDROM. The Netffinity
replaces previous versions of systems management that shipped on OS/2 Warp Server CDROMS, and
needs to be installed on the domain controller and additional server following OS/2 installation.

The following steps outline installation and setup of Netfinity 5.2xx on the Domain Controller:

1.

Insert the Netfinity CDROM in the CD drive.
Open an OS/2 Window session.

Change to G: (G: will be the CDROM drive if only the partitions needed for testing have been setup
according to documentation.)

Change to G:\OS2\SERVICES

Type Install and press Enter.

The Netfinity Install screen is displayed, accept the defaults and click on OK

On the pop-up that says C:\NETFIN does not exist and will be created, click on OK.
Highlight Active Client Operation.

Turn on all check boxes under Optional services, and click on Install

. When copying from the CDROM is finished, the Network Driver Configuration screen is displayed.
. Enter ITO1DO1 as the System Name.

. Highlight NetBIOS <disabled>, and click on Driver Enabled.

. Enter AC010001 as the Network Address.
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14. Highlight TCP/IP <disabled>, and click on Driver Enabled.
15. Enter engineering for System Keyword.
16. Click on Options button to display Netfinity Options menu.

17. Turn on check boxes for Service Execution Alerts and Show Support Program, leave the others off,
click on OK.

18. Click on Save button, and on OK button on pop-up panel.
19. Click on Exit button.

20. A Change CONFIG.SYS panel will be presented, click on YES to have the installation automatically
update config.sys.

21. A FFST/2 panel will be presented, click on No to not have alerts routed to the Netfinity Manager.
22. Click on OK on pop-up Netfinity Install Complete!.

Installing the Test Cases on the Domain Controller

IMPORTANT: When loading test cases, load all of the test cases at the same time.

The tests in the PCM Testkit can be installed on any local (non-network) drive, however, the drive partition
defined for the base test cases should be used. The d: drive is used for all examples in the documentation.
The selected PCM Testkit drive can be reformatted with this process. The config.sys file is modified during
PCM Testkit installation, which will require the system to be shut down and rebooted after the test cases are
loaded.

This installation installs Base Testcases and Network Testcases depending on machine network role.
23. Insert the OS/2 PCM Compatibility Testkit Version 4.91 in the CD-ROM drive.
24. Open an OS/2 window.

Note: If the d: drive is unformatted, format it now before continuing with installation of the base
testcases. The drive can be formatted as either FAT or HPFS. For example:

format d: /fs:fat
or

format d: /fs:hpfs

25. Change to the \setup directory on the CDROM and type pcmsetup.

26. Wait for the PCM Testing Setup - Main Menu window to open.
On this screen the default selections are:
» 0OS/2 Boot Partition = <current boot partition>
* Test Case Partition=C
* 0S/2 Release = <current OS/2 release>
» Format Testcase Partition = NO (Change to YES only if you are reformatting this partition)
« Format Type = N/A (available if “Format Testcase Partition” set to “Yes”)
* Install Testkit From: (CDROM Install)

27. To change the defaults, select Change Settings to open the PCM Testing Configuration window. On this
panel the default selections can be changed for:

» Update Config.sys & Startup.cmd
» Testcase Partition

Note: For Domain Controller set the testcase partition letter same as OS/2 boot drive

80 Appendix A. Install and Configure Convenience Package for OS/2 Warp Server for e-business



* Format Testcase Partition
« FAT or HPFS
»  Source Drive for PCM Testkit Installation

28. Click on ACCEPT to save your changes and return to the main menu. Verify your selections.
29. Click on Install.

30. When installation of the test cases has completed, remove the CDROM from the drive, and then shut
down and restart the system.

The OS/2 PCM Compatibility Testkit Version 4.91 folder is added to the Desktop.

Setting Up the Additional Server System

Setting up the additional server consists of:
* Loading the additional server

»  Configuring the additional server

* Installing the base test cases

* Installing the network test cases

Note: All system names, addresses, user names, and passwords are case-sensitive and must be typed
exactly as shown.

Note: If the system supports RAID disks, configure the machine with a minimum of three physical disks and
set up the RAID controller for RAID-1 or RAID-5 configuration. See "Netfinity Raid Information
(ITLRAID)" for additional information.

Load the additional server with Convenience Package for OS/2 Warp Server for e-business.

The following steps walk through the installation of the operating system on the system destined to be the
additional server.

1. If there are any files on the hard drive of the system that you want to keep, make a copy of them now.
This procedure will delete all files on the hard drive.

Leave the domain controller on. (The additional server is currently shut down or powered off.)
Insert the OS/2 Installation diskette in the a: drive.

Power on or restart the system.

When prompted for the OS/2 Diskette 1, insert the diskette and the OS/2 CD, and press Enter.
When prompted for the OS/2 Diskette 2, insert the diskette and press Enter.
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At the Welcome screen, press Enter to start loading from the CD.
If the Welcome screen is not displayed, see "Resolving Problems during Installations".

8. The screen OS/2 Warp Server for e-business Installation is displayed, press Enter.

If there are no volumes or partitions defined:

« The Volumes Too Small screen is presented, press Enter.

If there are partitions defined, but no volumes defined:

e The "Volume Conversion Utility" (VCU) will convert disk partitions that do not have volumes defined
to compatibility volumes. Drive letters will be assigned to any partition that would be visible under
previous versions of OS/2. Hidden partitions (2nd primary partition on a drive) will not be converted.

» The VCU conversion screen will be presented indicating the number of compatibility volumes
created, and prompt you to reboot using the installation diskettes.

If there are volumes and partitions defined:
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e The Installation Volume Selection screen will be displayed.
» Highlight 2. Specify your own installation volume, and press Enter.

9. A Modifying Volumes Warning is displayed indicating all data on the volumes will be lost. Be sure there
is nothing left on the drive(s) that might still be needed, and then press Enter to start the Logical Volume
Management Tool (LVM).

10. If the message A volume of the following minimum size must be set installable: 120megabytes is
displayed, press Enter.
If needed, press F3 to exit the installation and back up any necessary data.

Note: If the system has both IDE and SCSI/RAID disks, and the IDE disk is in the boot sequence before

the SCSI/RAID, then install OS/2 Boot manager and create the PCMTEST partition on the IDE
disk. The OS/2 boot partition, and at least one of the JFS partitions should be created on the
SCSI/RAID disks.

Note: If the system has more than 1 disk of a pariticular type, then define JFS logical partitions on at

least 2 disks that can be used for testing the LVM function of having JFS volumes span
physical disks. However, if the system has only 1 disk drive, then 2 partitions can be defined
on the drive for testing LVM volume spanning.

Note: If you know the system bios supports booting from a partition that begins or extends

beyond 8.3GB (cylinder 1024) on large drives, then create a partition on the disk beyond
the 8.3GB range for the OS/2 bootable volume. You can create a filler partition to take up the
free space not allocated or required for PCM testing.

Note: When using LVM to modify partitions and volumes, you must first delete the volumes and

partitions and then re-create them.

11. The Logical Volume Management Tool - Logical View screen is displayed. Setup the disk partitions
and volumes as follows:
a. Install 0S/2 Boot Manager

In the Logical Volume section at the top, the entry [CDROM-1], may be the only entry, and the
Disk Partition section at the bottom will be blank.

Press Enter to bring up the Options screen.

Highlight Install boot manager and press Enter.

b. Press F5 to change to the physical view.
c. Define Physical Partition for OS/2:

Tab up to the Physical Disks section, and highlight the disk drive to be used for OS/2
installation.

Tab down to the Disk Partition section, and highlight [free space 1].
Press Enter to bring up the Options menu.
Highlight Create a new partition, and press Enter.

Highlight Primary Partition, and press Enter.

Note: If you know the system BIOS supports booting from a partition that begins or
extends beyond 8.3GB (1024 cylinders), then in the next step, select create at end of
free space, otherwise select create at beginning free space.

Highlight Create at the beginning of free space, and press Enter.

Clear the entry field, and enter Warp Server for the partition name, and press Enter.

Set the size of the boot partition to 500 MB, and press Enter.
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Define Physical Partition for PCMTEST:

Tab up to the Physical Disks section, and highlight the disk drive to be used for the PCMTEST
partition.

Tab down to the Disk Partition section, and highlight [free space 1].

Press Enter to bring up the Options menu.

Highlight Create a new partition, and press Enter.

Highlight Logical Partition, and press Enter.

Highlight Create at beginning of free space and press Enter.

Clear the entry field presented, and enter PCMTEST for the partition name, and press Enter.

Set the size of the pcmtest partition to at least 230MB, and press Enter.

Define Physical Partition for JFS:

Tab up to the Physical Disks section, and highlight the disk drive to be used for the Journaled
File System (JFS).

Tab down to Disk Partition section, and highlight [free space 1].

Press enter to bring up the Options menu.

Highlight Create a new partition, and press Enter.

Highlight Logical Partition, and press Enter.

Highlight Create at the end of free space, and press Enter.

Clear the entry field, and enter JFS Drivel for the partition name, and press Enter.
Set the size of the JFS partition to 100 MB, and press Enter.

Note: If you have more than 1 disk, and the above JFS partition was created on the first disk,
then use the steps from above to create a JFS partition on the second disk. This allows
testing of volumes that span physical disks. Enter the second partition name as JFS
Drive2, and set the size to 100MB. Otherwise, if you only have 1 disk, define the 2nd JFS
partition on the same drive, and when the JFS Volume is setup it will span partitions.

Press F5 to change to the Logical Volume Management Tool - Logical View.
Define OS/2 Boot Volume:

Press Enter for the Options menu.

Highlight Create a new volume, and press Enter.

Highlight Create a volume that can be made bootable, and press Enter.
Highlight C: and press Enter.

Type WSVR for e-business as the volume name, and press Enter.

A pop-up panel asks you to choose the disk for creating the volume, press Enter.
Highlight the disk drive selected for OS/2 installation, and press Enter.

Highlight Use existing partition, and press Enter.

Highlight [Warp Server 500], and press Enter.

The partition name Warp Server is presented, press Enter to accept.
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h. Add OS/2 Boot Volume to Boot Manager:

Highlight the volume WSVR for e-business.

Press Enter for the Options menu.

Highlight Set Boot Manager startup values, and press Enter.
Highlight Default boot selection field, and press Enter.

Highlight Save the changes, and press Enter.

i. Define PCMTEST volume:

Press Enter for the Options menu.

Highlight Create a new volume, and press enter.

Highlight Create a volume that does not need to be bootable, and press Enter.
Highlight Create a compatibility volume and press Enter.

Highlight D: and press Enter.

Type PCMTEST as the volume name, and press Enter.

A pop-up panel asks you to choose the disk for creating the volume, press Enter.
Highlight the disk drive selected for PCMTEST, and press Enter.

Highlight Use existing partition, and press Enter.

Highlight [PCMTEST nnn], and press Enter.

The partition name PCMTEST is presented, press Enter to accept.

j- Define JFS (Journaled File System) volume:

Press Enter for the Options menu.

Highlight Create a new volume, and press enter.

Highlight Create a volume that does not need to be bootable, and press Enter.
Highlight Create an LVM volume and press Enter.

Highlight E: and press Enter.

Type JFS Volume as the volume name, and press Enter.

A pop-up panel asks you to choose a disk for creating the volume, and then press F6 to complete
creation of the volume. Only press Enter for now.

Highlight the disk drive selected for JFS Drive1, and press Enter.
Highlight Use existing partition, and press Enter.
Highlight [JFS Drivel nnn], and press Enter.

The partition name JFS Drivel is presented, press Enter to accept.

Note: If you have more that 1 physical disk installed, and created a second logical partition JFS
Drive2, then continue to setup the JFS volume to span physical disk partitions.
Otherwise, press F6 now to finish the LVM volume definition.

Highlight the physical disk that JFS Drive2 was created on and press Enter.
Highlight Use existing partition, and press Enter.

Highlight [JFS Drive2 nnn], and press Enter.

The partition name JFS Drive2 is presented, press Enter to accept.

Press F6 to finish the LVM volume definition.
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k. The rest of the disks can be left as free space for now.
I.  Press F3 to exit.
m. Highlight Save the changes and exit, and press Enter.

12. If disk partitions were modified, follow the instructions to reboot the system using the new disk partitions.
Use the same installation diskettes as before.

» Atthe Welcome screen, press Enter.
« The OS/2 Warp Server for e-business installation screen is presented, press Enter.

« The Installation Volume Selection screen is presented, and the message in the middle of the
screen should say OS/2 Warp Server for e-business will be installed on: Volume C. Highlight
option 1. Accept the volume, and press Enter.

Note: It will be the boot drive that was set as installable with LVM.

13. Select 2. Format the Partition on the Formatting the Installation Partition screen.

Note: When disk partitions have been modified, the boot partition will be unformatted and this screen
will not be presented.

14. The Formatting the Installation Volume screen is presented. Select option 1. Perform a long format, and
press Enter.

15. On the Select the File System screen, highlight option 1. High Performance File System, and press Enter.
Note: There are test cases that require HPFS in order to use file names greater than eight characters
long.

Note: If the boot volume is currently formatted, a warning screen is displayed indicating that the hard
disk might contain data. Press Enter to continue with formatting.

The system starts copying data from the CD to the system's hard disk. A progress bar displays the status of
this activity.

16. When loading is complete, an all blue screen is displayed requesting you to remove the diskette from the
a: drive, and press Enter to reboot the system.
When the system boots this time, it is booting from the hard drive. The system automatically opens the
System Configuration screen. The following steps identify how the system should be configured.

17. On the System Configuration screen, click on Next.
18. The System Configuration(cont.) screen is presented. Click on Next.

19. The Country Information screen is presented, choose the United States, and select codepage (437,850)
and click on OK

20. The Select System Default Printer screen is displayed.
Choose Do not install default printer now, and click OK.

21. If your system recognizes a sound card, it opens the Multimedia Device Settings screen. Click on
Selections to verify the adapter settings, and then click on OK.

22. In the Primary Display Driver Install screen, the video driver is already selected. Click on OK to accept
the default.

23. The OS/2 Warp Server for e-business Setup and Installation screen is presented. Accept the defaults
and click on Next.

24. The Installing IBM OS/2 Warp Server for e-business screen is displayed. Click on Next.

25. The Information screen is displayed, DO NOT ADD ANY INFORMATION ON THIS SCREEN, click on
Next.

26. On the Select the services to install screen, check the following items:
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27.

28.
20.

30.

31.

32.
33.

» File and Print Sharing Services
* Click on more button and turn on check box for Generic Alerter Service, and click on OK.

« TCP/IP Services

e Click on more button and turn on check box for Network File System (NFS) Support, and click
on OK.

* Netscape Communicator
« Tivoli Management Agent
e PSnS Backup and Recovery

Click on Next. The Configuration screen is displayed.

The next set of steps configure the characteristics of the additional server. The test cases depend on this
information. If you do not follow these instructions exactly, test cases might fail. On the left side of the
screen is a list of the components to configure.

OS/2 Warp Server for e-business - explains the color codes of the check marks and needs no input.

Click on File and Print Sharing Services - do the following:
» Select the Additional Server radio button. (note it defaults to Domain Controller)

Enter a Server name: IT01S01
Enter a Domain name: [IT0O1D01D

Click on Network Adapters for File and Print Sharing - this will have been filled out already if 0OS/2 was
able to detect the network adapter card installed in the system. If no information is displayed, or the
wrong adapter is listed, then the installed network adapter needs to be identified to OS/2. Follow the
instructions in step 41 on page 78 to identify the network adapter and load the driver, then return to this
step and continue.

Click on Autostart - in addition to the items already selected, also select the following:

o Alerter

*  Generic Alerter

If this item is disabled, then the Generic Alerter service was not selected when File and Print Services
was selected for installation (see step 26).

Click on User ID and Password - enter USERID for the user ID and PASSWORD for the password.

Click on TCP/IP Services - enter the following information:

TCP/IP address 10.3.227.79
Subnet Mask 255.255.254.0
Router 10.3.226.1
Host Name it01s01

TCP/IP Domain Name test.company.com

Name Server 10.3.199.2

You must use the TCP/IP addresses shown. If other addresses are used, the test cases that rely on the
TCP/IP addresses will fail.

If the network being used is not isolated from other LAN segments the TCP/IP information here will not be
valid with the existing network. This is why it is important to isolate this test environment if at all possible.
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34.
35.
36.
37.
38.

39.

40.

Click on Netscape Communicator, accept the defaults.
Click on Tivoli Management Agent, accept the defaults.
Click on PSnS Backup and Recovery - accept the defaults.
Click on Books - accept the defaults.

Click on Error Logging Services - enter the following information:

Route Alerts to: IBM LAN Network Manager
Workstation ID:  1T01S01

Click on Network Adapters and Protocol Services

» If the system displays the adapter as selected, skip to step 42.

» If OS/2 did not detect the adapter card, the Add Adapter push button is displayed. Do the following
steps to define the adapter. The following directions assume the adapter's device driver and Network
Information File (NIF) are on a diskette. For example, the IBM token ring adapter has a device driver
named ibmtok.os2 and a NIF file named ibmtok.nif.

1. Click on Other Adapter. The Network Adapter Driver Disk panel is displayed.

2. Insert the diskette with the OS/2 driver and NIF files in the a: drive and specify the directory
where the system can find those files.

3. Click on OK. The Drivers Found panel is displayed. Select the adapter that is installed and make
sure the correct LAN type is selected (Ethernet or Token-Ring).

4. Click on OK. The files are copied to the hard drive.

5. Remove the diskette and click on OK. The Configuration panel is displayed showing the adapter
that was selected.

If OS/2 detected an adapter card in the system, the Configuration panel is displayed with the adapter

selected. Set the address on the network card to 4000AC010101 using the following steps: (Ref #2.)

a. Click on Settings. The Parameters for adapter_name Adapter panel is displayed.

b. Select Node Address/Network adapter address and click on CHANGE. The Change Configuration
panel is displayed.

Note: Not all adapter cards allow you to define the network address for the LAN adapter. Having a
defined network address makes the isolation of problems easier. If your adapter does not let
you change the network address, skip this step.

c. Enter the following value for the node address: 4000AC010101
d. Click on OK. The Parameters for adapter_name Adapter panel is displayed.
e. Click on OK. The Configuration panel is displayed.

All of the items should be selected with colored check marks indicating all the parameters have been
provided to finish the installation of the additional server.

4,
42.

43.

44,

Click on Install. A Configuration pop-up panel is displayed asking if it is OK to start the installation.

Click on OK The system begins the installation. A progress bar is displayed as the installation
progresses. Load time is less than one hour. The system will reboot automatically when the installation is
complete.

If the Monitor Configuration/Selection Utility panel is displayed, accept the defaults for monitor type
and click on OK.

If the Select Display Resolution panel is displayed, click on OK to accept the default selection.

After the installation completes, the system automatically reboots and an OS/2 Warp Server for e-business
registration screen is displayed. Click on Exit to close the registration screen.
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Installing Netfinity V5.2xx from CDROM (Optional)

With OS/2 Warp Server for e-business and Convenience Package for OS/2 Warp Server for e-business, the
Netfinity product is shipped on a separate CDROM. The Netfinity replaces previous versions of systems
management that shipped on OS/2 Warp Server CDROMS, and needs to be installed on the domain
controller and additional server following OS/2 installation.

The following steps outline installation and setup of Netfinity 5.2xx on the Additional Server:
1. Insert the Netfinity CDROM in the CD drive.
2. Open an OS/2 Window session.

3. Change to F: (F: will be the CDROM drive if only the partitions needed for testing have been setup
according to documentation.)

4. Change to F\OS2\MANAGER

5. Type Install and press Enter.

6. The Netfinity Install screen is displayed, accept the defaults and click on OK

7. On the pop-up that says C:\NETFIN does not exist and will be created, click on OK.
8. Turn on all check boxes under Optional services, and click on Install

9. When copying from the CDROM is finished, the Network Driver Configuration screen is displayed.
10. Enter ITO1S01 as the System Name.

11. Highlight NetBIOS <disabled>, and click on Driver Enabled.

12. Enter AC010101 as the Network Address.

13. Highlight NetBIOS [alternate adapter], and click on Driver Enabled.

14. Enter AC010101 as the Network Address.

15. Highlight TCP/IP <disabled>, and click on Driver Enabled.

16. Enter engineering for System Keyword.

17. Click on Options button to display Netfinity Options menu.

18. Turn on check boxes for Service Execution Alerts and Show Support Program, leave the others off,
click on OK.

19. Click on Save button, and on OK button on pop-up panel.
20. Click on Exit button.

21. A Change CONFIG.SYS panel will be presented, click on YES to have the installation automatically
update config.sys.

22. A FFST/2 panel will be presented, click on No to not have alerts routed to the Netfinity Manager.
23. Click on OK on pop-up Netfinity Install Complete!.

Installing the Test Cases on the Additional Server

IMPORTANT: When loading test cases, load all of the test cases at the same time.

The tests in the PCM Testkit can be installed on any local (non-network) drive, however, the drive partition
defined for the base test cases should be used. The d: drive is used for all examples in the documentation.
The selected PCM Testkit drive can be reformatted with this process. The config.sys file is modified during
PCM Testkit installation, which will require the system to be shut down and rebooted after the test cases are
loaded.

This setup installs Base Testcases and Network Testcases depending on machine network role.
1. Insert the OS/2 PCM Compatibility Testkit Version 4.91 in the CD-ROM drive.
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2. Open an OS/2 window.

Note: If the d: drive is unformatted, format it now before continuing with installation of the base
testcases. The drive can be formatted as either FAT or HPFS. For example:

format d: /fs:fat
or

format d: /fs:hpfs

Change to the \setup directory on the CDROM and type pcmsetup.

Wait for the PCM Testing Setup - Main Menu window to open.

On this screen the default selections are:

e 0S/2 Boot Partition = <current boot partition>

* Test Case Partition=C

* 0S/2 Release = <current OS/2 release>

» Format Testcase Partition = NO (Change to YES only if you are reformatting this partition)
« Format Type = N/A (available if “Format Testcase Partition” set to “Yes”)

* Install Testkit From: (CDROM Install)

5. To change the defaults, select Change Settings to open the PCM Testing Configuration window. On this
panel the default selections can be changed for:
» Update Config.sys & Startup.cmd
» Test Case Partition
* Format Testcase Partition
* FAT or HPFS
»  Source Drive for PCM Testkit Installation

Click on ACCEPT to save your changes and return to the main menu. Verify your selections.
Click on Install.

8. When installation of the test cases has completed, remove the CDROM from the drive, and then shut
down and restart the system.

The OS/2 PCM Compatibility Testkit Version 4.91 folder is added to the Desktop.
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Appendix B. Install and Configure Convenience Package for
OS/2 Warp Version 4

This appendix details the steps needed to install your Requester #1 and Requester #2 systems with
Convenience Package for OS/2 Warp Version 4 for testing with the OS/2 PCM Compatibility Testkit Version
4.91.

Setting Up Client 1 or Client 2

Setting up the client 1 or client 2 consists of:

» Loading Convenience Package for OS/2 Warp Version 4 on client 1 or client 2
»  Configuring client 1 or client 2

* Installing the base test cases

* Installing the network test cases

Note: All system names, addresses, user names, and passwords are case-sensitive and must be typed
exactly as shown.

Load client 1 or client 2 with Convenience Package for OS/2 Warp Version 4.

The following steps walk through the installation of the operating system on the system destined to be the
client 1 or client 2.

1. If there are any files on the hard drive of the system that you want to keep, make a copy of them now.
This procedure will delete all files on the hard drive.

Shut down or power off your system.

Insert the OS/2 Installation diskette in the a: drive.

Power on or restart the system.

When prompted for the OS/2 Diskette 1, insert the diskette and the OS/2 CD, and press Enter.
When prompted for the OS/2 Diskette 2, insert the diskette and press Enter.

At the Welcome screen, press Enter to start loading from the CD.

If the Welcome screen is not displayed, see "Resolving Problems during Installations".

© ® N o gk~ w0 N

The screen OS/2 Warp Version 4 Installation is displayed, press Enter.

If there are no volumes or partitions defined:

e« The Volumes Too Small screen is presented, press Enter.

» If there are partitions defined, but no volumes defined:

*  The "Volume Conversion Utility" (VCU) will convert disk partitions that do not have volumes defined
to compatibility volumes. Drive letters will be assigned to any partition that would be visible under
previous versions of OS/2. Hidden partitions (2nd primary partition on a drive) will not be converted.

» The VCU conversion screen will be presented indicating the number of compatibility volumes
created, and prompt you to reboot using the installation diskettes.

e If there are volumes and partitions defined:

» The Installation Volume Selection screen will be displayed.

» Highlight 2. Specify your own installation volume, and press Enter.

10. A Modifying Volumes Warning is displayed indicating all data on the volumes will be lost. Be sure there

is nothing left on the drive(s) that might still be needed, and then press Enter to start the Logical Volume
Managment Tool (LVM).
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1.

12.

If the message A volume of the following minimum size must be set installable: 120megabytes is
displayed, press Enter.
If needed, press F3 to exit the installation and back up any necessary data.

The Logical Volume Management Tool - Logical View screen is displayed. Setup the disk partitions
and volumes as follows:
a. Install OS/2 Boot Manager

* Inthe Logical Volume section at the top, the entry [CDROM-1], may be the only entry, and the
Disk Partition section at the bottom will be blank.

» Press Enter to bring up the Options screen.
* Highlight Install boot manager and press Enter.

b. Press F5 to change to the physical view.
c. Define Physical Partition for OS/2:

« Tab up to the Physical Disks section, and highlight the disk drive to be used for OS/2
installation.

» Tab down to the Disk Partition section, and highlight [free space 1].
» Press Enter to bring up the Options menu.
« Highlight Create a new partition, and press Enter.

* Highlight Primary Partition, and press Enter.

Note: If you know the system BIOS supports booting from a partition that begins or
extends beyond 8.3GB (1024 cylinders), then in the next step, select create at end of
free space, otherwise select create at beginning free space.

» Highlight Create at the beginning of free space, and press Enter.
» Clear the entry field, and enter Warp Version 4 for the partition name, and press Enter.
e Set the size of the boot partition to 500 MB, and press Enter.

d. Define Physical Partition for PCMTEST:

» Tab up to the Physical Disks section, and highlight the disk drive to be used for the PCM Testkit

partition.
« Tab down to the Disk Partition section, and highlight [free space 1].
e Press Enter to bring up the Options menu.
» Highlight Create a new partition, and press Enter.
* Highlight Logical Partition, and press Enter.
« Highlight Create at beginning of free space and press Enter.
e Clear the entry field presented, and enter PCMTEST for the partition name, and press Enter.
e Set the size of the pcmtest partition to at least 230MB, and press Enter.

e. Press F5 to change to the Logical Volume Management Tool - Logical View.
Define OS/2 Boot Volume:

» Press Enter for the Options menu.

—h

* Highlight Create a new volume, and press Enter.

« Highlight Create a volume that can be made bootable, and press Enter.
* Highlight C: and press Enter.

» Type Warp Version 4 as the volume name, and press Enter.

» A pop-up panel asks you to choose the disk for creating the volume, press Enter.
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» Highlight the disk drive selected for OS/2 installation, and press Enter.

* Highlight Use existing partition, and press Enter.

» Highlight [Warp Version 4 500], and press Enter.

e The partition name Warp Version 4 is presented, press Enter to accept.

g. Add OS/2 Boot Volume to Boot Manager:
» Highlight the volume Warp Version 4.

» Press Enter for the Options menu.
» Highlight Set Boot Manager startup values, and press Enter.
» Highlight Default boot selection field, and press Enter.
» Highlight Save the changes, and press Enter.
h. Define PCMTEST volume:
*  Press Enter for the Options menu.
» Highlight Create a new volume, and press enter.
* Highlight Create a volume that does not need to be bootable, and press Enter.
* Highlight Create a compatibility volume and press Enter.
* Highlight D: and press Enter.
» Type PCMTEST as the volume name, and press Enter.
» A pop-up panel asks you to choose the disk for creating the volume, press Enter.
» Highlight the disk drive selected for PCMTEST, and press Enter.
» Highlight Use existing partition, and press Enter.
* Highlight [PCMTEST 500], and press Enter.
* The partition name PCMTEST is presented, press Enter to accept.

i. The rest of the disks can be left as free space for now.
j- Press F3 to exit.
k. Highlight Save the changes and exit, and press Enter.

13. If disk partitions were modified, follow the instructions to reboot the system using the new disk partitions.
Use the same installation diskettes as before.

e Atthe Welcome screen, press Enter.
« The OS/2 Warp Version 4 installation screen is presented, press Enter.

« The Installation Volume Selection screen is presented, and the message in the middle of the
screen should say OS/2 Warp Version 4 will be installed on: Volume C. Highlight option 1. Accept
the volume, and press Enter.

Note: It will be the boot drive that was set as installable with LVM.

14. Select 2. Format the Partition on the Formatting the Installation Partition screen.

Note: When disk partitions have been modified, the boot partition will be unformatted and this screen
will not be presented.

15. The Formatting the Installation Volume screen is presented. Select option 1. Perform a long format,
and press Enter.

16. On the Select the File System screen, highlight option 1. High Performance File System, and press Enter.

Note: There are test cases that require HPFS in order to use file names greater than eight characters
long.
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Note: If the boot volume is currently formatted, a warning screen is displayed indicating that the hard
disk might contain data. Press Enter to continue with formatting.

The system starts copying data from the CD to the system's hard disk. A progress bar displays the status of
this activity.

17. When loading is complete, an all blue screen is displayed requesting you to remove the diskette from the
a: drive, and press Enter to reboot the system.

When the system boots this time, it is booting from the hard drive. The system automatically opens the

System Configuration screen. The following steps identify how the system should be configured.

18. On the System Configuration screen, click on Next.

19. The System Configuration(cont.) screen is presented. Click on Next.

20. The Country Information screen is presented, choose the United States, and select codepage (437,850)
and click on OK

21. The Select System Default Printer screen is displayed.
22. Select the type of printer that will be connected to client 1 for PCM base testing and click on OK.

23. If your system recognizes a sound card, it opens the Multimedia Device Settings screen. Click on
Selections to verify the adapter settings, and then click on OK.

24. In the Primary Display Driver Install screen, the video driver is already selected. Click on OK to accept
the default.

25. The OS/2 Warp Version 4 Setup and Installation screen is presented. Accept the defaults and click on
Next.

26. The Installing IBM OS/2 Warp Version 4 screen is displayed. Click on Next.

27. The Information screen is displayed, DO NOT ADD ANY INFORMATION ON THIS SCREEN, click on
Next.

28. On the Select the services to install screen, check the following items:
» File and Print Sharing Services
* TCPI/IP Services
* Netscape Communicator
» Tivoli Management Agent

29. Click on Next. The Configuration screen is displayed.

The next set of steps configure the characteristics of the domain controller. The test cases depend on this
information. If you do not follow these instructions exactly, test cases might fail. On the left side of the screen
is a list of the components to configure.

30. OS/2 Warp Version 4 - explains the color codes of the check marks and needs no input.

31. Click on File and Print Sharing Services - do the following:
» Select Install LAN Server Administration
» Select Install sharing.

Enter a Workstation ITO1RO1 for client 1 or
name: ITO1RO2 for client 2

Enter a Domain name: [T01D01D

32. Click on Network Adapters for File and Print Sharing - this will have been filled out already if OS/2 was
able to detect the network adapter card installed in the system. If no information is displayed, or the
wrong adapter is listed, then the installed network adapter needs to be identified to OS/2. Follow the
instructions in step 37 to identify the network adapter and load the driver, then return to this step and
continue.

33. Click on User ID and Password - enter USERID for the user ID and PASSWORD for the password.
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34.

35.
36.
37.

38.
39.

40.

41.
42.

43.

Click on TCP/IP Services - enter the following information:

TCP/IP address 10.3.227.80 for client 1 or
10.3.227.81 for client 2

Subnet Mask 255.255.254.0
Router 10.3.226.1
Host Name it01r01 for client 1 or

it01r02 for client 2
TCP/IP Domain Name test.company.com

Name Server 10.3.199.2

You must use the TCP/IP addresses shown. If other addresses are used, the test cases that rely on the
TCP/IP addresses will fail.

If the network being used is not isolated from other LAN segments the TCP/IP information here will not be
valid with the existing network. This is why it is important to isolate this test environment if at all possible.

Click on Netscape Communicator, accept the defaults.
Click on Tivoli Management Agent, accept the defaults.

Click on Network Adapters and Protocol Services

» If the system displays the adapter as selected, skip to step 43.

« If OS/2 did not detect the adapter card, the Add Adapter push button is displayed. Do the following
steps to define the adapter. The following directions assume the adapter's device driver and Network
Information File (NIF) are on a diskette. For example, the IBM token ring adapter has a device driver
named ibmtok.os2 and a NIF file named ibmtok.nif.

Click on Other Adapter. The Network Adapter Driver Disk panel is displayed.

Insert the diskette with the OS/2 driver and NIF files in the a: drive and specify the directory where the
system can find those files.

Click on OK. The Drivers Found panel is displayed. Select the adapter that is installed and make sure the
correct LAN type is selected (Ethernet or Token-Ring).

Click on OK. The files are copied to the hard drive.

Remove the diskette and click on OK. The Configuration panel is displayed showing the adapter that was
selected.

If OS/2 detected an adapter card in the system, the Configuration panel is displayed with the adapter
selected. Set the address on the network card to 4000AC010201 for client 1 or 4000AC010202 for client
2 using the following steps: (Ref #1.)
I.  Click on Settings. The Parameters for adapter_name Adapter panel is displayed.
m. Select Node Address/Network adapter address and click on CHANGE. The Change Configuration
panel is displayed.
Note: Not all adapter cards allow you to define the network address for the LAN adapter.
Having a defined network address makes the isolation of problems easier. If your
adapter does not let you change the network address, skip this step.

n. Enter the following value for the node address: 4000AC010201 for client 1 or 4000AC010202 for
client 2.

0. Click on OK. The Parameters for adapter_name Adapter panel is displayed.

p. Click on OK. The Configuration panel is displayed.

All of the items should be selected with colored check marks indicating all the parameters have been
provided to finish the installation of the domain controller.

44.

Click on Install. A Configuration pop-up panel is displayed asking if it is OK to start the installation.
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45, Click on OK The system begins the installation. A progress bar is displayed as the installation
progresses. Load time is less than one hour. The system will reboot automatically when the installation is
complete.

46. If the Monitor Configuration/Selection Utility panel is displayed, accept the defaults for monitor type
and click on OK.

47. If the Select Display Resolution panel is displayed, click on OK to accept the default selection.

After the installation completes, the system automatically reboots and an OS/2 Warp Version 4 registration
screen is displayed. Click on Exit to close the registration screen.

Installing the Test Cases on Client 1 or Client 2

IMPORTANT: When loading test cases, load all of the test cases at the same time.

The tests in the PCM Testkit can be installed on any local (non-network) drive, however, the drive partition
defined for the base test cases should be used. The d: drive is used for all examples in the documentation.
The selected PCM Testkit drive can be reformatted with this process. The config.sys file is modified during
PCM Testkit installation, which will require the system to be shut down and rebooted after the test cases are
loaded.

This setup installs Base Testcases and Network Testcases depending on machine network role.
1. Insert the OS/2 PCM Compatibility Testkit Version 4.91 in the CD-ROM drive.
2. Open an OS/2 window.

Note: If the d: drive is unformatted, format it now before continuing with installation of the base
testcases. The drive can be formatted as either FAT or HPFS. For example:

format d: /fs:fat
or

format d: /fs:hpfs

Change to the \setup directory on the CDROM and type pcmsetup.

Wait for the PCM Testing Setup - Main Menu window to open.

On this screen the default selections are:

e 0S/2 Boot Partition = <current boot partition>

* Test Case Partition=C

* 0S/2 Release = <current OS/2 release>

* Format Testcase Partition = NO (Change to YES only if you are reformatting this partition)
* Format Type = N/A (available if “Format Testcase Partition” set to “Yes”)

* Install Testkit From: (CDROM Install)

5. To change the defaults, select Change Settings to open the PCM Testing Configuration window. On this
panel the default selections can be changed for:

» Update Config.sys & Startup.cmd

* Test Case Partition

« Format Testcase Partition

e FAT or HPFS

»  Source Drive for PCM Testkit Installation

6. Click on ACCEPT to save your changes and return to the main menu. Verify your selections.
Click on Install.

8. When installation of the test cases has completed, remove the CDROM from the drive, and then shut
down and restart the system.

The OS/2 PCM Compatibility Testkit Version 4.91 folder is added to the Desktop.
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Appendix C. Hardware Information Components

The following figures show the hardware information components. You can use this information as a

reference to collect the details that you need before completing your system's hardware configuration
information.

FCH = Syshem Handware Information

The information entered on the following pages will be made available with the PCM
Compatibility Listings at this Web site:

httpaf Al dbmocomds ot twar el 05l wiar o w -caerts

This site is intended to provide information about the system as tested, as well as any
comments on how the system was conflgured.

IT you did not configure the hardware, install 0542, or conligure the nelwark, consull the
personis) who did to ensure that the information is accurate and complete.

If using this program for the first time on a system tested

te F Results Disk
previously in a different location (581 or DA1 for server and e s i

Rl or REZ for client), click here to use the data from the
Hesults disk IJI'E'H'IEILISH_.I creaiec.

Click here to enter or update system hardware Eééfe}[ﬁ&it;

iril erimation. ' '

If you are using PCMHDW for the first time, read Hel

the Infermation provided in the help e i
Cancel

Figure 9. PCM - System Hardware Information
1. Click on Create/Update to create new or modify existing system hardware information.
The System Hardware Configuration window appears, as described on page 97.

2. Click on Update From Results Disk to load system hardware information from the results disk created
earlier.
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E4 System Hardware Configuration

System configuration:

~-Component:—
Contact Information - P
Modifications/Comments Add
Equivalent Systems
Modify |
Remove
M
Save Cancel Help
Contains list of current configuration.

Figure 10. System Hardware Information

There are three default components for entering your system hardware configuration.

1.

Select the component you want to modify and click on Modify.
An alternative method is to double-click the component.
See the following figures for more details.

2. Click on Add to add a new system hardware component.

See Add Component on page 101 for more details.
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@8 Contact Information

Provide information on who to contact in your company
for further information or assistance.

Company name:

Address:
City: State/Province:
CountryfRegion: ZIP code:

Contact person:

Position/Department:

Phone I: Phone II:
| |
E-mail: Ueb:
| |
0K I Cancel Help

Figure 11. Contact Information

1. To modify contact information, provide the contact information of the person in your company to contact
for further information or assistance.

2. Click on OK to save the information or click on Cancel to close this window without saving the changes.
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Use the input area below to provide any information
on the following:

1. Hodifications to Sustem configuration or adapters

( interrupts, If0, Address, Ports, etc..)

that were needed in order to configure the listed hardware.
2. Hodifications made to 05/2 installation diskettes

( device drivers, config.sus, etc.. )

3. Device drivers that were updated from those

provided on 052 CD-ROM's, and where customers can obtain
the updated drivers [ such as WEB or FTP sites ).

4. MHodifications to 0S/2 system or network configuration
files for the network adapter.

Modifications:

Hone Provided

0K Cancel Help

&8 Hodifications/Comments

Figure 12. Modifications/Comments

1. To enter modifications or comments, enter the required information in the text field. This information
records the initial modifications for the system.

2. Click on OK to save the information or click on Cancel to close this window without saving the changes.
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E8 Equivalent 5ystems

A system IS EQUIVALENT if any of the following changes
on the occur to the shipped configuration.

Covers / Frame of sustem

Humber of slots on riser card.

Humber of bays for disks, cdroms, diskettes.
Size of Disks or Diskettes.

bl R

( Ho Re-test required. )

Equivalent Systems:
Hone Provided

0K Cancel Help

Figure 13. Equivalent Systems

1. To enter equivalent systems, enter names of the systems that are equivalent and do not require retesting.

2. Click on OK to save the information or click on Cancel to close this window without saving the changes.
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9 Add Component

Add component:

System =l Add This
Video

CD-ROM
CD Writer Cancel
CD Rewriter
DVD-ROM
DVD-RAM
DVD-RW
DVD+RW
Sound Card
Hard Disk Drive
Disk Controller
USB Keyboard
USB Mouse
USB Printer —_
USB ZIP Disk Drive
USB Floppy Disk Drive - Help

Figure 14. Add Component

Select a component to add and click on Add This or click on Cancel to close this window without saving the
changes.
The selected component is added to the list in the System Hardware Information window.

Note: The equivalency guidelines are available from the PCM Program WEB site. The TIPS page on the
WEB contains the latest updates and requirements for listing equivalent systems.
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Appendix D. LAN Test Case Groupings, Execution, and Output

For OS/2 Warp Server products listing, a system must be tested in domain and server roles.

For OS/2 Warp Client products listing, a system must be tested in both client 1 and client 2 roles.

Table 4. Testing of Domain Controller DO1 (Test Case Logs in \d01logs)

Test Case Description Execution From Output
CD-ROM Install 0OS/2 Warp Server (SMP, |manual script none
Adv, Entry)
ITLDUMP Dump Utility manual script Dumpfile, itldump.txt
ITLPSNSO0 Backup/Restore manual script itlpsns.ixt
ITLLS56.CMD LAN Exerciser for DO1 ---, S01, R01, R02 itlls56.xxx
ITLMSG.CMD LAN Messaging D01, ---, RO1, --- itlmsg.xxx
ITLFTP0O2.CMD FTP Server/Ping ---, -, -, R02 itlftp02.xxx
Exerciser of D01
ITLTCPO1.CMD TCP/IP Remote Execution |D0O1, ---, ---, --- itltcp01.xxx
on RO1
ITLRAID SystemView RAID manual script alerts.log

Information
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Table 5. Testing of Additional Server S01 (Test Case Logs in \sOllogs)

Test Case Description Execution From Output

CD-ROM Install 0OS/2 Warp Server (SMP, |manual script none
Adv, Entry)

ITLSVOO Group Management manual script none

ITLSVO6 Monitor Remote manual script XXXXXXXX.DBF
Workstation

ITLSVO7 Hardware Inventory manual script XXXXXXXX.hst
(Group)

ITLSVO8 Software Inventory manual script XXXXXXXX.iNV
(Group)

ITLSV11 S01-System Information  |manual script sysinfo.rpt
Tool

ITLLS57.CMD LAN Exerciser for S01 D01, ---, R01, R02 itlls57 .xxx

ITLFTPO1.CMD FTP Server/Ping --, -, RO1, --- itlftp01.xxx
Exerciser of S01

ITLALERT.CMD Alert Reporting on S01 -, S01, -, - itlalert.xxx

ITLCLIENT1 Client Load from Server  |manual script none

Table 6. Testing of Client 1 RO1 (Test Case Logs in \rOllogs)

Test Case Description Execution From Output

CD-ROM Install 0S/2 Warp Connect, manual script none
0S/2 Warp V4

ITLPEER.CMD PEER Services Exerciser |---, S01, ---, R02 itlpeer.xxx

ITLLS56.CMD LAN Exerciser for DO1 -, -, RO1, --- itlls56.xxx

ITLLS57.CMD LAN Exerciser for S01 ---, -, RO1, --- iths57 . xxx

ITLMSG.CMD LAN Messaging D01, ---, RO1, --- ithmsg.xxx

ITLFTPO1.CMD FTP and Ping Testingto  |---, ---, RO1, --- itlftp01.xxx
S01

Table 7. Testing of Client 2 R02 (Test Case Logs in \r02logs)

Test Case Description Execution From Output
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ITLCLIENT2 Client Load from PEER manual script none

ITLLS56.CMD LAN Exerciser for DO1 --=, ===, ---, RO2 itlls56.xxx
ITLLS57.CMD LAN Exerciser for S01 -, ===, ===, R02 itlls57 .xxx
ITLFTP02.CMD FTP and Ping Testingto  |---, ---, ---, R02 itlftp02.xxx

D01

104 Appendix D. LAN Test Case Groupings, Execution, and Output




Appendix E. Troubleshooting

This appendix provides information to assist you with problem analysis and reporting.

Resolving Problems during Installations
The following information can be used to solve problems you might encounter during installation.
The System Hangs during the Boot Up Sequence

This can be caused by any number of problems.

A common problem is that there is an IRQ conflict caused by the cards installed in the system. To investigate
this, reboot the machine. When the white box and the words "OS/2" are displayed in the left-hand corner of
the screen, press Alt+F2. (You have only a few seconds to press Alt+F2.) The system then shows the drivers
as they are being loaded, which might help identify what is happening when the system hangs.

The System Keeps Asking For the OS/2 Warp Server CD-ROM

It is an indication that the system does not recognize the CD-ROM. First, check to make sure the CD is in the
CD-ROM drive. Otherwise, this is most likely caused by the lack of a device driver on the boot diskettes that
enables the system to recognize the CD-ROM. Determine the controller driver required for the CD-ROM and
add that driver to the config.sys file on the second OS/2 boot diskette. For example, the Compaq Proliant
system requires having the cpg53cx.add driver loaded in order to use the CD-ROM in that system. So a
BASEDEV=cpq53cx.add statement is added to the config.sys file on the boot diskette along with adding the
driver itself to the boot diskette.

Note: If you add a device driver to diskette-1 remember to update the config.sys file with the appropriate
BASEDEV=device driver name and also add SET CopyFromFloppy=1. This will cause a prompt for
diskette-1 to be re-inserted later in the installation process so the BASEDEYV driver can be copied.

Server Does Not Start or Net Logon Fails to Start

This may indicate that the additional server system is not synched with the domain controller. Run the resync
command from an OS/2 command prompt on the additional server to resync the server with the domain
controller.
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Resolving Network Problems

This section describes problems you might have installing OS/2 Warp.

If you have problems while loading client 2 remotely from client 1 or if client 2 was not able to connect with
client 1, possible causes include:

 The OS/2 Warp CD is not in the CD-ROM drive of client 1.

» The diskette might specify an incorrect network adapter card. On OS/2 Diskette 1, check the lantran.log
file for error messages that might indicate a problem with the driver or protocol.ini file.

» The adapter card is not configured correctly. For example, there may be an IRQ conflict or the card may
be configured to use the BNC connection when the card is using an RJ45 connector.

» The cabling may be broken or not connected. Try using another cable.

e The card may be bad. Try using another card. If that fails to correct the problem, run adapter card
diagnostics as described in the documentation that came with your adapter card.

If you are using Ethernet connections, the network address is different. Look in the lantran.log file for the
network address specified as the "token ring format" address. This part of a lantran.log file shows the correct
address for this on an Ethernet network.

Look at the lantran.log file in the \ibmcom directory or on OS/2 Diskette 1 for LAN load of clients. In that file
you might see an error message similar to Adapter failed to respond in tine (indicating a problem
with the target's adapter).

Unknown Error 205 Generating Response Files

This error message is seen when trying to load a requester from the OS/2 Warp requester. Look for a file
called mkrsp.log on the client machine. The system may be trying to generate a response file for an adapter
that is not in the machine. This log could indicate the system could not find a .nif or .0s2 file on the server.

Look at the config.sys file on the second boot diskette. Near the bottom of the file there should be "SET
ADAPTER" and "SET ADAPTER _INFQ" lines and they should match the adapter installed in the system.
There should also be a DEVICE=xxxx.0S2 where xxxx is the adapter driver being used.

On the client 1 system, look in the directory specified in mkrsp.log. It will be a subdirectory of the c:\grpware
directory. This error has been known to happen if the adapter specified in the "SET ADAPTER_INFO" line of
config.sys is not found in this directory.

Reporting Problems

Meaningful analysis, resolution, and disposition of problems is most effectively accomplished when the
problem can be replicated on a local system where OS/2 testers and code developers can experience the
problem first hand.

Problem resolution will most likely require the problem to be repeatable on a system that is the same or
similar to the system on which the problem first occurred.

In the event that problem analysis fails to resolve a test failure, problem resolution might require that the test
system be sent to the IBM OS/2 Compatibility Lab for problem re-creation.

When problems are encountered, please debug the problem as far as possible prior to submitting a problem
report form. Furthermore, all the tests, or as many as possible, should be attempted prior to reporting
problems.

Refer to Hints & Tips on the OS/2 PCM Compatibility Testkit Program home page (at
http://www.software.ibm.com/os/warp/hw-cert/pcm/pcm_tkit.htm) for additional information.

In the event that you need to re-install the Testkit to restore a "pristine install", refer to Chapter 10,
"Uninstalling the OS/2 PCM Compatibility Testkit".
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Problem Reporting Forms

For reporting problems, use the problem report form located on the Testkit home page.

Level 1 Support

Level 1 support begins with problem notification. The problem re-creation team receives the Web problem

report form that clearly characterizes the problem. Remember to provide your e-mail address and phone
number. The Program Office might request additional information as needed for analysis.

Level 2 Support

Level 2 is problem analysis and a sizing of the effort to replicate the problem.

Level 3 Support

Level 3 support, if required, will be problem re-creation, debug, and resolution followed by notification.

At all levels of support, there might be the need for a member of the support team to contact the originator of
the problem for additional information. Please be sure this information is provided on the problem report form.
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Appendix F. Testing with Additional LAN Clients

For OS/2 Server Compatibility testing, only two clients systems (R01 and R02) are required in the test
environment. However, to meet certain requests from your customers, you might need to test server systems
with more than just two clients. To facilitate this, the PCM Compatibility Testkit LAN setup utilities, network
files, test selection program, and test cases provide the ability to add clients R03 through R12.

Installation

Systems R03 through R12 are used as regular LAN Requester clients and can be installed as follows:

Note: Refer to the tables in "Tables for R03 through R12" for the system names, TCP/IP addresses, and
network adapter addresses that have been predefined for clients R03 through R12 in the PCM LAN
testing environment.

1. Installation of OS/2 Warp Version 4 or Convenience Package for OS/2 Warp Version 4 on systems R03
through R12:
Follow the instructions outlined in "Setting Up Client 1" for installing and configuring the systems, but
substitute the values from the tables in the network configuration section as appropriate.

Running Tests on RO3 through R12

Using the "LAN Test Selection and Control" GUI on clients R03 through R12, you can select to run tests to
exercise either the additional server (S01) or the domain controller (D01).

1. When you select Run tests to exercise the Additional Server, test cases itlls57.cmd and itlftp01.cmd
are run.

2. When you select Run tests to exercise the Domain Controller, test cases itlls56.cmd and itlftp02.cmd
are run.
The test case log files are located in the \xxxlogs directory on each system (where xxx is R03 through
R12). When the test cases complete, the log files are copied to the log file directory on the system that
was selected (\sO1logs on the additional server, \d01logs on the domain controller).

Testkit Results Processing will not use these log files and they will not be copied to the results diskette. To

verify if the test cases have completed successfully, issue the following commands.

1. On the additional server in the \sO1logs directory, type:
grep "ITLLS57 Completed successfully” itlls57.*
and
grep "ITLFTPO1 Completed successfully" itlftp01.*

2. On the domain controller in \dO1logs directory, type:
grep "ITLLS56 Completed successfully” itlls56.*
and
grep "ITLFTP02 Completed successfully" itlftp02.*

When running the manual intervention test cases on the additional server in an environment with R03 through
R12 systems, you should see the following results:

ITLSVOO - Group Management

R0O3 through R12 systems installed by following the instructions for client 1 installation will show one icon for
each system in the All Systems group, and one icon for each system in the NETBIOSWS group. There
should not be an icon in the TCPIPWS group.

RO03 through R12 systems installed by following the instructions for client 2 installation will show two icons for
each system in the All Systems group, and one icon each in the NETBIOSWS and TCPIPWS groups.
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ITLSVOS8 - Software Inventory and ITLSV11 - Hardware Inventory

If systems R0O3 through R12 are selected when running this test case, files will be created on the additional
server, and will be copied to the results diskette during results processing, but not used in results analysis.

Tables for RO3 through R12

Table 8. Predefined Values for Network Configuration

Workstation Name |Workstation TCP/IP Address Network Adapter Network Address
or Host Name or Description Address for System
System Name Management
ITO1R0O3 Requester #3 10.3.227.82 4000AC010203 AC010203
ITO1R04 Requester #4 10.3.227.83 4000AC010204 AC010204
ITO1R0O5 Requester #5 10.3.227.84 4000AC010205 AC010205
ITO1R06 Requester #6 10.3.227.85 4000AC010206 AC010206
ITO1RO7 Requester #7 10.3.227.86 4000AC010207 AC010207
ITO1R08 Requester #8 10.3.227.87 4000AC010208 AC010208
ITO1R09 Requester #9 10.3.227.88 4000AC010209 AC010209
ITO1R10 Requester #10 10.3.227.89 4000AC010210 AC010210
ITO1R11 Requester #11 10.3.227.90 4000AC010211 AC010211
ITO1R12 Requester #12 10.3.227.91 4000AC010212 AC010212
ITO1S02 N/A 10.3.227.92 4000AC010102 AC010102

Note: The following values are not used during OS/2 installation or network configuration but are provided as
additional information for R0O3 through R12 as defined in the PCM testing environment.
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Table 9. User IDs and Passwords Defined during LAN Setup

User ID

Password

ITO1RO3U

UPWO01R03

ITO1R04U

UPWO01R04

ITO1RO5U

UPWO01R05

ITO1RO6U

UPWO01R06

ITO1RO7U

UPWO01R07

ITO1RO8U

UPWO01R08

ITO1RO9U

UPWO01R09

ITO1R10U

UPWO01R10

ITO1R11U

UPWO0O1R11

ITO1R12U

UPWO01R12

ITO1S02A

APW01S02
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Appendix G. Testing Tips and Hints

This appendix is available to help in identifying problems encountered with installation or execution of the
PCM Testkit Version 4.91. Please read this appendix for testkit section you are having problems with.

Other or updated tips files are available on the OS/2 PCM Compatibility Test Program Web Site.

Problem Isolation

Provides information on general problem isolation.

The OS/2 Compatibility testkit is made up of testcases from the OS/2 FVT and SVT test groups.

The testkit focus is on hardware compatibility and designed to exercise the OS/2 interfaces to the hardware
components in a system unit.

The testcases are run from combinations of Presentation Manager programs, command files, and controlling
processes (switch.exe and dswitch.exe).

The controlling processes run testcase script files (.scr) that contain  the controls for starting sessions and
running executables with parameters.

Most testcases in a test group can be run independently from an OS/2 full screen or window session, in many
cases the individual executables can be re-run separately without re-running the entire testcase.

As with most testcases, there may be timing instances when a failure is generated that is not due to an error
in either the hardware or OS/2. This is why the recommendation for failures noted is to first re-run the failing
testcase by itself.

Intermittent fails typically point to transient timing problems in the test tools and/or testcases and will typically
pass on individual re-run of the testcase.

Consistent fails with individual re-runs MAY point to problems with the hardware, BIOS, or OS/2 device driver
timings.

If attempts at re-running the individual testcase or executable consistently result in a failure, then you should
next re-install the testcase group from the CDROM and re-run the failing test again.

If you still get failures, then check the CDROM to be sure there are no scratches or smudges on the CDROM
that may be resulting in a file being copied incorrectly.

To copy an individual executable from the testkit CDROM, follow these instructions:
Go to the testcase group directory on the CDROM.

* \ACCEPT : Contains ACCEPTANCE testcases. Change to the appropriate sub-directory for the
testcase you need.

+ \STRESS : Contains STRESS testcases. Change to the stress sub-directory for the testcase
executables.
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* \PCMCIA : Contains PCMCIA testcases. The PCMCIA testcases are primarily .CMD files, with
executables in the \stress sub-directory.

e \FVT :Contains FVT, some executables are in the stress sub-directory, other are in their own sub-
directory for the testcase you need.

\MMEDIA : For Multimedia, it is recommended to re-install the entire testcase grouping.
* \SMPTEST : For SMP, the executable is in the \smp sub-directory.

Note: PCMCIA and FVT directories contain a stress sub-directory with the specific files for those test groups.
They are the same as the executables in the \STRESS test group and included in the PCMCIA and
FVT groups for execution when only PCMCIA or FVT are installed without install of the STRESS
testcase group.

* Copy the individual test .exe file you need to the testcase drive.

*  Check the CDROM \PCM_INST\EAS\EAS\ sub-directories for the testcase group the individual file
was copied from to see if there is an EA data file that goes with the executable.

« If an EA data file exists, issue the following command from the testcase drive in the directory with the
re-copied executable.

(example assumes E: is the CDROM Drive and test.exe is from stress)

PCMEAS test.exe e:\pcm_inst\eas\eas\str\test.exe /j

Then re-run the testcase to see if the failure is cleared.
For information on how to re-run individual testcases, refer to the main PCM Testkit Documentation.

For information on how to re-run individual executables, refer to the Tips Documentation for that testcase
group.

Stress Testcase Help

Provides information on the stress testcase and information on re-running individual executables and
updating of the testkit results files.

The STRESS testcase consists of a group of executables that are run under a controlling processes
(switch.exe and dswitch.exe). The switch program takes in a script file (pcmmed01) which contains the
controls for starting the various screen groups (sessions) and testcase executables. The main switch.exe is
invoked through RUN.CMD and takes in the script file and creates the different screen groups and controls
testcase execution.

The script PCMMEDO1 is setup to create 8 screen groups and start/stop the testcases in the different screen
groups. The screen groups are used for grouping testcases as follows:

Screen Group Session Type Testcases
1 - DSwitch.exe MVDM DOS window DOS VDM File/Video tests
2 - Switch.exe Vio Window Session File System
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3 - Switch.exe Vio Window Session File System

4 - Switch.exe Vio Window Session Pipes/Queues

5 - Switch.exe Full Screen Session NPX/Pipes

6 - Switch.exe PM Session PM Exercisers

7 - Switch.exe Vio Window Session Memory Exercisers
8 - Switch.exe Vio Window Session Memory Exercisers

With version 4.91 of the testkit, many of the testcases were updated and now include a timer parameter that
specifies how long the individual executable will run, others are setup to run until all work is completed. The
MVDM testcases will run until they complete, and no other tests can be started in that screen group until the
testcase prior has finished.

To see the list of executables in each screen group, you can print the file \SCRIPT\PCMMEDO1 which
contains a breakdown at the top, along with an indicator of whether the executable is timed, or runs to
completion.

The PCMMEDO1 script also creates several working directories that are used by the various testcases, and at
the end, the directories are cleared and deleted. Some directories are created on the testcase drive, and
some on the scratch diskette in the A: drive. In the script, the directories are all assumed to be at the root of
either the testcase drive or diskette.

Several testcases require predefined input files located in the TEXT directory for correct test execution, which
are provided as parameters.

The STRESS testcase can be started in two ways, the first is the PM Test icon in the Testkit Folder on the
desktop. The second is to open an OS/2 full screen session, go to the \LOG directory on the testcase drive
and type RUN and enter. In both cases, you will be prompted for a scratch diskette in the A: drive (unless
already inserted).

At the end of the script execution, the RUN.CMD calls LOG.CMD to create the PCMMEDO1.SUM file in the
\LOG directory with PASS/FAIL information for the various testcases. This summary file is used during results
processing. You can view the file by going to the \LOG directory and entering the command "type
pcmmed01.sum".

If you have a lot of missing testcases, first check that stress testcases were installed, and that there is at least
10MB of free space on the disk. If the disk is full, there are testcases that will either fail or not run properly.
Also, verify that the config.sys was updated correctly to setup the dpath/path/text statements to point to the
testcase drive and directories, and that the PCM environment variables are at the bottom.

If the config.sys is not correct, you can re-run the program PCMSETUP from the Testkit folder, select the 1st
checkbox and verify that the OS/2 and Testcase drive information is correct, then hit the RUN button, when
completed, shutdown and reboot, then re-run the STRESS testcase.

Typically, you will see a lot of missing testcases if the config.sys was not setup properly and the system
rebooted, or not all the stress testcases were installed. You may also see this if one of the testcases had a
problem where it caused a system lockup, thus preventing the remaining testcases from executing.

If you have only a couple testcases that have failed, and re-running the entire STRESS testcase does not
change this, then you may need to run the failing tests individually. To run an individual testcase, follow this
procedure:

1. Open OS/2 full screen session

2. "D.CMD" (changes to \LOG directory on testcase drive)

3. "grep xxxxxx.exe \script\pcmmed01" (were xxxxx.exe is testcase to run)
4

Write down the parameters you see listed on the line.
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5. If there are any directories needed, you will need to create those from the root of the testcase drive or

A: drive as needed. The directories used are the following:

(testcase drive): \SeqDir \RanDir \Tmp1 \Tmp2 \Tmp3 \Tmp4
(A: drive diskette):  A:)\SeqDir A:\RanDir A:\WrkDir

6. Note if the testcase uses a timer variable, you will want to change the timer value so that the testcase
runs approximately 10-15 minutes.

7. Inthe \LOG directory, enter the testcase and variables noted from the grep output done in step 3
above, only changing the timer variable if applicable.

8. After all the individual testcase have been rerun, enter the command "strlog g pcmmed01" to
recreate PCMMEDO1.SUM summary file.

The following is section provides information on individual testcase executables and their associated parms.
Also provided is the sequence/command in order to re-run the testcase as outlined on page-2 of this
document.

BSEQMP (timer ends)

This will spawn instances of child process BSEQMPC.EXE during execution.
usage: BSEQMP [-u gx] [-u P] [-u cxxx] [-u Zxxx] [-u Nxxx] [-u nxxx] [-u mxxx]
[-u ixxx] [testlog flags]
? Help info
-u gx Type of queue for this test FIFO/LIFO/PRIORITY(default is FIFO)
-uP  Use SYNCHRONOUS processes (default is ASYNCHRONOUS)
-u cxxx Run for xxx seconds or until error. (14400 sec is default)
-u Zxxx Sem timeout on thrds & processes (900,000 ms default)
-u Nxxx Number of queue processes to kick off(2-30, default=4)
-u nxxx Number of queue items to start with(default=10)
-u mxxx Max number of queue items to test(default=250)
-u ixxx Number of queue items to increase by each pass(default=10)
-u vxxx Number of times to run the iterations
-f***** |_ogfile name
-5 Logging level 5 ->9
re-run: BseQMP.exe -u ¢300 -u n10 -u m80 -u i5 -u N10 -u gPRIORITY -fBSEQMP -I5 -0

CLOCK32 (timer ends)

To view additional information on the clock32 testcase open an OS/2 session and change to the \STRESS
directory and type "clock32" enter. This will start the program on the desktop, then use the EXTENDED
HELP option.

usage: Clock32 -u kxxx [-u AUTO] [-u ICON] [-u NOLOGO] [-u RESTORE] [-u SINGLE]
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[-u TYPE:pstype]

-U kxxx Number of seconds xxx to run the program

-u AUTO Starts the program in AUTO mode and handles input to the logo dialog box if necessary.
-u ICON Starts the program in MINIMIZED state.

-u NOLOGO  Causes the logo dialog box to NOT DISPLAY.

-u RESTORE The program is restored to the state that was saved when last
WM_SAVEAPPLICATION message was received.

-u SINGLE  Runs program single-threaded instead of multi-threaded.
-u TYPE:CACHE Makes a Cached PS the initial presentation space.
-u TYPE:MICRO Makes a Micro PS the initial presentation space.
-u TYPE:NORMAL Makes a Normal PS the initial presentation space.
-u TYPE:RETAIN Makes the Retained PS the initial presentation space.
-u TYPE:AVIO Makes the AVIO PS the initial presentation space.
-u TYPE:BITMAP Makes the BITMAP DC the initial device context.
e Logfile name
-15 Logging level 5 -> 9

re-run: Clock32.exe -u k300 -u nologo -u type:bitmap -fCLOCK32 -I5 -0

CUBE (CC or F3to end)

To view additional information on the cube testcase open an OS/2 session and change to the \STRESS
directory and type "cube" enter. This will start the program on the desktop, then use the EXTENDED HELP
option.

usage: CUBE [/AUTO] [/NOLOGQ] [/DIM:dimension]
/AUTO Starts the program in AUTO mode and handles input to the dialog box if necessary.
/INOLOGO Causes the logo dialog box to NOT DISPLAY.
/DIM:2 Makes cube size of 2x2x2
/DIM:3 Makes cube size of 3x3x3
/DIM:4 Makes cube size of 4x4x4
/IDIM:5 Makes cube size of 5x5x5
/IDIM:6 Makes cube size of 6x6x6
-s***** Logfile Nmae
-5  Logging level 5 ->9
re-run: Cube.exe /auto /nologo /DIM:5 -sCube -I5

Wait approximated 5 minutes then end with F3 key, or Ctrl-C.
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CUBE32 (timer or CC or F3 to end)

To view additional information on the cube32 testcase open an OS/2 session and change to the \STRESS
directory and type "cube32" enter. This will start the program on the desktop, then use the EXTENDED
HELP option.

usage: CUBE32 -u txxx [-u AUTO] [-u NOLOGQ] [-u DIM:dimension]
-u txxx  Time in seconds xxx to run testcase.
-u AUTO  Starts the program in AUTO mode and handles input to the dialog box if necessary.
-u NOLOGO Causes the logo dialog box to NOT DISPLAY.
-u DIM:2  Makes cube size of 2x2x2
-u DIM:3  Makes cube size of 3x3x3
-u DIM:4 Makes cube size of 4x4x4
-u DIM:5 Makes cube size of 5x5x5
-u DIM:6  Makes cube size of 6x6x6
-f*** Lodfile name
-15 Logging level 5 -> 9
rerun: Cube32.exe -u t300 -u nologo -u auto -fCUBE32 -I5 —o

EXCEPT32 (switcher KS, CC, or alt-F4 to end)

usage: Except32 [-cH##] [-u##] [-z##] [-0] [-m#H] [-n##] [-HH#]
[-ICON] [-HELP] [-ABOUT]
-c## # of invalid-opcode threads 0-128 (default 2)
-uf##  # of unwind threads 0-1 (default 1)
-z##  # of divde-by-zero threads 0-128 (default 2)
-0 turns on stack overflow test
-m##  # of milliseconds to suspend threads 1-300000 (default 300)
-n##  # of miliseconds before resume threads 1-300000 (default 300)
-t## how ofter in seconds to redisplay status 3-60 (default 5)
-ICON minimizes the window on startup
-HELP display help dialog box on startup
-ABOUT display about dialog box on startup
-s***** | ogfile name
re-run: Except32.exe -sExcept32 -I5

Wait approximated 5 minutes then end with Alt-F4, or Ctrl-C.

FLTxxx (run until finished) (VDM tests)

usage: fltxxx

-f***** | ogfile name
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-5  Logging level 5 ->9
re-run: FIt002.exe -fFIt002 -I5
FIt004.exe -fFIt004 -15
FIt005.exe -fFIt005 -15
FIt009.exe -fFIt009 -15
FIt010.exe -fFIt010 -15
FIt012.exe -fFIt012 -15
FIt013.exe -fFIt013 -I5
FIt015.exe -fFIt015 -15
FIt016.exe -fFIt016 -15
FIt017.exe -fFIt017 -I5
FIt018.exe -fFIt018 -15

FS32COPY or FSCOPY (runs till finished)

usage: FS32COPY -u n## -u m##H#H# -u iINSPEC -u oOutPath
FSCOPY -u n## -u m### -u iINSPEC -u oOutPath
-u i*****  Input path/file specification with wildcards.
This is a Required field. No ending '\'.

*kkkk

-uo Output path must be a directory. No ending '\'.
-u n## The number of threads 1-14 copying. Default is one.
-u m##H# Copy open mode flags for output files.
e Logfile name
-15 Logging level 5-> 9
prep: FS32CPY1 Create directory \SeqgDir on A:
FS32CPY2 Create directory \TMP4 on testcase drive
FSCOPYO01 Create directory \RanDir on A:

FSCOPYO02 Create directory \SeqgDir on testcase drive

re-run: FS32Copy.exe -u n7 -u i\stress\*.sym -u 0A:\SeqgDir -fFS32CPY1 -I5 -0
FS32Copy.exe -u n7 -u i\stress\* -uo\Tmp4 -fFS32CPY2-I5 -0
FSCopy.exe -un14 -u i\stress\*.sym -u oA:\RanDir -fFSCOPY01 -I5 -o
FSCopy.exe -un5 -uilstress\* -uo\SeqDir -fFSCOPY02 -I5 -0

FS32DEL or FSDEL (runs till finished)

Usage: FS32Del [options]
FSDel [options]
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-uH Display This Help Summary

-u C<Number> Number of Creation Threads (default 4)
-u D<Number> Number of Deletion Threads (default 4)
-u E<Number> Number of EA Threads (default 4)

-u k<Number> Maximum Number of Files  (default 100)
-u m<Number> Maximum File Size (default 512)
-u n<Number> Maximum File Name Length (default 8)
-u o<Number> Maximum EA Size (default 65495)
-u p<path> Path for creating files

-u txxxxx  Time in seconds to run testcase

e Logfile name

-15 Logging level 5 -> 9

prep: FS32DEL1 Create directory \WrkDir on A:
FS32DEL2 Create directory \TMP3 on testcase drive
FSDEL Create directory \SegDir on testcase drive

re-run: FS32Del.exe -u t300 -u C2 -u D2 -u E1 -u k20 -u m512 -u 0256 -u pA:\WrkDir -fFS32DEL1 -I5 -0
FS32Del.exe -ut300 -u C3 -u D3 -u E2 -u k100 -u m1024 -u 01024 -u p\Tmp3 -fFS32DEL2 -I5 -0
FSDel.exe -ut300-u C3-u D3 -u E2 -u k100 -u m1024 -u 01024 -u p\SeqDir -fFSDEL -I5 -0

FS32DIR or FSDIR (runs till finished)

usage: FS32DIR [options]
FSDIR [options]

-uH?  Display help summary

-uN#  Number of nodes in tree (default 100)
-uE# Maximum EA data size  (default 65495
-uT#  Number of transformations (default 20)
-uD#  Maximum size of directory's name

-u P<path> Path for creating directory tree

-f****  Lodfile name

-15 Logging level 5 -> 9

prep: FS32DIR1 Create directory \RanDir on testcase drive
FS32DIR2 Create directory \TMP1 on testcase drive

FSDIR Create directory \RanDir on testcase drive
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re-run FS32Dir.exe -u n40 -u t50 -u €2048 -u p\RanDir -fFS32DIR1 -I5 -0
FS32Dir.exe -un50 -u t10 -u €512 -u p\Tmp1 -fFS32DIR2 -I5 -0
FSDir.exe -un50 -ut10 -u €512 -u p\RanDir -fFSDIR -I5 -0

FS32LOCK or FSLOCK (runs till finished)

Tests the systems ability to handle multiple file accesses to the same file.

usage: FS32LOCK -u iINPUTFILE -u o OUTPUTFILE -u n99 -u Pthreadprty
FSLOCK -uilNPUTFILE -u o OUTPUTFILE -u n99 -u Pthreadprty

-ui*****  Path\Name of a single input file.
-u o****  Path\Name of a single output file.
-un99 The number of threads (1-10) updating the file. (default 1)
-u p****  Thread priorities (0-9, A-V) for each thread executing.
(A-V is priority 10-31) The default is all O priority.
Each digit position represents a single copy thread.
(Example: OVA94T1U7C, for 10 threads.)
-frex*x* Logdfile name

-15 Logging level 5 -> 9

prep: FS32LOCK Create directory \TMP4 on testcase drive
FSLOCKO1 Create directory \TMP1 on testcase drive
FSLOCKO02 Create directory \TMP2 on testcase drive

re-run: FS32Lock.exe -u i\Stress\DSwitch.exe -u n9 -u p02123456A -u o\Tmp4\FSLock.dat -fFS32LOCK -I5

-0

FSLock.exe -u i\Stress\DSwitch.exe -u o\Tmp1\FSLock.dat -u n10 -u p012345ABCD -fFSLOCKO01 -I5 -

FSLock.exe -u i\Stress\DSwitch.exe -u o\Tmp2\FSLock.dat -u n8 -u p3 -fFSLOCKO02 -I5 -0

FS32RAND (runs till finished)

usage: FS32RAND -ilnSpec -oOutPath -n## -m#H#H#H#

-u i*****  Input path/file specification, wildcards allowed.
-u 0****  Qutput path, must be a directory.

-u n## The number of threads 1-14 copying. (default 1)
-u m##HH#  Copy open mode flags for output files.
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-frex*x* Logdfile name

-15 Logging level 5 -> 9
prep: Create directory \RanDir on A: drive

re-run: FS32Rand.exe -u n14 -u i\Text\* -u oA:\RanDir -fFS32RAND -I5 -0

FS32SEQ (runs till finished)

usage: FS32SEQ.EXE -uiINPUTFILE -u oOUTPUT -u n## -u m##H##HE -I# -sname

-u i***** |nput path/name with wild cards allowed

-u 0**** Qutput directory

-un#  Number of threads 1-14 (defaultis 1)

-u m##HH#  Copy open mode flags for output files (default is 0x00A1)
-f<**** | ogfile name

-15 Logging level 5 -> 9
prep: Create directory \SeqDir on A: drive

re-run: FS32Seq.exe -u n14 -u i\Text\* -u 0A:\SeqDir -fFS32SEQ -I5 -0

GP232 (timer ends)

usage: GP232 -u txxx -u auto
-u txxx Number of seconds to run testcase
-u auto Run in automatic mode
-fx**** Logfile name

-5  Logging level 5 ->9

re-run: Gp232.exe -u t300 -u auto -fGP232 -I5 -0

GPFLOOQOD (timer ends)

usage: GPIFLOOD -u txxx -u XPATHNAME [-u m] [-u ICON] [-u HELP] [-u ABOUT] [-1#] [-fname]
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*kkkk

-u X Filename of Bezier and obstacle points
-um Run in automatic mode (default is manual)
-u ICON Minimize window at startup

-u HELP Display help dialog box at startup

-u ABOUT  Display about dialog box at startup

-u f****  Qutput logfile name

-15 Logging level 5 -> 9

re-run: GpiFlood.exe -u t1500 -u x\text\bezidata -u m -fGPIFLOOD -I5 -0

LSDLL (timer ends)

usage: LSDLL [-u cH##HHAE] [-u d##] [-u ef#] [-u n##H] [-u tH##H]
[-u xDLLUSE] [-u yDLLDISABLE] [-I#] [-fname]

-CHit#HHE run time in seconds (default 14400 seconds)
-d##  module status display interval (default 30 seconds)
-e##  clock update interval (default 1 second)

-n#t  number of loader threads (default is 2)

-t##  sleep time between freeing DLL's (default is 3 seconds)
-XDLLNAME Name of DLL to test if given (default is all DLL's)
-yDLLNAME Name of DLL to disable

-fname Logfile name

-15  Logging Level 5->9

DLL's: LS32ICON.DLL 32bit icon DLL
LS32STRN.DLL 32bit memory DLL
LS32BIG.DLL 32bit memory DLL with code > 64KB

LS32BAD.DLL
LS32PROT.DLL

re-run: Isdll.exe -u ¢300 -u n2 -fLSDLL -I5 -0

LSTHRD (CC ends)

usage: Isthrd -nxx -slogname -Ix
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-nxx Number of threads to start
-s***** | ogfile name

-5 Logging level 5 ->9

re-run: Isthrd.exe -n4 -sLSTHRD -I5

Wait approximated 5 minutes then end with Ctrl-C.

M32LCK (timer ends)

Usage: M32Lck [-u ?] [-u axx] [-u bxx] [-u cxx] [-u dxX] [-u exx]

[u fxx] [-u gxx] -Ixx

-u? Help message
-u txx Number of seconds to run testcase
-u Axx Number of GDT Selectors [default 50]
-u Bxx Size of Phys Mem allocated for GDT selectors [default 100 bytes]
-u Cxx Number of Private Objects [default 100]
-u Dxx Size of Private Objects [default 100]
-u Exx Type of memory lock [default ML_SHORT + ML_ANYMEM + ML_NORMAL]
0000 ML_SHORT 0010 ML_HIMEM
0001 ML_LONG 0000 ML_NORMAL
0000 ML_ANYMEM 0100 ML_VERIFY
-u Gxx Number of threads to span [default 10]
-u Hxx Flag AllocPhys Below/Above 16Meg [default ABOVE_1_MEGABYTE]
-u 0000 ABOVE_1_MEGABYTE 0001 BELOW_1_MEGABYTE
-u Jxx Wait flag for memory lock [default MW _BVALID]
-u 0000 MW_BVALID 0001 MW_TEST
-f***** _ogfile name

-5 Logging level 5 -> 9

re-run: m32lck.exe -u t300 -u a25 -u b100 -u ¢50 -u d100 -u g5 -u E1 -u H1 -u JO -fM32LCK -I5 -0

M32NAME (timer ends)

usage: M32Name -u Axxxx -u Bxxxx -u Mxxxx -u Nxxxx -u Sxxx -u ksmp -Lx
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-ua Max number of shared given selectors to allocate (1-6144) [128]
-ub  Max segment size (12-65536) [1024]

-uc Time period in Secs. after which the program terminates[14400]
-um  Max number of named shared selectors to allocate (1-30) [16]
-un  Max number of subbing processes to start (1-254) [2]

-us Statistics logging file path [stdout]

-uv  Number of iterations that the child will process.

-u ksmp SMP Kernel is being used.

-fr**** Logdfile name

-5  Logging level 5 ->9

Statistics format

YYYY/MM/DD HH:MM:SS.TH M32Name AAAAAAAA BBBB CCCCCCC DDDD EEEEEEEE FFFF
GGGGGGGG HHHH 11

AAAAAAAA Total size Allocated memory (hex)

BBBB current total # of r/w selectors allocated (hex)
CCCcCcCccCcC Total size of r/w selectors allocated (hex)

DDDD current total # of named selectors allocated (hex)
EEEEEEEE Total size of named selectors allocated (hex)
FFFF current total sub-allocations (hex)

GGGGGGGG Total size of sub-allocations (hex)
HHHH Total number of 1st level Suballoc failures (hex)

Il Total number of 2nd level Suballoc failures (hex)

re-run: m32name.exe -u ¢300 -u a16 -u b800 -u m10 -u n10 -fM32NAME -I5 -0

M32PAGE (Ctrl_c ends)

usage: M32Page -I# [-F##] [-M##] [-N##] -L#

?  Help Summary

-F## Flag for memory lock (default VMDHL_LONG | VMDHL_16M)
-M## Maximum size of objects (default 16384)

-N## Number of children/objects (default 16)

-L5 Logging level 5 ->9

LOGFILE NAME DEFAULTS TO M32PAGE
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re-run: m32page.exe -n2-m1024 -I5

M32SHR (timer ends)

Usage: m32shr [options]

-uh Help summary

-u a<Number> Number of NameChld objects (default 10)
-u b<Number> Number of GetChld objects (default 10)

-u c<Number> Number of GiveChld objects (default 10)

-u m<Number> Maximum size of Memory object (default 10)

-u t<Number> Number of Seconds a Child process runs (default 600)
-u ksmp SMP Kernel is used
e Logfile name

-15 Logging level 5 -> 9

re-run: m32shr -u t300 -u a5 -u b5 -u ¢5 -u m224 -fM32SHR -I5 -0

M32SUB (timer ends)

Usage: m32sub [options]

-uh Help Summary

-u a<Number> Number of threads (default 15)

-u m<Number> Maximum size of Memory object  (default 65535)

-u n<Number> Total number of Memory objects  (default 255
Number should be greater than One

-u t<Number> Time out to run in Seconds

-u v<Number> Number of times each of the Threads Suballocate
the Memory Objects (default 10)

-u ksmp SMP kernel is used

e Logfile name

-15 Logging level 5 -> 9

re-run: m32sub.exe -ut300 -ual14 -u m512 -u n16 -fM32SUB -I3 -0
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MCLK (runs until finished)

usage: MCLK -I# [filename] [-r##] [-i##] [-n###] [-d##] [-fname]

[filename]  name of file containing control string

-ri##  number of times to repeat the control string (default 10)
-it# seconds between repetitions (default 1000 seconds)
-n##H# Frequency of tone to sound (default 300Hz)

-d##  Duration of tone sounded (default 1 sec)

-l#  Output logging level 1-9

-fname Output logfile name

re-run: mclk.exe -r2 -i1 -d2 -n440 -fMCLK -I5

MEMCODE (timer ends)

usage: memCode -u Lxxxxx -Lx -u Mxxxx -u Nxxxx [-u X]

-u Lxx Statistics logging file path [optional]

-L Logging level (0-9)

-uM  Max amount of memory per selector (1-65535) [128]

-uN  Max number of unshared selectors to allocate (1-2050) [256]
-uD Disable VIO status monitoring

-uT  Number of seconds to run (Approximate)

-u X Turn on extended memory alloc retry

-fr**** Logfile name

-5  Logging level 5 -> 9
Statistics format: YYYY/MM/DD HH:MM:SS.TH MemCode AAAAAAA

re-run: memcode.exe -u t300 -u n32 -u m512 -u D -fMEMCODE -I5 -0

MEMFREE (timer ends)

usage: memfree -u Lxxxxx -Lx -u Mxxxx -u Nxxxx [-u X][-u Txxx][-u D]

-u Lxx Statistics logging file path [optional]
-uM  Max amount of memory per selector (1-65535) [128]
-uN  Max number of unshared selectors to allocate (1-2050) [512]
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-uD Disable VIO status monitoring

-uT  Number of seconds to run (Approximate)
-u X  Turn on extended memory alloc retry
-f***** | ogfile name

-l Logging level 5 -> 9
Statistics format: YYYY/MM/DD HH:MM:SS.TH

re-run: memfree.exe -u t300 -u n40 -u m160 -u x -u D -fIMEMFREE -I5 -0

MEMHUGE (timer ends)

usage: memhuge -u Ixxxxx -Lx -u Mxxxx [-u X][-u D]

-u Ixx Statistics logging file path [optional]

-uM  maximum memory size allocated [67108864]
-u X Enable extended retry

-uD Disable VIO status monitoring

-ut  Number of seconds to run.

-fr**** Logfile name

-5  Logging level (0-9)

Statistics format:
YYYY/MM/DD HH:MM:SS.TH MemHuge AAAAAAAA BBBB CCCC DDDDDDDD

AAAAAAAA Total size Allocated memory using (get memory) (hex)
BBBB current total

re-run: memhuge.exe -u t300 -u m69000 -u x -u D -fMEMHUGE1 -I5 -0
memhuge.exe -u t300 -u m262114 -u x -u D -fMEMHUGE2 -I5 -0

MEMLOCK (timer ends)

usage: memlock [-u a#] [-u b##] [-u d] [-u e] [-u c##] [-u h?]

-uA#  Type of memory lock 0 = short term (default) 1 = long term
-u b##  Size of segments to lock 1-65535 (default 64K from 16K)
-uct##  Numbr of segments to lock 1-2048 (default is 2048)
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-ubD Disable statistic screen display
-u E##  Sharing attributes of allocated segment
0 = private (default)
1 = sharable through DosGiveSeg
2 = sharable through DosGetSeg
4 = discardable
8 = sharable, shrinkable
-uh? display help message
-f****  Lodfile name

-15 Logging level 5 -> 9

re-run: memlock.exe -u t300 -u D -u b9 -u ¢c200 -u A1 -u EQO -fMEMLOCK -I5 -o

MEMSEL (timer ends)

usage: memsel -u xxxxxxxx -Lx -u Mxxxxx -u Nxxxx -u Oxxxx [-u X]

-u Ixx Statistics logging file path [optional]

-uM Maximum memory per segment (1-65535) [128]

-u N Number of shared segments to allocate (1-6144) [4096]

-u O Number of unshared segments to allocate (1-2050) [2000]
-u X Enable extended retry

-uD Disable VIO status monitoring

-ut Seconds to run(appr.)
-f***** |_ogfile name

-15 Logging level 5->9

Statistics format:
YYYY/MM/DD HH:MM:SS.HH MemSel AAAAAAAA BBBB CCCCCCCC DDDD EEEEEEEE

AAAAAAAA - Total amount of memory allocated (hex)
BBBB - Number of unshared segments allocated (hex)
CCCCCCCC - Total size of unshared segments (hex)
DDDD - Number of shared segments allocated (hex)
EEEEEEEE - Total size of shared segments (hex)

re-run: memsel.exe -u t300 -u n175 -u m500 -u 025 -u D -fMEMSEL -I5 -0
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MEMSUB (Ctrl-C ends)

usage: memsub -1# [statlog] [-M##HHE] [-N##HEHE

statlog Statistics logging file path [optional]

-M#HH# Max number selectors to allocate (1-512) (Default 128)
-N##H#H# Max number subbing threads to start (1-10) (Default 2)
-f***** | ogfile name

-15  Logging level 5 ->9

Statistics format:
YYYY/MM/DD HH:MM:SS.TH MemSub AAAAAAAA BBBB CCCCCCC DDDD EEEEEEEE FFFF GGGG

AAAAAAAA Total size Allocated memory (hex)

BBBB current total # of r/w selectors allocated (hex)
CCCCCCCC Total size of r/w selectors allocated (hex)
DDDD current total sub-allocations (hex)

EEEEEEEE Total size of sub-allocations (hex)

FFFF Total number of 1st level Suballoc failures (hex)
GGGG Total number of 2nd level Suballoc failures (hex)

re-run: memsub.exe -m128 -n4 -4

MEMSUBGR (Ctrl-C ends)

usage: memsubgr -u Ixxxxx -Lx -u Mxxxxx

-u Lxx Statistics logging file path [optional]

-uD Disable VIO status monitoring

-uT  Number of seconds to run (Approximate)

-uM  Max starting memory size (2048-67108864) [67108864]
-f***** | ogfile name

-15  Logging level 5 ->9

Statistics format:
YYYY/MM/DD HH:MM:SS.TH MemSubgr AAAAAAAA BBBB CCCCCCC DDDD EEEEEEEE

AAAAAAAA Total size Allocated memory using (get memory) (hex)

BBBB current total # of unshared s
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re-run: memsubgr.exe -u t300 -u m1048577 -fMEMSUBGR -I5 -0

NMPIPE (runs until finished)

usage: nmpipe [options]

-uH display this help summary
-u SP Short name for pipe
-u I<file-spec> input file specification (default *.*)

-u O<path-spec> output path specification (default \util)

-u PC<pipe-name> client pipe name (default \pipe\pipe1)

-u PS<pipe-name> server pipe name (default \pipe\pipe1)

-u TC<threads> client thread type #s  (default 011)
-u TS<threads> server thread type #s  (default 0123)
-u PL<pipe-len> pipe length

e Logfile name

-15 Logging level 5 -> 9

Server Thread Types:
Type Mode Pipe Access Technique

0 msg Blocking, Nrml R/W
1 byte Blocking, Nrml R/W
2 msg NonBlocking, Nrml R/W
3 byte NonBlocking, Nrml R/W

Client Thread Types:
Type Read Mode Pipe Access Technique

0 byte stream Blocking, Nrml R/W
1 byte stream NonBlocking, Nrml R/W

NOTE: To re-run NMPIPE1S or NMPIPE1C, you must run both, starting

NMPIPE1S first, then NMPIPE1C. One is server, one is client.

prep: NMPIPE1S or NMPIPE1C - Create directory \TMP2 on testcase drive

NMPIPEOQ2 - Create \TMP1 directory on testcase drive
NMPIPEOQ3 - Create \TMP2 directory on testcase drive
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NMPIPEO4 - Create \TMP3 directory on testcase drive

re-run: nmpipe.exe -u l\stress\*.sym -u O\Tmp2 -u PC\pipe\Med01a -u PS\pipe\MedO1a -u TS0123 -
fNMPIPE1S -I5 -0

nmpipe.exe -u l\stress\*.sym -u O\Tmp2 -u PC\pipe\Med01a -u PS\pipe\MedO1a -u TC0011 -
fNMPIPE1C -I5 -0

nmpipe.exe -u l\stress\*.sym -u O\Tmp1 -u PC\pipe\Med01b -u PS\pipe\Med01b -u TCO1 -u TS12 -
fNMPIPEO2 -I5 -0

nmpipe.exe -u l\stress\*.sym -u O\Tmp2 -u PC\pipe\Med01c -u PS\pipe\Med01c -u TC010101 -u
TS0123 -fNMPIPEO3 -I5 -0

nmpipe.exe -u l\stress\*.sym -u O\Tmp3 -u PC\pipe\Med01d -u PS\pipe\Med01d -u TC011 -u TS123 -
fNMPIPEO4 -I5 -0

NPX (timer ends)

usage: npx [-u txxx] [-u ixxx] [writelog flags]

-u nxxx number of threads to do calculations. max of 16.
-u txxx run for xxx seconds or until error.

-u ixxx run xxx iterations through the loop.

-fr**** Logfile name

-15 Logging level 5 -> 9

re-run: npx.exe -u t300 -u n2 -fNPX01 -I5 -0
npx.exe -u t300 -u n4 -fNPX02 -I5 -0
npx.exe -u t300 -u n2 -fNPX03 -I5 -0

PIPES (timer ends)

usage: pipes [-u p][-u c][-u nxxx][-u mxxx][-u ixxx][-u Pxxx]

? Help summary

-up echo progress to the screen

-uc run forever

-u Pxxx number of pipes per process 2-256 (5)

-u nxxx initial size of pipes 1-65535 (100)

-U mxxx maximum size of pipes 1-65535 (65535)

-U ixXxx pipe size increment each iteration 1-65535 (1007)

-u txxx Number of Seconds to run
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-f=**** Logfile name

-5 Logging level 5->9

re-run: pipes.exe -u t300 -u n100 -u m2000 -u 50 -fPIPESO1 -I5 -0
pipes.exe -u t300 -u n50 -u m3000 -u i50 -fPIPES02 -I5 -0
pipes.exe -u t300 -u n100 -u m32000 -u i100 -fPIPES03 -I5 -0

SWP232 (runs until finished)

usage: swp32 [options]
-u n## Number of windows to create/process
-fx**** Logfile name

-15  Logging level 5 ->9

re-run: swp32.exe -u n35 -fSWP32 -I5 -0

VIDEO (timer ends)

usage: video
-u t### Number of seconds to run testcase
-u ***** nput file specification
-f<**** | ogfile name

-15 Logging level 5 -> 9

re-run: video.exe -u t300 -u \text\short1.vid -fVIDEO -I5 -o

VSMAIN32 (Alt-F4 or switcher kill signal)

usage: vsmain32 inputfile
inputfile File containing test control sequences
-s*****  |Logfile name

-15 Logging level 5 -> 9

re-run: vsmain32.exe /a\textivsmnirg.vsm -sVSMain32 -5
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VSPS32 (Alt-F4 or switcher kill signal)

usage: vsps32 inputfile
inputfile File containing test control sequences
-s*****  |Logfile name

-15 Logging level 5 -> 9

re-run: vsps32.exe /a\text\VSPSIrg.VSP -sVSPS32 -I5

VVDCHRIO (runs until finished) (VDM test)

usage: vvdchiro -m#
-m# modetorun1->9
-fr**** Logfile name

-15  Logging level 5 ->9

re-run: vvdchrio.exe -m4 -fVWDCHRIO -I5 -0

WIND32 (Alt-F4 or switcher Kill signal)

usage: wind32 -u n500
-u n##HE Number of windows to create/process
-fr**** Logdfile name

-15 Logging level

re-run: wind32.exe -u n500 -fWIND32 -I5 -0

Device Driver Information

Provides information on what device drivers should be tested, and a suggested sequence of where to look for
updated drivers, and how they should be noted in the PCM Testing report(PCM_HDW).

When testing systems with the PCM OS/2 Compatibility Testkit, is important to get the correct device driver
for your system.

WHENEVER YOU TEST A SYSTEM WITH THE PCM TESTKIT, AND USE A DEVICE DRIVER  THAT
WAS NOT ON THE OS/2 PRODUCT CDROM, YOU SHOULD NOTE IN THE COMMENTS PAGE OF
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PCM_HDW (PANEL 3) WHERE THE DEVICE DRIVER CAME FROM, THE DRIVER NAME, DATE/TIME
STAMP, AND SIZE OF THE DRIVER.

Some Adapter/Device Driver Manufacturers may not have the most recent versions of the device drivers
available from their web sites.

When a PCM manufacturer gets a new chipset, some device manufactures will  also be provided a specific
device driver for that PCM's system that will  differ from the device drivers available on the device
manufacturers WEB site.

They also may get a copy of the source code for the device driver and make changes to it that are specific to
the various system models they make. Even if a PCM offers 2 different system models using the same
chipset number, the device driver for each may be different system model.

Typically, when a device driver is tailored for a specific PCM system model, the PCM will provide that unique
device driver in the system models ship group of documentation and software, and usually placed on the
PCM's WEB site noting the specific system model they work with.

Which means, if the system is shipped with a tailored device driver that is the one that should be used for
PCM Testing, since it is the device driver the customers will receive and be expected to use.

If a new or updated device driver is needed, there is a sequence that you should go through in looking for the
correct updated device driver for the specific system you are testing.

1. The first place you should look for an updated device driver, is on the WEB site of the company the
manufactured the system unit. If they have a tailored device driver, they usually ship it with their system,
but will also probably have it, or an updated version of it on their WEB site for that specific system model
and chipset combination.

2. The second place you should look, if the PCM's web site does not have any tailored device drivers for
that system available, would be the IBM OS/2 DDPAK on the WEB.

Note: There is a link to this from the PCM Testkit WEB pages.

3. Finally, if it's impossible to find a device driver either on the PCM's WEB site, or the IBM OS/2 DDPAK
WEB site, then you need to look at the WEB site of the manufacturer of the device/chipset.

PCM_TEST PM Interface

The program PCMTEST.EXE is a PM Graphical User Interface that provides selection and execution control
for PCM Testkit testcase groupings.

The user has the ability to select whether to run manual intervention testcase first, or last after all automated
testing has completed.

For PCMCIA testcases, the program requires you to enter the drive letters assigned to the PCMCIA slots.
The number of slots and drives assigned is dependent on config.sys entries. You can check the DRIVES
FOLDER to verify what drive letters were assigned.

The program automatically reboots the system and continues at certain points depending on which testcases
have been selected to run.

The program flow is the following:

1. If Manual FIRST was selected:
a. If ACCEPTANCE selected

* runs SNFMVDM Testcase
 runs ACC_SUMM.CMD Summary for ACCEPTANCE

b. If FVT selected
 runs KEYBOARD Testcase

e« runs PRINTDD Testcase
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* runs CD-TESTS
 runs 137GB_TESTS
* runs FVT_SUMM Summary for FVT
c. If MME PCM_REXX was selected, run PMREXX Testcase.

2. If ACCEPTANCE Selected:
a. Runs SNF002, SNF005, SNF006, SNFBPB, SNFREXX Testcases
b. Runs ACC_SUMM.CMD Summary for ACCEPTANCE

3. If FVT Selected:

(reboots for 137GB_TESTS)
a. Runs FVTDISK, TIMERDD, CD-TESTS, 137GB_TESTS Testcases
b. Runs FVT_SUMM Summary for FVT

4. If MULTIMEDIA Selected:

(reboots if ACCEPT or FVT were also selected)

a. if PCM_VGA Selected, Runs PCM_VGA Testcase

b. if PCM_SVGA Selected, Runs PCM_SVGA Testcase

c. if PCM_HPFS Selected, Runs PCM_HPFS Testcase

d. if PCM_FLC Selected, Runs PCM_FLC Testcase

e. ifPCM_CD Selected, Runs PCM_CD Testcase (SEE NOTE-1 BELOW)

5. If PCMCIA Selected:

(reboots if ACCEPT or FVT or MMEDIA were also selected)
a. Runs SLOT-1 testcase selected (ATA, FLASH, SRAM)
b. Runs SLOT-2 testcase selected (ATA, FLASH, SRAM)

6. If SMP Selected, runs SMP testcase.
7. If STRESS Selected:

(reboots if ACCEPT or FVT or MMEDIA or PCMCIA were also selected)
a. Prompts for diskette in drive A: if not found.
b. Runs STRESS testcase.

8. If FVT Selected:

(reboots for 137GB_TESTS)

a. Prompts for CD-like media for CD_TESTS Testcase.
b. Prompts for diskette in drive A: if not found.

c. Runs FORMAT testcase.

d. Runs FVT_SUMM.CMD summary for FVT.

9. If Manual LAST was selected:
a. If ACCEPTANCE selected

* runs SNFMVDM Testcase
 runs ACC_SUMM.CMD Summary for ACCEPTANCE

b. If FVT selected
 runs KEYBOARD Testcase

* runs PRINTDD Testcase
* runs CD-TESTS
 runs 137GB_TESTS
* runs FVT_SUMM Summary for FVT
c. If MME PCM_REXX was selected, run PMREXX Testcase.
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NOTE-1:

With CDROM Drives connected directly to a sound card, the program may not be able to run the PCM_CD
testcase from the PM GUI. There are 2 symptoms of this that require the PCM_CD testcase to be run from an
0OS/2 Full Screen session instead of the PM GUI.

Symptom-1

Start PCM_TEST and select PCM_CD and have a MUSIC CD in the CDROM drive. Press the "RUN" Button,
the program will start, then end before running any testcases. In the file \PCMLOGS\PCMTEST.LOG you
will see a return code of 87 from DosQueryFSAttach for the CD Drive Letter. and a return code of 253 from
the request for a Music CD in drive.

Symptom-2

Start PCM_TEST and select PCM_CD without any CD in the CDROM drive. Press the "RUN" Button, the
program will start, and you will be prompted to insert a Music CD in the CDROM drive, and then press "OK",
again the program starts, then ends before running any tests. In the file \PCMLOGS\PCMTEST.LOG you will
see a return code of 21 from DosQueryFSAttach for the CD Drive Letter. and a return code of 87 from the
request for a Music CD in drive.

NOTE-2:

If you have problems with running from the PM GUI, always check the file \PCMLOGS\PCMTEST.LOG for
error return codes. The return codes will usually provide some indication of what the problem is, such as
2041 which indicates the path could not be found. To find out what a return code is, type the command
"HELP SYSxxxx" where xxxx is the return code (with leading 0's if needed) that was displayed in the
PCMTEST.LOG file.

NOTE-3:

The PM GUI returns "file not found" whenever attempting to run a test group from the GUI. This typically
happens if an installation has not been completed correctly and environment variables are not placed in the
config.sys. The first step would be to check the file \PCMLOGS\PCMTEST.LOG as was mentioned earlier.
The next step is to determine what could account for the files not being found after the PCM testkit installation
had been completed and files have been seen on the D: drive from an OS/2 window. There are a few
suggestions to try:

Suggestion-1

Many SCSI controllers have a setting for support of disk drives greater than 2GB - if you are using a drives
larger than 2GB with this set incorrectly there can be problems. Some SCSI cards provide a key sequence
such as a CTRL-A prompt during boot to enter setup, or a diskette/CDROM with software for configuring
SCSiI controller.

Suggestion-2

If there is a large amount of software installed, the environment variables may not all be set properly as there
may be too many set in config.sys and exceed the environment variable space.(OS/2 has an limit on the
amount of data that can be stored in the OS/2 environment space). In this case move the PCM set
statements in the config.sys from the bottom to the top of the file.

Suggestion-3

If you have a SCSI adapter and use base VGA and all looks ok, then you switch to a video SVGA device
(embedded or adapter) and now the files on drive D: cannot be seen, then you should check your config.sys
first. In this case, you probably have a large SCSI disk drive, and you will probably see both an IBMINT13.113
and the specific device driver for the SCSI adapter in config.sys, this would occur during OS/2 installation.
Since VGA works ok, but the SVGA driver while the video works, you cannot see files on Drive D:, most likely
the SVGA driver activating the video chipset has conflicts with the SCSI chipset or adapter settings, and the
system reverts to using IBMINT13.113 to access the disk. To verify this, you will note that if the system has a
SCSI CDROM, it is now not available since IBMINT13.113 only provides access to the disk drives (and SCSI
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adatper setting for > 2GB may need to be set). Another way to verify this is to issue the command "RMVIEW
>rmv.out", then check the rmv.out file and see which device driver is loaded for the SCSI disk support. If you
have this situation, you need to verify the settings of both adapters or chipsets, and then configure the system
so no conflicts exist.

Equivalent System Information

The following information supercedes the PCM Testkit V4.1 Documentation and lists the criteria for
determining if a system model can be considered equivalent to a model under test and listed as an equivalent
system in the WEB report for that model, and if any re-testing is needed.

A system model IS EQUIVALENT without any additional testing needed, if any of the following changes occur
to the shipped configuration:

Covers / Frame of the system No Re-test required
Number of slots on a riser card No Re-test required
Number of bays for disks, cd-roms, diskettes No Re-test required
Sizes of Disk / Diskette drives No Re-test required
Number of installed disks / diskette drives No Re-test required
Amount of system memory installed No Re-test required
Power Supply used in system No Re-test required
No Sound Support if tested system had one No Re-test required
Network Adapter (tested system can cover 2) Test 1st/role 1, 2nd/role 2

A system IS NOT EQUIVALENT if any of the following changes occur to the shipped configuration. Re-run
the tests indicated, and submit a separate results diskette (COPY OF 1st/ORIGINAL) updated with the re-run
tests, and updated PCMHDW system and model specifications.

Planar or component design Run all BASE/LAN tests

CPU Manufacturer Run all BASE/LAN tests

CPU Speed (same manufacturer) Run all BASE/LAN MAX speed, Stress MIN speed
Sound Support - Adapter / MFG Run Multimedia / Speech tests

CDROM or DVDROM Re-install Testkit, run Multimedia PCM_CD
Processor or BIOS levels Run all BASE/LAN tests

Video chipset/adapter Run ACCEPT and STRESS tests

Disk subsystem Chipset/Interface Run all STRESS and FVTDISK tests

PCMCIA Chipset / Level Run PCMCIA tests

APM Interface / level Run APM and STRESS tests

SMP system - # of Processors Run all BASE & LAN tests with Min & max # CPU's
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NOTE-1:

When you are testing a system, the PCM_HDW panel-5 provides that ability to list equivalent system models.
This information is included in the WEB listing for the results diskette submitted.

It is not necessary to submit a separate results diskette for each equivalent system, however the testing is
required. This results in only 1 model listing on the WEB with the equivalent systems included in the report.

If your intent is to have both systems model names listed with reports, then you need make a DISKCOPY of
the 1st/Original Results Diskette, then re-run the required testcases on the 2nd system with the sub-system
changes. Use PCM_HDW to update the system model name, configuration, and equivalency information on

panel-5. Then UPDATE the 2nd (copy) Results Diskette, and submit both results diskettes for processing.
Send results images via email as outlined on WEB.

The choice of how to list equivalent systems is up to you, but if the equivalency information indicates that
some tests must be re-run due to a single subsystem change, then those tests should be re-run on the
system with the subsystem change, whether you are submitting only 1 results diskette or 2.

NOTE-2:

The Celeron line of processors should be treated as a completely different processor line and will require a
complete test of the system since they are functionally a different CPU line from the Pentium or Pentium Il
processor lines.

For different speeds of a Celeron version (300A,333A), you can treat them as equivalent systems and make a
copy of the original results diskette for the system tested with the highest speed, and for lower speeds of the
same Celeron version you need to run the tests outlined in equivalency information for CPU's with different
speeds, and submit either 1 or 2 results diskettes depending on how the manufacturer wants the systems
listed on the WEB. If you want different entries, 2 results diskettes need to be submitted, if you only want 1
entry, then you need to be sure to enter the equivalent model information on panel-5 of PCM_HDW and
submit 1 results diskette.

For the different versions of Celeron, (333, 333A) ,this would be similar to testing of systems that had
Pentium, Pentium Il processors and need to have complete testing performed and a different results diskette
submitted. This is because the different versions have different features, not just different speeds.

The only time CPU speed equivalency information can be used to define the amount of re-testing needed is
with a CPU of the same version where only the speed is different (Celeron 300A, 333A).

LAN TESTING

LAN testing contains a combination of command files and manual test scripts.

The command file testcases are started from the PM GUI "Testcase Selection and Control LAN" icon in the
Compatibility Testkit Folder on the desktop.

The command files can also be run individually from the command line. The LAN Testing GUI is started on all
systems in the test environment and a target system is selected to test. The same system to exercise should
be selected on all systems in the test environment. The individual systems then begin running testcase
commands (.CMD's) to exerise the target system selected.

The testcases rely on the systems in the test environment having been installed and configured as outlined in
the PCM Compatibility Testkit V4.91 Documentation.

The following section covers potential problems that can occur when running the various testcases.
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Testcase: ITLLS56(domain test) ITLLS57(server test) LAN Exercisers

These testcases exercise the LAN environment by copying files to/from the system being tested and
comparing the files after each copy. The testcase uses 1MB, 2MB, 4MB, 8MB. Also there is an xcopy of all 4
files (15MB) with a compare of each file after the xcopy finishes.

If testcase appears to hang almost immediately when trying to either delete the old logfile on the target
system or on 1st copy attempt. This usually only happens with ETHERNET environments. There is an OS/2
fixpack that will correct this. The latest MPTS fixpack for the OS/2 server product you are using needs to be
downloaded and installed on the domain and server systems.

You can see this problem when you start one of the testcases, and when the session hangs, open an OS/2
window and try "NET VIEW" of the target system, you will probably see this hang as well. Sometimes when
this is done, the testcase will go one step further, then both session appear hung.

NOTE: There are different fixpacks for 0S/2 WARP Server, ADVANCED, and SMP. Be sure to get the
correct one for the version installed.

In most cases, the fixpack is all that is needed to correct this problem.

Another problem that can occur with ITLLS56, ITLLS57, and ITLPEER is that you get an access denied
failure. If you open an OS/2 window and manually attempt to copy a file to the target system, you will get an
error code, use the command "help NETxxxx" to get expanded information on the problem.

However this is usually due to access control problems where the target system's access control is not setup
properly. Sometimes a re-run of LANSETUP on the target system then rebooting can correct this problem.

If that does not work, then you should manually open add the access by using the "LAN Services File and
Print" folder and then going through LAN Server Administration to add a resource definition and then set

the manage access permissions to add the group USERS with all access privledges granted. To verify, you
can then manually try a copy to the target system from another in the environment to verify the access denied
problem is cleared.

Testcase: ITLMSG (lan messaging

There is a known problem with messaging with LAN Server on SMP machines that will cause this test case to
fail. The problem is the SMP system will only see the first message it is sent and nothing after that until the
system is rebooted. The log file for this test (ITLMSG.R01 or ITLMSG.DO01) will indicated there were
unsuccessful attempts at sending messages.

This is only a problem when testing a Warp Server SMP system and affects messages sent to the server
specifically, broadcast messages are not affected by this and will be received on the Warp Server SMP
system.

The testcase ITLMSG.CMD have been updated in the version 4.5 to use broadcast messages for sending to
either the domain controller DO1 or additional server S01, while still using single messaging to the clients R01
or R02.

Testcase: ITLSVOO (Group Management)

If the ITO1D01 and IT0O1S01 Netbios system are not detected (i.e. you do not see their icon in the group after
doing a discovery) check to see that the Netbios protocol is enabled. Do this from the Netfinity configuration
icon in the Netfinity folder.

After enabling that protocol, be sure to also provide the network address, AC010001 for the domain
controller, AC010101 for the Additional server.

You will need to close all Netfinity windows and then restart Netfinity for the changes to take effect. Restart
Netfinity by double clicking the Netfinity Server Service icon in the Netfinity folder.
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Testcase: ITLSV06 (Monitor Remote Systems Resources)

If testing WARP SERVER or WARP SERVER ADVANCED (not SMP) after selecting "Export to Database",
you will need to specify the monitor that was used since there will not be a default selection. After
highlighting the monitor, click on ok and the filename/directory panel is presented. Change the directory to the
ROOT of C:\ (OS/2 Boot Drive example) and enter a filename of ITO1xxx.DBF (where xxx can be anything)
and then click on OK.

This is due to differences between the SystemView and TME10 defaults for the system monitor utility.

The file ITO1xxxx.DBF must be in the root of the OS/2 boot drive (C:\) for results processing to pick it up for
processing.

Results processing was looking for only one occurrence in the .DBF file for the system names IT01D01,
ITO1RO1, ITO1R02. Monitoring and saving to datafile of more than one activity or interval results in the
PCMSCORE.TXT showing a fail.

The results processing routines have been updated to correct this problem. Download the V4.1 FIXPACK to
apply the updated routines.

Test case TIMER (in the base test cases)

If the timer test case failed rerun the test case after shutting down any "extra" applications that are running.
Reboot may be necessary depending on the application that is closed.
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Appendix H. Frequently Asked Questions

The following Q&A's will identify the options of the program for you. When you are finished reading, you will
be able to choose the program that is right for you.

Q. What is the OS/2 Compatibility Test Program?

A. The compatibility test program is a test process that ensures your hardware will be compatible with OS/2.
Primarily, this program is for system manufacturers, but component manufacturers also have the opportunity
to use the test process to ensure compatibility with OS/2.

Q. What OS/2 products can be tested with the OS/2 Compatibility Testkit?

A. OS/2 WARP Server for e-business, Convenience Package for OS/2 Warp 4, Convenience Package for
0OS/2 WARP 4 Server for e-business.

Q. Who can join the OS/2 Compatibility Test Program?

A. All personal computer manufactures and independent hardware vendors who want to be certain their
products are compatible with OS/2.

Q. What does it mean to join the OS/2 Compatibility Test Program?

A. It means your systems are actively being tested for compatibility and test results are submitted and
verified for entry into the OS/2 Hardware Compatibility List.

Q. Why should | be interested about OS/2 compatibility?

A. Your customers will be asking if your hardware is compatible with OS/2. Also, OS/2 compatibility is
required by many businesses, governmental operations and international organizations.

Q. How will my customers know my systems are OS/2 compatible?

A. Customers will be aware systems are OS/2 compatible from several sources. First, you will receive a letter
from IBM Personal Software Products, confirming that the systems for which test results were submitted,
have passed the OS/2 Compatibility test. You may disclose this letter to your customers and use it to satisfy
bid requirements. Next, when your systems are OS/2 compatible, they are entered on the OS/2 Compatibility
List published on the World Wide Web at URL: http://www-3.ibm.com/ software/os/warp/hw-
cert/pcm/pcm_syst.htm.

Q. What is the benefit if our systems are OS/2 compatible?

A. Compatibility will ensure to your customers that your systems have been tested and proven to be
compatible.

Q. What happens when my company joins the OS/2 Compatibility Test Program?

A. As a participant of the compatibility test program, you are provided the current OS/2 Compatibility Testkit.
This package permits you to begin testing.

Q. Where else in my company can the OS/2 Compatibility Test Program be used?
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A. Some OEM's have taken the testkit code and implemented it in their assurance labs. This ensures your
systems are OS/2 compatible when the systems exit your development process.

Q. Can | make copies of the testkit code and documentation?

A. Yes you can make up to 10 copies. After the tests are complete, the test code is to be removed from the
test systems.

Q. How long does the compatibility test process take?

A. The latest version of the testkit involves a standalone 4 system LAN attached environment, after initial
setup of the environment, a system can be tested for both BASE and LAN coverage in about 3-4 days.

Q. How will I know if testing is successful?

A. When testing is complete, a testcase summary is presented.

Q. What happens after | complete OS/2 compatibility testing?

A. You provide a Test Results Diskette Image to the program office.

Q. What is the process after | submit the Test Results Diskette?

A. Once the test results are received, they will be verified and you will be informed. When tests are
successful, you will receive a letter confirming OS/2 compatibility and the systems are entered into the next
update of the OS/2 Hardware Compatibility List.

Q. What happens if the test are not successful?

A. If your tests do not pass, then the problems will be addressed by our analysis team who will work with you
and track the problem until solved. If a test is unsuccessful because of a hardware incompatibility, then the
0S/2 development staff will work with you for a solution.

Q. What is the confidentiality of the test information?

A. Test information is considered IBM Confidential and is not available to anyone outside of the OS/2
Compatibility Test Program Office.

Q. Will future releases of OS/2 require compatibility testing?

A. Itis in both of our interest to ensure our customers get the best quality hardware and software that is
available. The OS/2 Compatibility Test Program will enhance the quality of both products.

Q. Will there be future releases of the OS/2 Compatibility Testkit?

A. The testkit is updated as needed by the OS/2 product line, with updates being made available from the
PCM Testkit Home Page.

Q. Will the criteria for OS/2 compatibility remain the same as each new testkit becomes available?

A. Yes, the base criteria for OS/2 compatibility will remain the same as new testkits become available. In
addition, tests may be added to support new functions.
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Q. Is there a cost associated with the OS/2 Compatibility Test Program?
A. Not at this time.

Q. What methods are available to do OS/2 compatibility testing?

A. A request for the testkit can be made at the URL http://www-3.ibm.com/software/os/ warp/hw-
cert/pcm/pcm_tkit.htm. This testkit enables OEM's to perform OS/2 compatibility testing on systems at your
facility.

Q. What systems should the OS/2 compatibility test focus on?

A. All systems should be tested and entered into the OS/2 Hardware Compatibility List. If some of your
systems are configured the same, and sold under different logos, then you may follow the directions in the
Testkit documentation for equivalent systems and may list 1 or more as you require.

Q. How does the OS/2 Compatibility Testkit process work?

A. This process starts with the delivery of the testkit materials. The testkit materials consists of the following:
0S/2 Compatibility Testkit on CD-ROM, including online test documentation.

Tips and Hints on using and running the PCM Testkit from the PCM Testkit WEB Home Page.

Once you decide which version of OS/2 you need for testing, and have obtained the product, the testkit
materials you receive and updates you download, you will have everything you need to load OS/2 and to run
the tests. The test documentation will guide you through each test. When your tests are complete, you submit
the Test Results Diskette to the program office where test results are verified.

Q. Is there a license agreement that covers the OS/2 Compatibility Testkit?

A. The OS/2 Compatibility Testkit has the license agreement in the package. Please read that document
before you open the package.

Q. What is the level of testing that is done for OS/2 system compatibility?
A. The OS/2 compatibility test will test key components of OS/2 running on your systems. For example:

+ Installation & Initialization

*  Communications

* Queues/Pipes

» File Systems/File Management

* Loader/Scheduler/Switcher

» Batch Processing

*  Memory

*  Numeric processing

+ DOS Video

» Presentation Space

» PM Desktop/Video/Exerciser/Messaging

e Code Page Segments
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Appendix |. Notices

References in this publication to IBM products, programs, or services do not imply that IBM intends to make
these available in all countries in which IBM operates. Any reference to an IBM product, program, or service
is not intended to state or imply that only that IBM product, program, or service may be used. Subject to IBM's
valid intellectual property or other legally protectable rights, any functionally equivalent product, program, or
service may be used instead of the IBM product, program, or service. The evaluation and verification of
operation in conjunction with other products, except those expressly designated by IBM, are the responsibility
of the user.

IBM may have patents or pending patent applications covering subject matter in this document. The
furnishing of this document does not give you any license to these patents. You can send license inquiries, in
writing, to:

IBM Director of Licensing
IBM Corporation

500 Columbus Avenue
Thornwood, NY 10594
US.A.

Asia-Pacific users can inquire, in writing, to the IBM Director of Intellectual Property and Licensing, IBM World
Trade Asia Corporation, 2-31 Roppongi 3-chome, Minato-ku, Tokyo 106, Japan.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange
of information between independently created programs and other programs (including this one) and (ii) the
mutual use of the information which has been exchanged, should contact IBM Corporation, Department
LZKS, 11400 Burnet Road, Austin, TX 78758 U.S.A. Such information may be available, subject to
appropriate terms and conditions, including in some cases, payment of a fee.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States or other countries or both:

| BM

Net Finity

Qperating Systeni2
Qos/ 2

Personal Computer AT
Personal Systent 2
PS/ 2

Syst enVi ew

Voi ceType

TME 10 is a trademark of Tivoli Systems, Inc.
Intel and Pentium are registered trademarks of Intel Corporation in the U.S. and other countries.
Microsoft and Windows are registered trademarks of Microsoft Corporation.

Other company, product, and service names may be trademarks or service marks of others.
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